# Table of Contents

Table of Contents ........................................................................................................ 2

Introduction ..................................................................................................................... 7
  Welcome to NiceLabel ................................................................................................. 7
  Contents of the Package .............................................................................................. 7
  About this Manual ....................................................................................................... 7
  About this Manual ....................................................................................................... 7
  Software Restrictions ................................................................................................. 8
  Typographical Conventions ....................................................................................... 8

Product Overview .......................................................................................................... 8
  NiceLabel Software Products .................................................................................... 8
  NiceLabel Suite ......................................................................................................... 9
  NiceLabel Pro ............................................................................................................ 9
  NiceLabel Express .................................................................................................... 10
  NiceLabel Pocket PC Designer .................................................................................. 10
  Pocket NiceLabel ...................................................................................................... 10
  NiceLabel SDK .......................................................................................................... 10
  NiceLabel Print Center .............................................................................................. 10
  NiceWatch Enterprise ............................................................................................... 11

Installation and Activation ......................................................................................... 12
  System and Software Requirements .......................................................................... 12
    Single User Edition .................................................................................................. 12
    Network Edition ....................................................................................................... 12
    Pocket Edition ......................................................................................................... 12
  Installing Software ..................................................................................................... 13
    Installing Software .................................................................................................. 13
    Run START.EXE ....................................................................................................... 13
    Close All Software Applications ............................................................................. 13
    Define Setup Options .............................................................................................. 13
    Install Printer Driver ............................................................................................... 14
  Installing Network Edition ......................................................................................... 15
    Overview .................................................................................................................. 15
    Define Access Rights for Network Clients .............................................................. 16
    Install the Software on the Server .......................................................................... 17
    Install the Software on the Workstation ................................................................. 18
    Install the Client in Unattended Mode with Group Policy ...................................... 18
    Install on Windows Terminal Services and Citrix Metaframe ................................ 19
    Enable Offline Mode ............................................................................................... 19
    Limitations of the Network Offline Mode ............................................................... 20
    Migrate Network Edition to New Server Computer ............................................... 21
    Recovering Lost Licenses ....................................................................................... 22
    Use Primary and Secondary Server ....................................................................... 22
  Installing Pocket Edition ........................................................................................... 23
    Overview .................................................................................................................... 23
    Setup and Test Mobile Device Setup ...................................................................... 24
    Install Pocket NiceLabel .......................................................................................... 24
    Activating Software ................................................................................................. 25
### Table of Contents

- Activating Software ................................................................. 25
- Activate Software with a Hardware Key ........................................ 25
- Activate Single User Edition ...................................................... 27
- Move the Software License to Another Computer .......................... 30
- Activate Network Edition .......................................................... 30
- Activate Software with license from Enterprise Print Manager ........ 32
- Activate Additional Network Clients .......................................... 33
- Activate Pocket NiceLabel ......................................................... 34
- Installing Upgrades ...................................................................... 35
  - Overview .................................................................................. 35
  - Install Minor Version Upgrade ................................................... 35
  - Install Major Version Upgrade ................................................... 35
  - Install Edition Upgrade ............................................................ 36
- Installing Network Upgrades ....................................................... 36
  - Overview .................................................................................. 36
  - Install Minor Version Network Upgrade ...................................... 36
  - Install Major Version Network Upgrade ...................................... 37
  - Install Network Upgrade from Single User Edition ..................... 38
- Activating Upgrades ..................................................................... 38
  - Activate Minor Version Upgrade ............................................... 38
  - Activate Major Version Upgrade ............................................... 38
  - Activate Edition Upgrade ......................................................... 40
  - Activate Network Major Version Upgrade ................................... 40
  - Activate Network Upgrade from Single User Edition .................. 41
- Deactivating Software .................................................................. 43
- Deactivating Software .................................................................. 43
- Enterprise Print Manager ............................................................. 43
  - Introduction to Enterprise Print Manager .................................... 43
  - Label Services ......................................................................... 44
- Limitations of the Demo Mode ...................................................... 45
- Registering the Software ............................................................... 46
- Using License Manager ............................................................... 46
- Setting up the Software .............................................................. 48
- User Interface ............................................................................. 48
  - Basic and Advanced User Interface ........................................... 48
  - Shortcuts ................................................................................. 48
  - Main Window ........................................................................... 51
  - Mouse Wheel support .............................................................. 51
  - Using the Keyboard and Mouse Effectively ................................. 51
- Label Security ............................................................................. 52
  - Tracking Label Design and Printing .......................................... 52
  - Login ...................................................................................... 52
  - Define User Passwords and Permissions ................................. 54
  - Lock Label ............................................................................. 56
  - System Folder ......................................................................... 57
- Designing Labels ......................................................................... 58
- Designing a Basic Label .............................................................. 58
  - Overview ................................................................................. 58
  - Create a Basic Label .................................................................. 58
<table>
<thead>
<tr>
<th>Using Toolbars</th>
<th>Options</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Variable Fields</td>
<td>none</td>
<td>67</td>
</tr>
<tr>
<td>Using Advanced Functionality</td>
<td>none</td>
<td>70</td>
</tr>
<tr>
<td>Creating a Label with GS1-128 (EAN.UCC 128) Compliance</td>
<td>none</td>
<td>70</td>
</tr>
<tr>
<td>Using EPSC</td>
<td>none</td>
<td>73</td>
</tr>
<tr>
<td>Designing Label with Variable Length</td>
<td>none</td>
<td>75</td>
</tr>
<tr>
<td>Controlling Cutter in the Printer</td>
<td>none</td>
<td>76</td>
</tr>
<tr>
<td>Defining Label Batch Printing and Using Header and Tail Labels</td>
<td>none</td>
<td>77</td>
</tr>
<tr>
<td>Designing Double-Sided Label</td>
<td>none</td>
<td>78</td>
</tr>
<tr>
<td>Designing Labels for Mobile Devices</td>
<td>none</td>
<td>79</td>
</tr>
<tr>
<td>Multicolor Printing</td>
<td>none</td>
<td>80</td>
</tr>
<tr>
<td>Setting up Stock Manager to List Commonly Used Labels</td>
<td>none</td>
<td>80</td>
</tr>
<tr>
<td>Tracing Variable Values</td>
<td>none</td>
<td>81</td>
</tr>
<tr>
<td>Using Contents Mask</td>
<td>none</td>
<td>81</td>
</tr>
<tr>
<td>Using Expression Builder</td>
<td>none</td>
<td>82</td>
</tr>
<tr>
<td>Using Label Inspector</td>
<td>none</td>
<td>83</td>
</tr>
<tr>
<td>Using Pictures from the Memory Card</td>
<td>none</td>
<td>84</td>
</tr>
<tr>
<td>Designing an RFID Smart Label</td>
<td>none</td>
<td>85</td>
</tr>
<tr>
<td>Overview</td>
<td>none</td>
<td>85</td>
</tr>
<tr>
<td>Create RFID Smart Label</td>
<td>none</td>
<td>86</td>
</tr>
<tr>
<td>Encode RFID Tag</td>
<td>none</td>
<td>86</td>
</tr>
<tr>
<td>RFID Tag Settings</td>
<td>none</td>
<td>88</td>
</tr>
<tr>
<td>RFID Tag Locking</td>
<td>none</td>
<td>89</td>
</tr>
<tr>
<td>Support for RFID Tags</td>
<td>none</td>
<td>90</td>
</tr>
<tr>
<td>RFID Read and Store Data</td>
<td>none</td>
<td>91</td>
</tr>
<tr>
<td>Database Storage Plugin</td>
<td>none</td>
<td>91</td>
</tr>
<tr>
<td>Changing Printer Settings</td>
<td>none</td>
<td>93</td>
</tr>
<tr>
<td>Changing Common Printer Settings</td>
<td>none</td>
<td>93</td>
</tr>
<tr>
<td>Changing Dithering Options</td>
<td>none</td>
<td>93</td>
</tr>
<tr>
<td>Defining Unprintable Area</td>
<td>none</td>
<td>94</td>
</tr>
<tr>
<td>Using Toolbars</td>
<td>none</td>
<td>95</td>
</tr>
<tr>
<td>Using Standard Toolbar</td>
<td>none</td>
<td>95</td>
</tr>
<tr>
<td>Using Database Toolbar</td>
<td>none</td>
<td>95</td>
</tr>
<tr>
<td>Using Design Toolbar</td>
<td>none</td>
<td>96</td>
</tr>
<tr>
<td>Using Printing Toolbar</td>
<td>none</td>
<td>96</td>
</tr>
<tr>
<td>Using Text Toolbar</td>
<td>none</td>
<td>97</td>
</tr>
<tr>
<td>Using Toolbox</td>
<td>none</td>
<td>98</td>
</tr>
<tr>
<td>Using Variable Toolbar</td>
<td>none</td>
<td>98</td>
</tr>
<tr>
<td>Using Zoom Toolbar</td>
<td>none</td>
<td>99</td>
</tr>
<tr>
<td>Working with Objects</td>
<td>none</td>
<td>100</td>
</tr>
<tr>
<td>Using Text Wizard</td>
<td>none</td>
<td>100</td>
</tr>
<tr>
<td>Using Bar Code Wizard</td>
<td>none</td>
<td>108</td>
</tr>
<tr>
<td>Defining Objects</td>
<td>none</td>
<td>111</td>
</tr>
<tr>
<td>Using EAN.UCC 128 Wizard</td>
<td>none</td>
<td>115</td>
</tr>
<tr>
<td>Selecting Bar Code Type</td>
<td>none</td>
<td>121</td>
</tr>
<tr>
<td>Working with Images</td>
<td>none</td>
<td>130</td>
</tr>
<tr>
<td>Designing Objects with Relative Positions</td>
<td>none</td>
<td>133</td>
</tr>
<tr>
<td>Rotating Label</td>
<td>none</td>
<td>133</td>
</tr>
<tr>
<td>Selecting Objects</td>
<td>none</td>
<td>134</td>
</tr>
<tr>
<td>Editing Objects</td>
<td>none</td>
<td>134</td>
</tr>
<tr>
<td>Moving Objects</td>
<td>none</td>
<td>135</td>
</tr>
<tr>
<td>Aligning Objects</td>
<td>none</td>
<td>135</td>
</tr>
<tr>
<td>Resizing Objects</td>
<td>none</td>
<td>136</td>
</tr>
</tbody>
</table>
### niceprint

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rotating Objects</td>
<td>136</td>
</tr>
<tr>
<td>Grouping Objects</td>
<td>136</td>
</tr>
<tr>
<td>Clipart Galleries</td>
<td>137</td>
</tr>
<tr>
<td>Font Files</td>
<td>137</td>
</tr>
<tr>
<td>Supported Graphics Formats</td>
<td>138</td>
</tr>
<tr>
<td>Working with Text Objects</td>
<td>139</td>
</tr>
<tr>
<td>Working with Variable Data</td>
<td>139</td>
</tr>
<tr>
<td>Dynamic Data Overview</td>
<td>139</td>
</tr>
<tr>
<td>Contents Providers</td>
<td>140</td>
</tr>
<tr>
<td>Working with Variables</td>
<td>143</td>
</tr>
<tr>
<td>Working with Functions</td>
<td>157</td>
</tr>
<tr>
<td>Working with Databases</td>
<td>163</td>
</tr>
<tr>
<td>Creating Custom Check Digit</td>
<td>189</td>
</tr>
<tr>
<td>Special Characters</td>
<td>190</td>
</tr>
<tr>
<td>Working with Memory Cards</td>
<td>193</td>
</tr>
<tr>
<td>Using Label Setup Wizard</td>
<td>195</td>
</tr>
<tr>
<td>Defining Label Dimensions</td>
<td>195</td>
</tr>
<tr>
<td>Stock</td>
<td>197</td>
</tr>
<tr>
<td>Selecting Label Layout</td>
<td>198</td>
</tr>
<tr>
<td>Defining the Page Size</td>
<td>199</td>
</tr>
<tr>
<td>Selecting Printer</td>
<td>200</td>
</tr>
<tr>
<td>Using Document Storage Server</td>
<td>200</td>
</tr>
<tr>
<td>Printing and Previewing Labels</td>
<td>202</td>
</tr>
<tr>
<td>Preview and Print a Label</td>
<td>202</td>
</tr>
<tr>
<td>Store and Recall Printing Mode</td>
<td>202</td>
</tr>
<tr>
<td>Previewing Pictures</td>
<td>204</td>
</tr>
<tr>
<td>Optimize the Printing Speed</td>
<td>204</td>
</tr>
<tr>
<td>Reprint Labels</td>
<td>205</td>
</tr>
<tr>
<td>Use Custom Edit Forms</td>
<td>206</td>
</tr>
<tr>
<td>NicePrint</td>
<td>207</td>
</tr>
<tr>
<td>Integration and Connectivity</td>
<td>208</td>
</tr>
<tr>
<td>Overview</td>
<td>208</td>
</tr>
<tr>
<td>Command Files</td>
<td>208</td>
</tr>
<tr>
<td>Use Command Files</td>
<td>208</td>
</tr>
<tr>
<td>Command File: JOB File</td>
<td>209</td>
</tr>
<tr>
<td>Automatic Print with JOB Files</td>
<td>209</td>
</tr>
<tr>
<td>Using JOB Files</td>
<td>209</td>
</tr>
<tr>
<td>Command File: CSV File</td>
<td>210</td>
</tr>
<tr>
<td>Command File: XML File</td>
<td>211</td>
</tr>
<tr>
<td>Automating the Software</td>
<td>213</td>
</tr>
<tr>
<td>Automation with ActiveX</td>
<td>213</td>
</tr>
<tr>
<td>Automation with DDE</td>
<td>214</td>
</tr>
<tr>
<td>Integration to SAP R3</td>
<td>214</td>
</tr>
<tr>
<td>Integration to SAP/R3</td>
<td>214</td>
</tr>
<tr>
<td>Label Export</td>
<td>214</td>
</tr>
<tr>
<td>Label Export</td>
<td>214</td>
</tr>
<tr>
<td>Label Export</td>
<td>216</td>
</tr>
<tr>
<td>NiceComands</td>
<td>216</td>
</tr>
<tr>
<td>NiceComands</td>
<td>217</td>
</tr>
<tr>
<td>COMMENT</td>
<td>217</td>
</tr>
<tr>
<td>Command</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------</td>
</tr>
<tr>
<td>CREATEFILE</td>
<td>217</td>
</tr>
<tr>
<td>DELETEFILE</td>
<td>217</td>
</tr>
<tr>
<td>EXPORTLABEL</td>
<td>218</td>
</tr>
<tr>
<td>LABEL</td>
<td>218</td>
</tr>
<tr>
<td>LABELCLOSE</td>
<td>218</td>
</tr>
<tr>
<td>LOGIN</td>
<td>219</td>
</tr>
<tr>
<td>MESSAGEBOX</td>
<td>219</td>
</tr>
<tr>
<td>OEMTOANSI</td>
<td>219</td>
</tr>
<tr>
<td>PORT</td>
<td>219</td>
</tr>
<tr>
<td>PRINT</td>
<td>220</td>
</tr>
<tr>
<td>PRINTER</td>
<td>220</td>
</tr>
<tr>
<td>PRINTJOBNAME</td>
<td>221</td>
</tr>
<tr>
<td>QUIT</td>
<td>221</td>
</tr>
<tr>
<td>RETURN</td>
<td>221</td>
</tr>
<tr>
<td>SESSIONEND</td>
<td>221</td>
</tr>
<tr>
<td>SESSIONPRINT</td>
<td>221</td>
</tr>
<tr>
<td>SESSIONSTART</td>
<td>221</td>
</tr>
<tr>
<td>SET</td>
<td>222</td>
</tr>
<tr>
<td>SETDATABASE</td>
<td>222</td>
</tr>
<tr>
<td>SETPRINTPARAM</td>
<td>223</td>
</tr>
<tr>
<td>SETTABLE</td>
<td>223</td>
</tr>
<tr>
<td>TEXTQUALIFIER</td>
<td>223</td>
</tr>
<tr>
<td>Command Line Parameters</td>
<td></td>
</tr>
<tr>
<td><strong>Technical Support</strong></td>
<td>226</td>
</tr>
<tr>
<td>Online Support</td>
<td>226</td>
</tr>
<tr>
<td>Contact Information</td>
<td>226</td>
</tr>
</tbody>
</table>
Introduction

Welcome to NiceLabel

NiceLabel is a family of professional labeling software products that brings a complete bar code printing solution and RFID Smart Label printing to desktop, mobile and enterprise users. NiceLabel offers an easy-to-use interface and meets any label design and printing requirement for efficient label printing solutions to users in retail, logistics, health care, chemical, automotive and other industries.

The main product lines include NiceLabel Suite, NiceLabel Pro, NiceLabel Express, NiceLabel SE and Pocket NiceLabel.

For demanding enterprise environments NiceLabel software is available in the NiceLabel Print Center and NiceWatch Enterprise editions.

For software developers and integrators NiceLabel software is available in the NiceLabel SDK, NiceLabel PocketSDK and NiceLabel WebSDK editions.


The latest software is available for download on the NiceLabel product web site at www.nicelabel.com.

Contents of the Package

Before starting the installation of the NiceLabel labeling software check the contents of the package to ensure it is complete. The package must include:

- NiceLabel CD
- Installation Guide
- Quick Start Guide
- Software key, or optionally a hardware key (not available with all editions)

If any of the mentioned items are missing, please contact your software vendor immediately for package replacement.

About this Manual

The User Guide helps you design and print labels quickly.

The User Guide contains the following sections:
Introduction: This chapter will introduce you to the labeling software.

Installation and Activation: Learn how to install and activate the labeling software.

Setting up the Labeling Software: Learn how to set up and customize software to your preferences.

Designing Labels: Learn how to create labels. You should refer to this chapter regularly while designing labels, until you have completely familiarized yourself with the commands. By using the information contained in this chapter, you will be very quickly able to use labeling software efficiently.

Printing and Previewing Labels: Learn how to print and preview labels.

Integration and Connectivity: This chapter describes how labeling software can be used for seamless integration of label printing to your custom applications and which connectivity methods are available for including labelling to information systems without any modifications to existing applications.

Technical Support: Contacting technical support.

Software Restrictions

All features explained in the Quick Start Guide are available in the NiceLabel Suite edition. However, some features are not available in the NiceLabel Pro or NiceLabel Express editions. Sections discussing features not available with NiceLabel Pro or NiceLabel Express will display an alert icon, or non supported functionality will be clearly marked.

Typographical Conventions

Text that appears in bold refers to menu names and buttons like the OK button.

Text that appears in italic refers to options, confirming actions like Read only and locations like Folder.

Text enclosed in <Less-Than and Greater-Than signs> refers to keys from the desktop PC keyboard like <Enter>.

Variables are enclosed in [brackets] like [variable].

Product Overview

NiceLabel Software Products

NiceLabel is a family of professional labeling software products that brings a complete bar code printing solution and RFID Smart Label printing to desktop, mobile and enterprise users. Software offers an easy-to-use interface and meets any label design and printing requirement for efficient label printing solutions to users in retail, logistics, healthcare, chemical, automotive and other industries.

NiceLabel family of products offers the following:

- Standard Series
• Represent the most complete range of “standard” labeling software
• Easy to use but offers powerful functions expected from advanced label designers
• Unique selling points: NiceForm, NiceWatch & Pocket NiceLabel
• Tight control over printing process – NicePrintQueue & bi-directional drivers, reprint functionality

• **Enterprise Series** (Products for enterprises and toughest demands)
• NiceLabel Print Center
• NiceWatch Enterprise

• **Developer Series** (Integration solution for software publisher - "print engine")
• NiceLabel SDK: SDK for software publishers, who need label printing capabilities in their software. NiceLabel SDK can be embedded in existing information systems or existing applications to provide support for label printing. NiceLabel SDK provides all label printing functionality of the software.
• NiceLabel PocketSDK
• NiceLabel WebSDK

### NiceLabel Suite

NiceLabel Suite is a complete software solution for any kind of label design and print requirement. Multiple connectivity options allow users to perform stand-alone printing or integrate label printing into any network environment.

NiceLabel Suite offers interactive label printing capabilities such as integrating label printing into existing applications (ActiveX) or non-programming embedding of label printing to existing systems (NiceWatch).

NiceLabel Suite includes the following programs:

• **NiceLabel Pro**: Main application for label design and printing.
• **NiceForm**: Create your own custom designed data-entry applications without requiring any programming skills.
• **NiceWatch**: Integrate and automate label printing to any existing information system.
• **NiceMemMaster**: Download fonts and graphics to the printer's internal memory or memory card for optimized label printing.
• **NiceData**: Manage your databases.
• **NicePrint**: Manage fast and easy label printing.
• **NicePrintQueue**: manage your print jobs.

NiceLabel Suite is available in Print Only edition as well.

For detailed information about a particular program please refer to User Guide, available on the product CD and web site.

### NiceLabel Pro

Full-featured software designed for professional label design and printing, including complete database support and ActiveX integration possibilities. A wide range of
features and options makes NiceLabel Pro a perfect and easy-to-use tool for any labeling requirement.

NiceLabel Pro includes the following modules:

- **NiceLabel Pro**: Main application for label design and printing.
- **NiceMemMaster**: Download fonts and graphics to the computer’s memory card for optimized label printing.
- **NiceData**: Manage your databases.

NiceLabel Pro is available in Print Only edition as well.

**NiceLabel Express**

Wizard-based software meeting basic bar code labeling needs. The entry-level software includes many design elements of the NiceLabel Pro edition with the emphasis on simplified user interaction.

**NiceLabel Pocket PC Designer**

NiceLabel Pocket PC Designer is a software package for desktop Windows computers that brings the power of label and form design to Windows mobile devices. After you have designed the required labels on the desktop PC, synchronize the labels with the Windows mobile device and print them from the Windows mobile device.

**Pocket NiceLabel**

Pocket NiceLabel is a program package for Windows CE that brings the power of label printing to portable Windows CE computers (Windows Mobile Device).

**NiceLabel SDK**

NiceLabel SDK is an ActiveX integrator edition of software developed for software publishers who need label printing capabilities in their software. NiceLabel SDK can be embedded in existing information systems or existing applications to provide support for label printing. NiceLabel SDK provides all label printing functionality of the software.

**NiceLabel Print Center**

NiceLabel Print Center is enterprise-level labeling solution with centralized control over all clients in the network. The enterprise edition manages the printing process centrally while label design and printing occurs locally on the client computers hosting NiceLabel Suite.

The NiceLabel Print Center software performs the following:

- Centralized print and event logging.
- Centralized control over printers and print queues (print jobs).
- Centralized logging of executed NiceWatch actions.
- Issuing alerts through email, NetSend, Instant Messenger, RSS feed, SMS or pager.
- Flexible licensing for clients.

The NiceLabel Print Center is comprised of two main components:
• NiceLabel Enterprise Print Manager, installed on server,
• NiceLabel Suite, installed on client computers.

The NiceLabel Print Center edition can be used with 32-bit and 64-bit Windows 2000 and Windows 2003 server families.

**NiceWatch Enterprise**

Centralized label printing middleware software that integrates the label printing process into enterprise-level products, such as Enterprise Resource Planning (ERP) systems, Warehouse Management Systems (WHS) and others.

The NiceWatch Enterprise performs the following:

• Multi-threaded label printing execution to ensure fast and stable operation in heavy-load environments (where a lot of print requests happen simultaneously).
• Remote administration to view list of triggers, start and stop triggers.
• Centralized logging of executed actions.

NiceWatch Enterprise includes the following modules:

• **NiceWatch Server**
• **Enterprise Print Manager (EPM)**

NiceWatch Enterprise also includes one NiceLabel Pro license. You will use NiceLabel Pro for label design.

The NiceWatch Server edition can be used with 32-bit and 64-bit Windows 2000 and Windows 2003 server families.
Installation and Activation

System and Software Requirements

Single User Edition
To run the program you need at least the following:

- Pentium based computer with at least 128 MB of free RAM
- One of the 32-bit or 64-bit Windows operating systems: Windows 2000, XP, 2003, 2008 and Vista
- Hard disk with 160 to 550 MB of free disk space (depending on the installation options)
- CD-ROM drive
- Support for OLE DB database drivers. Recent Windows operating systems have included OLE DB database drivers. If your operation system does not have the database support, the installation wizard will prompt you to install it.
- Administrator rights to the local computer during installation

Network Edition
To run the Network Edition you need to fulfill the following:

- All requirements for the single user edition
- Network interface card in each workstation
- Computer acting as a server. Any server operating system that allows file sharing with Windows system (any Windows, UNIX or Netware)
- Each client must have granted full access (read, write, delete) to the System folder on the server
- Local Area Network (LAN)

Note:
The Network edition does not run over WAN or Internet. The server and all clients must be installed on the same LAN.

Pocket Edition
To work with Pocket edition, you need to have the following:

A) Desktop PC to design labels and forms with one of the following Windows operating systems:
  - Windows 2000 Professional with Service Pack 1 or higher
  - Windows XP
  - Windows Server 2003
  - Windows Server 2008
  - Windows Vista

B) Windows Mobile Device meeting the following requirements:
• Installed ActiveSync Version 4.0 or higher
• One of the following Windows operating systems:
  • Pocket PC 2003
  • PocketPC 2003 SE
  • Windows CE 4.2 (CF SP 1)
  • Windows CE 5.0
  • Windows Mobile 2005

---

**Installing Software**

**Installing Software**

When you put the product CD in your CD-ROM drive, the installation/demonstration program will start automatically. You can browse the directory of the CD, look at the brochures and technical documentation, sample files and other documents.

**Note:**
If you are using Windows 2000, XP, 2003, 2008 or Vista, you have to log on with Administrator rights to be able to perform installation.

**Run START.EXE**

Use the installation wizard to install the labeling software on your desktop PC. To install the labeling software, do the following:

1. Put the product CD in your CD-ROM drive. An installation window will open automatically.

**Note:**
If the installation wizard does not start automatically, go to the main CD directory of your product CD and double-click on the file START.EXE.

2. Click on Install. A new window will open showing all available software editions.
3. Click on the software edition you want to install. Follow the prompts.

**Note:**
Make sure to select the appropriate installation type in the installation wizard. The same installation wizard is used for all software editions.

**Close All Software Applications**

To ensure complete installation of the labeling software, close all open software applications before you start installing the labeling software.

**Define Setup Options**

You can select the components of the selected software edition that you want to install. You can choose among the following three types of installations:

• **Full Installation** - installs all software components in all available languages.
Installation and Activation

- **Compact Installation** - installs only minimal set of components required for software to work correctly. Help and sample files are not installed.
- **Custom Installation** – gives you the option to select individual components for installation.

To continue installation, do the following:

1. Click on the **Next** button.
2. Specify the program group you want to use for the labeling software.
3. Specify if shortcuts to labeling software should be created on the desktop or in Quick Launch area.
4. Click on the **Install** button to finish the installation.
5. The Start menu in your Windows will show a new program group for the labeling software that contains shortcuts for all applications.

**Install Printer Driver**

**Install Printer Driver**

You can use the labeling software to design and print labels to standard office printers (laser, inkjet or matrix) or to professional label printers (thermal printers). If you own a thermal printer, you have to install the appropriate printer driver before you can print with the label printer. You will find NiceDrivers for all major thermal printer brands on the product CD and on the product website.

You can install a NiceDriver for your thermal printer in the following three ways:

- Install within the labeling software installation.
- Use the Printer Installation Wizard.
- Use the Windows Add Printer Wizard.

**Printer installation within software installation**

To continue installing the NiceDriver after setup has finished the labeling software installation, do the following:

1. Select the option Install printer driver.
2. Click on the **Finish** button.
3. Printer Installation Wizard will open.
4. Select your printer from the list. Click on the **Next** button.
5. Select the port where you have connected your printer and click on the **Finish** button.

**Note:**
This type of printer installation is available only when running installation from the product CD.
Printer Installation Using the Printer Installation Wizard

1. Put the product CD in your CD-ROM drive. The main installation application should start automatically. If not, start Windows Explorer, browse to the CD and double click on the file START.EXE.
2. Click on Installation. A new window will open showing all software editions and printer drivers.
3. Click on NiceDrivers. The printer installation wizard will start.
4. Select your printer from the list. Click on the Next button.
5. Select the port where you have connected your printer and click on the Finish button.

Note:
If you have downloaded the installation for NiceDriver from the product web site, run the downloaded executable file and follow the steps four (4) and five (5).

Printer Installation Using the Windows Add Printer Wizard

1. Open Control Panel from Settings option in Start menu.
2. Open Printers (Printers and Faxes) and select Add a Printer.
3. Follow the Add Printer Wizard prompts. The actual steps vary depending on the version of your Windows operating system. It is only important to click on the Have disk button in the step where you can select printer manufacturer and model.
4. Put the product CD in your CD-ROM drive (if not already done so) and browse to the folder \Drivers.
5. Select the folder of your printer name and click on Open/OK buttons to return to the Add Printer Wizard. You will see the list of all available printer models of the selected printer.
6. Select your model, click on the Next button and finish the installation.

Note:
Windows 2000, XP and Vista might prompt you to cancel the installation process because NiceDrivers do not have the digital signature by Microsoft. It is safe to continue with the installation at this point. NiceDrivers have not been certified by Microsoft but have been subject of intensive pre-release testing and comply with Microsoft's demands for printer drivers.

Installing Network Edition

Overview

The Network software consists of two parts: the server and the workstation.
First, you must install the labeling software on the server computer and make all files accessible to the clients. Then you can install the labeling software on the workstation (client). Client installation is possible from the server or from the product CD. Both, the server and the client client must be accessible in the same LAN (Local Area Network).

**Important!**
The Network edition does not run if server and client are connected over WAN, internet or similar long-distance connections.

**Note:** NiceLabel SE, NiceLabel Express and NiceLabel Pro editions are not available with network licenses. Only NiceLabel Suite edition can be activated using the network license.

### Define Access Rights for Network Clients

<table>
<thead>
<tr>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator rights to the local computer at the install time</td>
<td>The user that is installing the labeling software on the client computer has to be either Administrator or member of the Administrator group.</td>
</tr>
<tr>
<td>Read-write access to HKEY_LOCAL_MACHINE\SOFTWARE key at install time, read-only access at the run time</td>
<td>It is vital to have Administrator rights to be able to update labeling software related information in the registry. Windows Registry is used to store information about the software installation, file folders and to register the labeling software components and modules. Read-write access is required at install time. Read-only access is required at any other time when the software is run.</td>
</tr>
<tr>
<td>Read-write access to HKEY_CURRENT_USER\SOFTWARE key</td>
<td>User-specific software settings are stored within this registry key. Every user that logs on the computer has his own settings. User has to be able to update his information.</td>
</tr>
<tr>
<td>Read-write access to the System folder in the server installation of the labeling software</td>
<td>The server edition is installed on some computer that has the role of file server. No labeling software is running on this server computer, only files are shared for the clients. The folder where the server is installed has to be shared to the clients. The share mode for all files</td>
</tr>
</tbody>
</table>
**Install the Software on the Server**

Please follow these steps to install the labeling software on the server computer:

1. Make sure that the folder on your server where you want to install the labeling software provides full access admission.
2. Put the product CD in your CD-ROM drive. An installation window will open automatically.

**Note:**
If the installation wizard does not start automatically, go to the main CD directory of your product CD and double-click on the file `START.EXE`.

3. Click on **Install**. A new window will open showing all software editions.
4. Click on **NiceLabel Suite Network (Server)**.
5. Follow the installation prompts.
6. When prompted to **Select Server Location**, type in the network location where you will install the server part of NiceLabel Suite Network edition and click on **Next**.

**Note:**
Make sure you are using UNC syntax when referring to the network location. Use the syntax `\server\share\file` and not the syntax with the mapped drive like `W:\share\file`.

7. You can enter the location of the secondary server that will take over when primary server fails. If you have a computer to act as a secondary licence server, enter the UNC path to the appropriate folder.

**Note:** If unsure, leave the edit field empty. The secondary server is optional.

8. You can create an MSI installation file if you want to automatically deploy the client software on workstations using the Active Directory group policy. You can use the MSI file for silent and unattended installation of software.

**Note:** If unsure, skip this optional step.
9. Click on the **Next** button to finish the installation.

**Note:**
You should select a server and disk share that is visible to all workstations in the domain where you intend to use the software.

---

**Install the Software on the Workstation**

There are two ways how you can install the labeling software Network client on the workstation:

- **Installing the client from CD.**
  Install NiceLabel Suite single user software from the product CD as described in the chapter **Installing Software**.

- **Installing the client from the network.**
  Install the software client by running the installation file NiceLabel-ProSuite5.exe from the labeling software server.

Follow these steps to install the client from the network:

1. Open Windows Explorer.
2. Browse to the labeling software server computer in **My Network Places**.
3. Browse to the folder where the labeling software is installed on the server.
4. Double click on the file **NiceLabel-ProSuite5.exe**.
5. Follow on-screen instructions. Just make sure to install NiceLabel Suite edition, not NiceLabel Pro. For detailed instructions you can also refer to the installation of the single user edition in the chapter **Installing Software**.

**Note:**
The labeling software client installed on the workstation must have full access (read, write, delete) to the System subfolder on the server computer.

6. Click on **Finish** button to finish the installation.

---

**Install the Client in Unattended Mode with Group Policy**

You can install the Network clients with two approaches:

1. **Interactive installation mode.**
   You need to start the installation manually on each workstation. Smart administrator will use the Remote Desktop, VNC or similar application to get access to the remote computer from one central console. Otherwise, the administrator will have to sit in front on each workstation and install the client from there.

2. **Unattended installation mode.**
   In this case the client installs automatically with a directive from Windows Active Directory.

The "Group Policy" allows the administrators to deploy the software without any user intervention on the workstations. When the group policy is in place the client can install automatically when the user logs into the system the next time, or the installation of the client can be forced at any time.
If you want to take advantage of the unattended installation mode, you need to prepare the labeling software installation that is compatible with the group policy. The group policy requires that you prepare the software installation in the form of the .MSI package.

To create the .MSI installation package, do the following:

1. Start the installation of the Network server.
2. Follow the on-screen instructions until you reach the step **Group Policy Installation.** By default the group policy installation is disabled.
3. Enable the option **Create MSI file for Group Policy deployment.**
4. Select the client components to include in the .MSI installation file. The selected applications will install on the workstations.
5. Define the path where the .MSI file will be saved into.
6. Click **Next.**
   The .MSI file will be generated.

Once you have the .MSI installation file, you can include it in your group policy.

**More information about the group policy:**

- **HOW TO: Use Group Policy to Remote Install Software on** support.microsoft.com
- **Using Group Policy to Deploy Applications on windowsnetworking.com**

**Install on Windows Terminal Services and Citrix Metaframe**

Before you start with the Network installation on the Windows Terminal Services or Citrix Metaframe, read the White Paper explaining how to use the labeling software with Windows 2000 Terminal Services and Citrix Metaframe. The White Paper is available on the product CD and the product website.

**Enable Offline Mode**

The Network edition depends on the network server that holds the program files and common data used by all workstations. In case of server or network failure, the whole system would fail. Off-line mode successfully copes with such situations and workstations are still able to operate, but some limitations apply.

The other case of Off-line usage is the use of labeling software with laptop users. In a company that has a Network version installed some of the workstation installs are performed on laptop computers. If this computer is detached from the network, the regular labeling software will not operate. Off-line mode successfully copes with this situation and enables you to use the Network edition even without connection to the network.

Switching the labeling software to off-line mode is done with License Manager program. When you start License Manager from Help menu, it will use one license for itself. This currently occupied license can be assigned as **Available Off-line.** When this option is enabled, your workstation will be able to operate without the server or network being on-line.
**Note:** The client running in the off-line mode will occupy one license. Off-line mode causes the license to be used all the time. When the Network client is started in off-line mode, it does not occupy another license. After it quits it also does not release this license. The number of all available licenses is thus reduced by one.

If you want to release the off-line license, start License Manager again (Help -> Manage License). Click the button **Disable Off-line** and you will cancel the off-line mode and release the license.

The system requirement for off-line mode to work is local installation of labeling software. Make sure to select the option Copy files to local hard disk in install program on all workstations for which you want to enable off-line mode. You must install all labeling applications to the local disk.

When the labeling software is started in off-line mode it will use local copy of the system files. For this purpose a local copy of System folder from the server computer will be made. When labeling software starts it will determine if server is accessible. If it is, server files will be used. If not, local copy of system files will be used.

When the workstation is running in off line mode, there are few important issues that have to be considered. All functionality of the labeling software is not available in the off-line mode.

**Note:** If you activate your Network client with the licenses from the Enterprise Series edition, you can also enable the offline mode using the same procedure as for the client from the Standard Series.

### Limitations of the Network Offline Mode

<table>
<thead>
<tr>
<th>Global variables</th>
<th>Global variables cannot be used in off line mode. If the local copy of global variable and a copy on another workstation or server would be used at the same time, the serial numbers would be duplicated.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log file</td>
<td>If you are using MS Access log file, the log will be created, but will not be merged with the main system log file when online mode is restored. If you are using Text format of the log file and the path to the log file is not accessible, the data will not be saved to log file.</td>
</tr>
<tr>
<td>Location of labels, database, graphics, etc.</td>
<td>The availability of necessary label files is up to the user. The labeling software will not duplicate these files. If you are using Windows 2000 (or newer) environment, you can enable off-line system accessibility directly in the Windows system with the option Make Available Off-line.</td>
</tr>
<tr>
<td>Number of off-line clients</td>
<td>The maximum number of off-line workstations is limited to half of the purchased licenses.</td>
</tr>
<tr>
<td>Login</td>
<td>Login protection and custom software usernames are disabled</td>
</tr>
</tbody>
</table>

NiceLabel Pro User Guide
Lease period

Off-line client cannot occupy a software license for unlimited period of time. Maximum lease period of every license is 15 days. If the client does not reconnect to the server in on-line mode in this time period, its license will expire and be released to some other client.

Lease period also considers the license used by a computer that will never login in on-line mode and normally release it (computer crashed beyond repair, computer got stolen etc.). When lease period expires, the license will be returned to the group of available licenses on the server.

Migrate Network Edition to New Server Computer

This topic provides you with information what you have to pay a special attention to, if you want to migrate the Network edition to another server computer.

1. First prepare the new server computer. You will have to install the same version of the Network edition to it from scratch. Please refer to the topic Install Software to the Server how it is done.
2. Deactivate the software. Select Help -> Manage License, then follow on-screen instructions. During the deactivation process you must have the access to the internet, or the process will fail. Your current network software key number will be transferred back to the activation server. See Related Topics for more information.
3. When the new server computer has labeling software properly installed and activated, the only thing left to do is to restore the previous program settings and data files.

The files that need to be copied on the new server computer, if you want to retain the previous settings, are:

- Global variables (GLOBALS.TDB)
- The software settings and list of users (SETTINGSDB.MDB)
- Log file (LOGDATABASE.MDB)
- Custom algorithm definition file (ALGO.DEF)
- Stock database (STOCKDB.MDB)
- Etc.

These files are located in the System folder of the server installation. When this step is completed, new software installation should have the same settings as the old one.

Note:
Make sure, that no user is running labeling software at the time, when you copy files, so the files can be overwritten.
4. You must perform one more task is remaining to be done. You probably want to copy the label, form and database files to the new server computer as well. By default the labeling software uses the directory structure with several subfolders, each for its own files:
   - Labels for label files (.LBL)
   - Forms for form files (.XFF)
   - Database for database files

Copy the contents of these folders to the new server to create duplicated file storage.

**Recovering Lost Licenses**

When the labeling software client connects to the server, one license gets occupied. If from some reason the client computer stops responding, freezes or locks up and you are forces to reboot it, the license will still remain in use on the server.

There is a simple way to recover such license. When computer restarts just re-run the labeling software. The client will find its previous license on the server and will not occupy another one. Then close the labeling software and the license will be released.

**Use Primary and Secondary Server**

You should use the primary and secondary server whenever you strive to provide reliable label printing system. In this dual-mode scenario the client licenses are stored on both servers at the same time. Whenever you start the client, it will check the primary server and try to access the license. If the primary server is not available, the client will try to access the secondary server and obtain the license from there.

The ability to store the license on primary and secondary server makes your label printing solution more robust.

**Note:**
- To install the licenses on two servers, make sure to tick the option **Enable Secondary Server** during the server installation process and select also the name and shared folder of the second server.
- To enable the client to use the license from primary and secondary server, make sure to select path for the **Secondary (backup) network location** as well, not only for the **Primary network location**.

The benefits using the secondary server mainly involve fail-save solution in case of primary server break-down. If the primary server becomes inaccessible, the secondary server will take over its role:
   - The same licenses are available also on the secondary server.

**Note:**
You need a single Network Software Key to install the licenses on both servers. Just make sure to provide paths to BOTH servers during the installation process. **Do not make two separate server installations.**
   - Synchronization of files with user definitions and label stock files is done to the secondary server.
Note:
The synchronization is performed from the primary to the secondary server only. When the primary server is down and you continue using the labeling software, all the logging is done on the secondary server. But the data is not synchronized back to the primary server.

- The global variables are NOT synchronized. Each client has its own local file that stores the values of global variables (by default in the System folder). The filename of the file storing values of global variables is Globals.tdb.
  To change the location of the file with global variables, do the following:
  1. Open **Tools -> Options**.
  2. Select **General -> Folders** tab.
  3. Select the appropriate folder for the **Variables**. Point to the location of the folder that stores the file **Globals.tdb**.
  4. Click **OK**.

- The log file is NOT synchronized.
  To change the location of the log file, do the following:
  1. Open **Tools -> Options**.
  2. Select **General -> Log file**.
  3. Look at **Advanced** section, and select the appropriate folder for the **Local database location**. Point to the location of the folder that will store the log file.
  
  **Note:**
  If you use MS Access type of the log file, the filename is **LogDatabase.mdb**.
  
  4. Click **OK**.

---

### Installing Pocket Edition

**Overview**

Pocket labeling software enables you to create robust data entry screens and print application for your mobile device. Pocket labeling software is a print-only solution for your Mobile Windows devices.

With the help of Pocket labeling software users can print bar code labels directly with Windows Mobile Devices that are connected with thermal printers through WiFi, Bluetooth, Infrared or serial cable. In addition, Pocket labeling software enables bar code label printing in a network environment. Using NiceWatch middleware integration module, you can print bar code labels to a centralized print server that handles printing and driver selection. Pocket labeling software and centralized printing through NiceWatch offer a truly mobile distributed printing application.

Pocket labeling software can also be used as a print engine (ActiveX server) to enable other applications on your mobile device to control label printing functions. Using Pocket labeling software as a print engine appeals to system integrators and software developers who wish to utilize Pocket labeling software as a label printing module for
their mobile applications. For more information about utilizing Pocket labeling software as a print engine in a customized mobile Windows application, visit the product web site www.nicelabel.com.

**Setup and Test Mobile Device Setup**
Before you can install the Pocket labeling software, you have to familiarize yourself with your Mobile Device. You must know what processor type and what Windows CE operating system your device uses. In addition, you have to be able to establish functioning communication between both your desktop computer and Mobile Device through an established ActiveSync partnership, Mobile Device and (thermal) label printer through serial cable, WiFi, Infrared or Bluetooth.

Please refer to the documentation of your mobile device to learn about processor, operating system and how to establish different communication modes.

**Install Pocket NiceLabel**
Before you install Pocket labeling software, make sure you have the following:

- Product CD-ROM
- User Guide for Pocket NiceLabel
- 25-digit Serial Number (Client Access Number)

**Note:**
You have to log on with administrator rights to be able to install the software properly. Furthermore, you must ensure that your Mobile Device works properly, including file synchronization with ActiveSync and any printing capabilities your Mobile Device supports.

To install Pocket labeling software, do the following:

1. Connect your Mobile Device to the desktop PC.
2. Make sure that an ActiveSync partnership is established between the desktop PC and Mobile Device.
3. Put the product CD-ROM in your CD drive. The START.EXE application will start automatically. If not, go the folder ‘X:\’ and click on the file START.EXE (‘X’ stands for the letter of your CD-ROM drive). The window Product CD will open.
4. Click on Install.
5. Click on Mobile Printing Editions (CE.NET).
6. Click on Pocket NiceLabel and follow the prompts.
7. Select the correct Operating System or Platform for your Mobile Device.
8. Follow the prompts to finish the installation.
9. If Pocket labeling software installation on your desktop PC is complete, ActiveSync will start and transfer the necessary files to the Mobile Device. Follow the prompts on both the desktop PC and Mobile Device.

The Pocket labeling software will be stored in the folder \Program Files. It will also appear in the Start Program menu of your Mobile Device.
Activating Software

Activating Software

The following activation instructions work for single-user and network editions.

You have to activate the software if you want to use it. If you do not complete the activation process, the software will run in demo mode.

The Product Activation utility will always run after installation. If you want to change the activation type or add more licenses to your network edition, you can also start activation from the labeling software. Select Help -> Manage License.

There are the following types of the software activation:

- Hardware key activation
- Single-user Software key activation
- Network Software key activation

**Note:**
NiceLabel SE, NiceLabel Express and NiceLabel Pro editions do not have the network licensing, or Enterprise Print Manager license server.

**Hardware key activation:** The software editions with hardware key can be used immediately after installation. If you have a software edition with a hardware key, please skip ahead to the chapter Activate the Software with a Hardware Key.

**Single-user Software key activation:** The software editions with a single-user software key need to run the activation application in order to obtain full functionality. The Software Key number is a sequence of 25 characters.

**Network Software key activation:** You can activate the server part of the Network edition the same way as editions that come with a single-user software key. The Network Software Key number is a sequence of 25 characters. Activating the server part will also activate the client on the current workstation. If you upgrade the network edition with additional users, you have to install and activate each additional workstation separately. Please refer to the chapter Activate Additional Network Clients.

**Enterprise Print Manager license server:** You can activate the labeling client with the license coming from the Enterprise Print Manager (EPM). Enterprise Print Manager is available with the Enterprise Series edition NiceLabel Print Center. Before you can activate the client, you must activate the NiceLabel Print Center.

**Activate Software with a Hardware Key**

You can activate the single user editions with a parallel or USB key. However, you cannot activate the network edition with a hardware key!

Make sure you have finished installing the software on your PC when you activate your single user edition with a hardware key.

**Activate the with a Parallel Key**
To install a parallel key, do the following:

1. Shutdown your computer and switch off your printer.
2. Connect the hardware key directly to the parallel port (marked as LPT or PRN port) on your computer.
3. Make sure you connect the hardware key in such a manner that pins on the key plug into the holes in the computer port. Fasten the two screws to secure the key.

**Note:**
Do not remove the screws or try to turn them inside out.
Never try to connect the key to a serial port on the computer or directly to a printer. You can permanently damage the hardware key as well as your computer equipment.

3. Start the labeling software. A Warning window will open.
4. Click on the Manage License button. The Manage License window will open.
5. Select **Activate the package** and click on **Next**.
6. Select Hardware Key and click on **Next**. A new Manage License window will open showing the key license information for your labeling software.
7. Click on the **Finish** button and the labeling software will start in full working mode.

**Note:**
If you own a serial printer, you cannot connect the printer to the hardware key directly because the connectors are not compatible. Always connect your serial printer to the serial port and hardware key to the parallel port. Your printer does not need to print "through" the hardware key.

**Activate the labeling software with a USB Key**

To activate the labeling software using a USB key, do the following:
1. Plug the USB key into an available USB port.
2. Start the labeling software. A Warning window will open.
3. Click on the Manage License button. The Manage License window will open.
4. Select Activate the package and click on Next.
5. Select Hardware Key and click on Next. A new Manage License window will open showing the key license information for your labeling software.
6. Click on the Finish button and labeling software will start in full working mode.

**Activate Single User Edition**

You can activate the labeling software automatically through the Activation Server or manually through the activation Key Number Activation Web site. The activation on the Web only works with single-user software key and network software key. If the computer that uses the labeling software is not connected to the Internet, you will have to open the Activation Web page on a computer with Internet access to obtain the activation information.

Before you start the activation process of the labeling software, get familiar with the following terminology:

- **Key number**: The sequence of 25 characters provided with the labeling software.
- **Registration number**: Unique number generated during the activation process. The registration number validates the entered software key.
- **Activation code**: Issued on the labeling activation Web site. The activation code activates the labeling software on your computer.

To activate the labeling software, do the following:

1. After the installation is complete, run the labeling software. The Warning window will open.
2. Click on Manage License. The Manage License window will open.
3. Select Activate the package and click on Next.
Selecting 'Single-user Software Key' activation

2. Select Single-user Software Key and click on Next.
3. Enter the required customer information and the key number.
4. Click on the Next button. The window Manage License – Activation Code will open.
5. To activate the software automatically, click on the link Connect to the Activation server (recommended).
6. To activate the software manually, click on the Internet link for Web page activation. Your Internet browser will open the Key Number Activation Web site.
   - Enter the key number and the registration number. Enter other user information, if prompted.
   - Click on the Activate button to retrieve the Activation code.
   - Copy the Activation code and paste it in the field Activation Code in the open Manage License – Activation code window of the opened labeling software.
7. Click on the Next button and follow the prompts to complete the activation process.

Note:
You can still activate the labeling software if the computer does not have access to the Internet.
If the computer where you installed the labeling software does not have Internet access, do the following:

1. Follow the steps one (1) to four (4) from the previous section.
2. Write down the Key number and the Registration number.
3. Write down the Internet activation Web address.

**Note:** You can also click the button **Save Data** and store the activation information to the text file. It will save you some time as you do not have to write down the numbers.

4. Go to a computer with Internet access and open the activation Web site in the Internet Explorer.
5. Enter the Key number and the Registration number. Enter other user information when prompted.

### Key Number Activation

Welcome to the software activation site. Please copy the data from your activation dialog box into the fields below. Then press the ACTIVATE button.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key Number</td>
<td></td>
</tr>
<tr>
<td>Registration Number</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td></td>
</tr>
<tr>
<td>Company</td>
<td></td>
</tr>
<tr>
<td>Address 1</td>
<td></td>
</tr>
<tr>
<td>Address 2</td>
<td></td>
</tr>
<tr>
<td>Zip</td>
<td></td>
</tr>
<tr>
<td>City</td>
<td></td>
</tr>
<tr>
<td>Country</td>
<td></td>
</tr>
<tr>
<td>E-mail</td>
<td></td>
</tr>
</tbody>
</table>

* - required

![Activate Button](activate-button.png)

**Internet Activation Website**

6. Click on the **Activate** button to retrieve the Activation code. Write it down.

**Note:**
The Key and Registration numbers, the Activation code and information in other fields are case-sensitive, so be careful when writing it down.

7. Go back to the client computer where the window Manage License is still open.
8. Enter the Activation code.
9. Click on the **Next** button and follow the prompts to complete the activation process.

**Move the Software License to Another Computer**

The labeling software will run in unlimited mode on each computer, where you have activated the labeling software. You can activate the software with a hardware key, or software key (single user or multi-user license).

To move the software license to another computer when you have the **hardware key**, do the following:

1. Disconnect the hardware key (USB or parallel port variant) from your computer.
2. Install the labeling software on the new computer.
   Follow the steps in the topic **Installing Software**.
3. Activate the labeling software on the new computer.
   Follow the steps in the topic **Activate Software with a Hardware Key**.

To move the software license to another computer when you have the **software key** (25-character number), do the following:

1. Run NiceLabel Pro on currently active computer.
2. Select Help -> Manage License.
3. Enable the option **Manage current software key license**.
4. Click **Next**.
5. Select the option **Deactivate License** and click **Finish**.
   Selecting this option will remove the license from your computer and store it back to the activation server.

**Note:** The computer must have access to the internet to be able to transfer the license to the activation server.

6. Install the software on the new computer.
   Follow the steps in the topic **Installing Software**.
7. Activate the software on the new computer.
   Follow the steps in the topic **Activate Single User Edition**.

**Activate Network Edition**

You can activate the labeling software network edition only with a 25-digit software key. The network edition does not provide the activation option with a parallel or USB hardware key. Before you start the activation process of the labeling software, get familiar with the following terminology:

- **Key number:** The sequence of 25 characters provided with the labeling software.
- **Registration number:** Unique number generated during the activation process. The registration number validates the entered software key.
- **Activation code:** Issued on the activation Web site. The activation code activates the labeling software on your computer.
To activate the network edition, do the following:

1. After you have installed the server and client parts of the network edition, run the labeling software from your server computer. No valid license is found. Click on the button **Manage License**.
2. Select **Network Software Key** and click on **Next**.
3. The primary network location path should be the same as the one entered at installation (see the chapter **Install Software on the Server**) and click on **Next**.

**Note:**
Make sure you are using UNC syntax when referring to the network location. Use the syntax `\server\share\file` and not the syntax with the mapped drive like `W:\share\file`.

4. Enter the required customer information and the key number and click on **Next**.
5. To activate the software automatically, click on the link **Connect to the Activation server** (recommended).
6. To activate the software manually, click on the provided Internet link for Web page activation. Your Internet browser will open the Network Key Number Activation Web site.
   - Enter the key number and the registration number. Enter other user information, if prompted.
   - Click on the **Activate** button to retrieve the **Activation code**.
   - Copy the Activation code and paste it in the field Activation Code in the open Manage License – Activation code window of the opened labeling software.
7. Click on the **Next** button and follow the prompts to complete the activation process.

**Note:**
You can still activate the labeling software if the computer does not have access to the Internet.

If the computer where you installed the labeling software does not have Internet access, do the following:

1. Follow the steps one (1) to four (4) from the previous section.
2. Write down the Key number and the Registration number.
3. Write down the Internet activation Web address.

**Note:** You can also click the button **Save Data** and store the activation information to the text file. It will save you some time as you do not have to write down the numbers.

4. Go to a computer with Internet access and open the activation Web site in the Internet Explorer.
5. Enter the Key number and the Registration number. Enter other user information when prompted.
6. Click on the **Activate** button to retrieve the Activation code. Write it down.

**Note:**
The Key and Registration numbers, the Activation code and information in other fields are case sensitive, so be careful when writing down the numbers.

7. Go back to the client computer where the window Manage License is still open.
8. Enter the Activation code.
9. Click on the **Next** button and follow the prompts to complete the activation process.

**Activate Software with license from Enterprise Print Manager**

Enterprise Print Manager (EPM) is the component of NiceLabel Print Center edition. EPM stores the client licences in its License server.

To activate the client with a license from EPM, do the following:

1. After the installation of the labeling client is complete, run NiceLabel Pro. The **Warning** window will open.
2. Click on **Manage License**. The **Manage License** window will open.
3. Select **Activate the package** and click on **Next**.

![Image of Product Activation Wizard](image)

Selecting "Enterprise Print Manager license server" activation

4. Select **Enterprise Print Manager license server** and click on **Next**.

5. Enter the name of the Windows server where EPM is installed, click on **Next**.

If the license from the EPM is successfully obtained, the client log settings will be changed to send all log information to central location in EPM.

**Note:** When you use license from EPM, the log data can be stored only on the EPM, only in the local Access database, or combined on both locations. To change the log settings open **Tools -> Options** and make the change.

If your NiceLabel Print Center is not already activated, no licenses are available in the EPM. Before you can activate the clients with licenses from EPM, you must activate the NiceLabel Print Center. Have your 25-character Activation Software Key ready and follow on-screen instructions, or refer to the NiceLabel Print Center user guide.

**Activate Additional Network Clients**

The Network client you have used for activation of the Network server is activated automatically as well. To activate additional Network clients on other workstations please follow these steps:

1. Install labeling software on the workstation.
2. Start the labeling software. No valid license is found and the window Manage License opens.
3. Select Network Software Key and click on Next.
4. Browse for the location where the Network edition was installed and click on the Next button.
   The license information will be copied from the server.

**Note:**
Make sure you are using UNC syntax when referring to the network location. Use the syntax `\server\share\file` and not the syntax with the mapped drive like `W:\file`.

The Network client is activated. The full version of the labeling software can only run on the workstation if the licensing server has enough licenses available. If no license is available, you can only work with the Demo Mode and have to wait until one of the client currently running the labeling software logs off.

**Activate Pocket NiceLabel**

**Note:**
The text in this topic applies to NiceLabel Suite edition that includes one Pocket NiceLabel Client Access License.

The licensed version of Pocket edition comes with a 25-digit Client Access License (CAL) number that releases the application from DEMO mode and enables you to print labels without limitations from your Windows Mobile Device. To get your Client Access License for Pocket edition, you must have the access to the internet from your computer. Do the following:

1. Start NiceLabel Pro.
2. Select Help -> Manage License.
3. Tick the option Manage current software key license. Click Next.
4. Select the option Get Pocket PC edition software key. Click Next.
   The Pocket edition activation web page will open.
5. Make sure that your Software Key Number is correctly entered.
6. Click on the button Get Free Pocket Key. The Pocket edition Key will be displayed on the screen.

To register Pocket edition on your Windows Mobile Device, do the following steps:

2. Read the DEMO warning and tap the YES button.
3. Enter the required information into the registration dialog box on the Mobile Device and tap the Activate button.

Activating Pocket edition with your Mobile Device will remove the DEMO mode limitations. The CAL number you received with your original labeling software is only valid for one (1) Mobile Device. If you want to use Pocket edition with more than one Mobile Device, contact your nearest reseller to upgrade the Client Access License for multiple devices.
Installing Upgrades

Overview
You can upgrade the labeling software in the following ways:

- Upgrade software within one version (minor version upgrade), for example from 5.0.0 to 5.1.0.
- Upgrade software version from an older version to the most current one (major version upgrade), for example 2.1.0 to 3.0.0.
- Upgrade software edition, for example NiceLabel Pro to a more advanced edition like NiceLabel Suite.

Install Minor Version Upgrade
In a software minor version upgrade, you upgrade an older minor version, for example 3.0.0, to the latest version of 3.x.x. Before you upgrade your labeling software, make sure you

- Backup your label files.
- Do not remove the existing version from your desktop PC.
- Check which software edition you have.

**Note:**
To check your software edition, look at the label on your CD case or start the software and select Help -> About.

To upgrade your **stand-alone/ single user software** (minor version upgrade), do the following:

1. Close the labeling software on your desktop PC.
2. Disable your Virus Scan software.
3. Install the new minor version in the same folder where the old version is currently installed. The new version will replace the old one.
4. Follow the prompts.

Install Major Version Upgrade
In a labeling software major version upgrade, you upgrade an older version, for example 2.x.x, to the latest version of 3.x.x. Before you upgrade the labeling software, make sure you

- Backup your program files.
- Do not remove the existing version from your desktop PC.
- Check which edition you have.

**Note:**
To check your software edition, look at the label on your CD case or start the software and select Help -> About.

To upgrade your **stand-alone/ single user software** (major version upgrade), do the following:
1. Close the labeling software and any other software on your desktop PC.
2. Disable your Virus Scan software.
3. Put the product CD in your CD-ROM drive.
4. Install the same software edition as you already have; for example, if you have NiceLabel Pro 2.1.x and want to upgrade to NiceLabel Pro 3.x.x, install NiceLabel Pro 3.x.x.
5. Follow the prompts.

**Install Edition Upgrade**

When you perform an edition upgrade, you want to upgrade to a more powerful software edition; for example upgrade from NiceLabel Express to (Undefined variable: Variables.Edition Pro) or NiceLabel Pro to NiceLabel Suite. Before you upgrade your labeling software, make sure you

- Backup your program files.
- Close the labeling software and any other software on your desktop PC.
- Do not remove the existing labeling software edition.

To upgrade your **stand-alone/ single user software** edition, do the following:

1. Put the product CD in your CD-ROM drive.
2. Install the new edition (Pro or Suite) on your computer. Follow the same instructions as for first-time installation. Refer to the chapter **Installing the Labeling Software**.
3. Follow the prompts.

**Note:**

Activate the new edition of the labeling software when you have received the activation document from your vendor with the upgrade package. You won’t be able to use the new edition until you have activated it.

---

**Installing Network Upgrades**

**Overview**

You can upgrade the Network edition in the following ways:

- Upgrade software within one version (minor version upgrade), for example from **3.0.0** to **3.1.0**.
- Upgrade software version from an older version to the most current one (major version upgrade), for example **2.1.0** to **3.0.0**.
- Upgrade software from stand-alone edition (single user license) to a Network edition with five or more concurrent users.

**Install Minor Version Network Upgrade**

In a minor version network upgrade, you upgrade an older minor version network, for example **3.0.0**, to the latest version of **3.x.x**. Before you upgrade your labeling software, make sure you
Backup your program files.
Do not remove the existing version from your server and workstations.

**Note:**
To check your current software version, look at the label on your CD case or open the software and select Help -> About.

To install a new minor version of the labeling software on the server and on the workstations, do the following:

1. Close the labeling software and any other running software on your server and workstations.
2. Disable your Virus Scan software.
3. Put the product CD in your CD-ROM drive on any computer with a labeling software client installed.

**Note:**
Make sure that all clients have logged off before you install the latest Network minor version upgrade.

4. Install the new version on the server computer. Follow the same instructions as for the first-time installation. Refer to the chapter [Install the Software on the Server](#).
5. Install the new version on all workstations. Follow the same instructions as for first-time installation. Refer to the chapter [Install the Software on the Workstation](#).

**Install Major Version Network Upgrade**

In a major version network upgrade, you upgrade an older network version, for example 2.x.x, to the latest version of 3.x.x. Before you upgrade the labeling software, make sure you

- Backup your program files.
- Leave the existing network version on your server and workstations.

**Note:**
To check your current software version, look at the label on your CD case or open labeling software and select Help -> About.

To upgrade your labeling software (major version upgrade), do the following:

1. Close labeling software and any other running software on your server and workstations.
2. Disable your Virus Scan software.

**Note:**
Make sure that all clients have logged off before you install the latest Network version.

3. Install the new version on the server computer. Follow the same instructions as for the first-time installation. Refer to the chapter [Install the Software on the Server](#).
4. Install the new version on all workstations. Follow the same instructions as for first-time installation. Refer to the chapter Install the Software on the Workstation.

Install Network Upgrade from Single User Edition

When you perform a network upgrade from a single user edition, for example, you want to upgrade from a stand-alone/single user edition to a Network edition. Before you upgrade your labeling software, make sure you

- Backup your program files.
- Remove the existing labeling software edition from your desktop computer.

To upgrade your labeling software edition, do the following:

1. Put the product CD in your CD-ROM drive.
2. Disable your Virus Scan software.
3. Install the new network edition on the server computer. Follow the same instructions as for the first-time installation. Refer to the chapter Install the Software on the Server.
4. Install the new network edition on all workstations. Follow the same instructions as for first-time installation. Refer to the chapter Install the Software on the Workstation.

Activating Upgrades

Activate Minor Version Upgrade

When you upgrade to a new minor version of the the same edition, for example NiceLabel Pro version 3.x.1 to NiceLabel Pro version 3.x.2, the software will remain activated. Just make sure you install the new version in the same folder as the existing version. Please follow the same instructions as described in the chapter Install the Minor Version Upgrade.

Note:
For the network edition make sure to install the server part in the same folder on the server that is currently used for the Network edition. You will not have to activate the server again. It will remain activated from the previously installed build.

Activate Major Version Upgrade

When you upgrade to a new major version of the same edition, for example NiceLabel Pro version 2.1.x to NiceLabel Pro version 3.x.x, you will have to activate the software again. The new version does not override the existing one and you can work with both the old and new version of the same edition. Please follow the same instructions as for the first-time installation of the labeling software in the chapter Installing the Software.

Summary of required steps:

1. Close running labeling applications.
Installation and Activation

2. Do not remove the existing version of labeling software.
3. Install the new version of the same edition you already have.
4. If your software (old version) has a hardware key (USB or Parallel, see chapter Activating the Software), plug the key in your computer.
5. Activate the new version with the upgrade key number.

Note:
To upgrade your software version 2.1.x to version 3.x.x, you need to have available both the old 25-digit serial number (for version 2.1.x) and the new 25-digit software key number (for version 3.x.x). Both keys are required to activate your software upgrade.

To activate the new version, do the following:

1. Open the newly installed labeling software. A Warning window will open.
2. Click on the Manage License button. The Manage License window will open.

Note:
If you activate the labeling software immediately after completing the installation, select Activate the package and click on Next.

3. Select Single User Software Key and click on Next. A new Manage License window will open showing the key license information of your old version of labeling software.

Note:
If your old software came with a USB or Parallel key, plug the key into an available port, select Hardware Key and click on Next.

4. If your software is protected by a software key, select Manage current software key license and click on Next.
   If your software is protected by a hardware key, select Manage current hardware key license and click on Next.
5. In the Manage License – Manage software key license window, select Upgrade key license and click on Next.
6. In the Manage License – Upgrade code window, enter the Upgrade Key Number you received from your vendor.
7. To activate the software automatically, click on the link Connect to the Activation server (recommended).
8. To activate the software manually, click on the provided Internet link for Web page activation. Your Internet browser will open the Upgrade Activation Web site.
   - Enter user information and click on ACTIVATE. A new window will open with the generated Activation Code.
   - Copy the Activation code from the Web site and paste it in the field Activation Code in the open Manage License – Activation code window of the open the software.
9. Click on the Next button and follow the prompts to complete the activation process.
Note:
You can still activate the software if the computer does not have access to the Internet. Please refer to the chapter Activate the Single User Edition.

Activate Edition Upgrade

When you upgrade to a new edition of the labeling software, for example from NiceLabel Express to NiceLabel Pro or NiceLabel Pro to NiceLabel Suite, you keep the existing software edition on your computer and install and activate the new software edition. Please follow the same instructions as for the first-time installation of the labeling software in the chapter Installing the Software. To activate the new edition of the labeling software, follow the activation instructions discussed in the chapter Activating the Major Version Upgrade.

Note:
To upgrade your software edition, you need to have available the old 25-digit serial number/software key and the new 25-digit software key number. Both keys are required to activate your upgrade.

Summary of required steps:

1. Close all labeling software applications.
2. Install the new edition of the software.
3. Activate the new edition with the upgrade key number.

Activate Network Major Version Upgrade

In a major version network upgrade, you upgrade an older network version, for example 2.x.x, to the latest version of 3.x.x. Summary of required steps:

1. Backup your program files.
2. Leave the existing network version on your server and workstations.

Note:
To check your current software version, look at the label on your CD case or open the software and select Help -> About.

3. Install the new version on the server computer. Follow the same instructions as for the first-time installation. Refer to the chapter Install the Software on the Server.
4. Install the new version on all workstations. Follow the same instructions as for first-time installation. Refer to the chapter Install the Software on the Workstation.
5. Activate the new software version with the upgrade key number.

Note:
To upgrade your Network version 2.1.x to the Network version 3.x.x, you need to have available both the old 25-digit serial number (for version 2.1.x) and the new 25-digit software key number (for version 3.x.x). Both keys are required to activate your software upgrade.

To activate the new Network version, do the following:
1. Start the newly installed software on your server or any client computer. A Warning window will open.

2. Click on the Manage License button. The Manage License window will open.

**Note:**
If you activate the software immediately after completing the installation, select Activate the package and click on Next.

3. Select Network Software Key and click on Next. A new Manage License window will open showing the network installation location.

4. Enter the primary network location path that should be the same as the one entered at installation (see the chapter Install the Software on the Server) and click on Next.

**Note:**
Make sure you are using UNC syntax when referring to the network location. Use the syntax \server\share\file and not the syntax with the mapped drive like W:\share\file.

5. Enter the required customer information and the upgrade key number and click on Next.

6. To activate the software automatically, click on the link Connect to the Activation server (recommended).

7. To activate the software manually, click on the provided Internet link for Web page activation. Your Internet browser will open the the Upgrade Activation Web site.
   - Enter the key number and the registration number. Enter other user information, if prompted.
   - Click on the Activate button to retrieve the Activation code.
   - Copy the Activation code and paste it in the field Activation Code in the open Manage License – Enter Old Key Number window of the open software.

8. Click on the Next button and follow the prompts to complete the activation process.

**Note:**
You can still activate the labeling software if the computer does not have access to the Internet. Please refer to the chapter Activate the Network Edition.

### Activate Network Upgrade from Single User Edition

When you upgrade to a Network edition from a single user edition, you must remove the old stand-alone edition and install the new network edition on the server computer and on all workstations. Follow the same instructions as for the first-time installation. Refer to the chapters Install the Software on the Server and Install the Software on the Workstation.

To activate the new the Network edition, follow the activation instructions discussed in the chapters Activating the Network Edition and Activating Additional Network Clients.

Summary of required steps:
1. Backup your program files.
2. Remove the existing labeling software edition from your desktop computer.
3. Install the Network software on your server and on the workstations.

**Note:**
Make sure that all clients have logged off before you install the Network edition.

4. Activate the new Network edition (server and client activation) with the new network key number.

**Activate Network License Pack**

With a Network License Pack upgrade you can add user licenses to your current Network edition in increments of 5, 10, 20 or 50 concurrent users. To add additional network user licenses, you only have to activate your network edition with the Network License Pack software key you have received from your vendor.

To upgrade your Network edition with additional user licenses, do the following:

1. Open the labeling software on your server computer or any client that has installed the software.
2. Select **Help -> Manage License**. The *Manage License* window will open.
3. Select **Manage current software key license** and click on **Next**.
4. In the *Manage License – Manage Network License* window, select **Add network license** and click on **Next**.
5. In the *Manage License – License Pack Key Number* window, enter the **License Pack Key Number** you received from your vendor.
6. To activate the software automatically, click on the link **Connect to the Activation server** (recommended).
7. To activate the software manually, click on the provided Internet link for Web page activation. Your Internet browser will open the License Pack Activation Web site.
   - Enter user information and click on **ACTIVATE**. A new window will open with the generated Activation Code.
   - Copy the Activation code from the Web site and paste it in the field **Activation Code** in the open *Manage License – Manage Network License* window of the open software.
8. Click on the **Next** button and follow the prompts to complete the activation process.

**Note:**
You can still activate the software if the computer does not have access to the Internet. Please refer to the chapter [Activate the Network Edition](#).
Deactivating Software

When you use NiceLabel software activated with the Software Key, you can deactivate the software and easily move the license to other workstation. Deactivation works with the software key for single-user and multi-user (Network) software.

**Note:** The primary use of deactivation is move of the software to some other workstation. If you want to reinstall it, or make the upgrade on the same workstation, you do not have to perform the deactivation.

To deactivate the software, do the following:

1. Start NiceLabel Pro.
2. Select Help -> Manage License.
3. Select the option Manage current software key license and click on Next.
4. Select the option Deactivate Software and follow on-screen instructions.

**Note:** Make sure the computer can access the Internet. The license will be returned to the internet activation server.

Be careful when removing the Network Software Key license. When you deactivate the Network Software Key, you will deactivate the activation of the server. All users of the software will have their licenses revoked and software running in the demo mode.

Another possibility of software deactivation is to simply to uninstall the software. During the removal process you will be prompted to remove the license or not. You can select not to remove the license. In this case you will not have to activate the software, when you install it again on the same workstation.

Enterprise Print Manager

**Introduction to Enterprise Print Manager**

**Note:** The contents of this chapter applies to the product NiceLabel Print Center.

NiceLabel Print Center is a software package with two modules (NiceLabel Suite and Enterprise Print Manager).

On workstations, users are working with NiceLabel Pro application for label design. As a part of NiceLabel Pro, a service called Label Services is monitoring the local printing process.

Printer and job statuses are sent to the server, where the Enterprise Print Manager (EPM) component is centrally controlling the printing process of the labeling software. The EPM stores all reported client information is into its database (Microsoft SQL Server).

The EPM is a web based application. You can use a standard web browser to control it from your machine or from any other workstation in the network. You can view the
status of each labeling client, view its event and error logs, manage the print jobs and create alerts.

The EPM alerts you upon arrival of a predefined condition, such as an error, a warning, or simple confirmation of executed print job. Several notification options are available: email (through SNMP), Net Send message, RSS 2.0 Feed or SMS message sent to your mobile phone.

You can set up different access permissions to your users. By default full access rights are granted to all users. To change the permissions, refer to the labeling software user guide.

To access your EPM, do the following:
1. Open Internet Explorer.
2. Type in the address of your EPM:

   http://server/EPM/Home.aspx

**Note:** The *server* above stands for the name of the computer where you installed EPM.

For more information about how to work with EPM please refer to the EPM user guide.

**Label Services**

A service called Label Services (LblServices.EXE) is installed and started on each client after the program installation. Label Services also runs a sub-process NDH.EXE. Both services are monitoring the local printer and its print job statuses and can report the statuses back to the labeling application where the statuses are continuously updated in the log file.

Printer and job statuses are also sent to the NicePrintQueue. It contains accurate information about the printed jobs and printer statuses. You can use the NicePrintQueue to monitor the statuses in the real time.

**Note:** The Label Services must also run if you want to report the print job and printer statuses to the Enterprise Print Manager (EPM), where the central job log is updated.

If you stop the Label Service, the following functionality will not be available:

- Advanced Printing - feedback from windows print spooler about print job progress is not written to the log file.
- Communication between the client and EPM is not active (sending print job/event information from the client to the NiceLabel Print Center).
- NicePrintQueue cannot be used.

If any of the mentioned functionality is not available, the first thing to check is the status of the Label Services on the workstation.

To check the status of Label Services, do the following:
1. Open **Control Panel -> Administrative Tools**.
2. Double-click the **Services** icon.
   The list of all registered services of your Windows system will open.
3. To start the **Label Services** service, right-click on the Label Services service and select **Start** from the context menu. The service status will change to **Started**.

### Limitations of the Demo Mode

The demo mode is enabled when you do not activate the software. The labeling software running in the demo mode has limited functionality. The major limitations of the labeling software demo mode are.

<table>
<thead>
<tr>
<th>Product</th>
<th>Limitations</th>
</tr>
</thead>
<tbody>
<tr>
<td>NiceLabel Pro / NiceLabel Express</td>
<td>You can only print five (5) labels per print job.</td>
</tr>
<tr>
<td></td>
<td>You can only define one variable field on the label you want to export (to Pocket edition, to SAP, to printer's memory or using other export possibilities.)</td>
</tr>
<tr>
<td></td>
<td>You cannot copy the bar code to clipboard.</td>
</tr>
<tr>
<td></td>
<td>You cannot print the label to file.</td>
</tr>
<tr>
<td></td>
<td>If you continue running the labeling software in the demo mode, you will experience increasing delay at startup.</td>
</tr>
<tr>
<td>NiceForm</td>
<td>Three actions are executed on the button.</td>
</tr>
<tr>
<td>NiceWatch</td>
<td>Three actions are executed for the trigger</td>
</tr>
<tr>
<td>NiceMemMaster</td>
<td>Download to the printer is not enabled.</td>
</tr>
<tr>
<td>NiceData</td>
<td>Database tables with maximum twenty (20) records can be used.</td>
</tr>
<tr>
<td>Pocket NiceLabel (if available)</td>
<td>You can print only one (1) variable field per label.</td>
</tr>
</tbody>
</table>

You should use the DEMO version only to evaluate the software. Any commercial use of the DEMO software is prohibited. To obtain the full working version of the labeling software, you have to purchase and activate the software.

**Note:** Not all listed products are available in all product editions.

The software can also run in the DEMO mode, when you:

- Run the software over the Remote Desktop connection, and do not use the Network edition (You can use the Remote Desktop connection when connecting to Windows XP, or when connecting to the console on Windows 2003/2008/Vista)
Installation and Activation

- Use the incorrect software/hardware key (for you try to activate NiceLabel Pro with the license for NiceLabel Express)
- Do not have the proper device driver for hardware key installed (if you use hardware key activation type)

Registering the Software

At the end of the activation process, please fill out the registration form in the last step of the Product Activation process. If you have the access to the internet, the product can be activated on-line. You can also print out the registration form and send or fax it to the contact on the form.

Registration is not required but you should register the labeling software to receive the following benefits:

- Free access to downloads and updates.
- Free Technical Newsletter discussing product news.

To register the labeling software, do the following:

1. Start the label designer.
2. Select Help -> Manage Registration.
3. Follow on-screen instructions.

Using License Manager

The program License Manager is used to monitor and manage network and enterprise licenses. License Manager displays the information of the current client and also provides an overview of the total license occupation.

You can also use it to enable/disable off-line mode for workstations. Off-line mode enables selected workstations to function in spite of the fact that the computer with licenses is not available or not accessible. It is used in environments where mobile label printing is required or in events where server system failure would otherwise stop the label production.

**Force Off-line Mode:** The client will not check for the presence of the network server. The client will automatically start in the off-line mode. When the license lease expires it will stop running and you must renew the license by switching off this option and re-connecting to the network server.

**Note:**
The off-line license expires after 14 days.

**Application Settings Location:** The software stores the setting in the System folder. By default, the System folder is available on the network server and is shared among all network clients. But you can also store the settings on the local workstation where they are accessible to your client only.
The table at the bottom of the dialog box displays the occupation of the licenses.
Setting up the Software

User Interface

Basic and Advanced User Interface

The labeling software has two-level user interface. By default, basic user interface is enabled that makes the software easier to use for beginners and inexperienced users.

Software in basic mode:
- Hides the advanced tabs in dialog boxes.
- Enables all wizards for frequent tasks in label design.
- Hides the advanced Toolbars.
- Shows large icons.

To switch between basic and advanced modes, do the following:

1. Click on the User Interface command in the Tools menu.
2. Click on the command Set Basic Mode to enable basic mode or click on the command Set Advanced Mode to enable advanced mode.

Note:
You can also enable only some properties of the basic/advanced mode. Look at the other User Interface options in the Tools menu.

Shortcuts

You can quickly accomplish tasks you perform frequently by using shortcut keys - one or more keys you press on the keyboard to complete a task. Note that this is just a faster and more convenient way of choosing commands. Command itself is executed just as if it was selected from the menu or toolbar.

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>Deletes selected element</td>
</tr>
<tr>
<td>Shift + Delete</td>
<td>Cut</td>
</tr>
<tr>
<td>Ctrl + Insert</td>
<td>Copy</td>
</tr>
<tr>
<td>Shift + Insert</td>
<td>Paste</td>
</tr>
<tr>
<td>Alt + Backspace</td>
<td>Undo</td>
</tr>
<tr>
<td>+ (numeric pad)</td>
<td>Zoom In</td>
</tr>
<tr>
<td>- (numeric pad)</td>
<td>Zoom Out</td>
</tr>
<tr>
<td>Alt + Shift + Backspace</td>
<td>Redo</td>
</tr>
<tr>
<td>Ctrl + 1</td>
<td>Open the label design for the next template within current label file. Only applicable if you use the header/main/tail or front/back labels.</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Ctrl + Shift + 1</td>
<td>Open the label design for the previous template within current label file. Only applicable if you use the header/main/tail or front/back labels.</td>
</tr>
<tr>
<td>Ctrl + Shift + N</td>
<td>Creates a new label with default settings, bypassing wizards.</td>
</tr>
<tr>
<td>Ctrl + T</td>
<td>Rotate 90° counter-clockwise</td>
</tr>
<tr>
<td>Ctrl + A</td>
<td>Align</td>
</tr>
<tr>
<td>Ctrl + X</td>
<td>Cut</td>
</tr>
<tr>
<td>Ctrl + C</td>
<td>Copy</td>
</tr>
<tr>
<td>Ctrl + V</td>
<td>Paste</td>
</tr>
<tr>
<td>Ctrl + Z</td>
<td>Undo</td>
</tr>
<tr>
<td>Ctrl + Y</td>
<td>Redo</td>
</tr>
<tr>
<td>Ctrl + N</td>
<td>New</td>
</tr>
<tr>
<td>Ctrl + O</td>
<td>Open</td>
</tr>
<tr>
<td>Ctrl + S</td>
<td>Save</td>
</tr>
<tr>
<td>Ctrl + P</td>
<td>Print</td>
</tr>
<tr>
<td>Ctrl + R</td>
<td>Print Preview</td>
</tr>
<tr>
<td>Ctrl + G</td>
<td>Snap to grid</td>
</tr>
<tr>
<td>Ctrl + H</td>
<td>Display guidelines</td>
</tr>
<tr>
<td>Alt + F4</td>
<td>Exit</td>
</tr>
<tr>
<td>Ctrl + move object with mouse</td>
<td>Parallel moving of the object by main axes only.</td>
</tr>
<tr>
<td>Alt + move object with mouse</td>
<td>Object snaps to grid even if it is off.</td>
</tr>
<tr>
<td>Shift + move object with mouse</td>
<td>Toggles object snapping to guidelines (if they are displayed).</td>
</tr>
<tr>
<td>Ctrl + move object with cursor keys</td>
<td>Fine tuning the position of the object.</td>
</tr>
<tr>
<td>Shift + cursor keys</td>
<td>Fine tuning the dimensions of the object, resize width</td>
</tr>
</tbody>
</table>
and height in very small steps.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click Text icon in ToolBox, then press Ctrl + click on the label</td>
<td>Dialog box for Text pops up.</td>
</tr>
<tr>
<td>Click Graphics icon in ToolBox, then press Ctrl + click on the label</td>
<td>Dialog box for Graphics pops up.</td>
</tr>
<tr>
<td>Select variable from the list in toolbar, click Text icon in ToolBox, then click on the label</td>
<td>Variable Quantity is automatically connected with text object and placed on the label.</td>
</tr>
<tr>
<td>Select variable from the list in toolbar, click Graphics icon in ToolBox, then click on the label</td>
<td>Variable Picture is automatically connected with graphics object and placed on the label. This is a great shortcut for using variable graphics, where filenames for pictures are received from database.</td>
</tr>
<tr>
<td>Right-clicking the object</td>
<td>Opens pop-up menu with shortcuts to commands. The content of the pop-up menu greatly depends on where you clicked your mouse button and what was selected at that time.</td>
</tr>
<tr>
<td>Enter (or F2)</td>
<td>Dialog box with element's properties will open.</td>
</tr>
<tr>
<td>F2</td>
<td>On-screen edit is enabled for text elements.</td>
</tr>
<tr>
<td>Space + left-click and dragging</td>
<td>Freely move the label within the working window. If you want to change the view on the label, you do not need to separately scroll the label in up/down and left/right direction, but just grab it and move it to proper position.</td>
</tr>
</tbody>
</table>
Main Window

The main window has many parts and functions. You can click specific parts of the screen-shot image to see the description.

Mouse Wheel support

If you have mouse, that has a wheel in place of the middle button, you can use it to speed-up zooming and scrolling a lot:

- Turning the wheel, scrolls the label up or down.
- Holding <SHIFT> and turning the wheel scrolls the label left or right.
- Holding <CTRL> and turning the wheel, zooms the label in or out.

Using the Keyboard and Mouse Effectively

When selecting objects you can use <CTRL> key to adjust object's anchoring point by clicking the object placeholders.

If you have a Wheel Mouse, you can use the wheel to scroll label up and down. Holding <CTRL> when rotating the wheel adjusts zoom factor, <SHIFT> scrolls label left or right.
Double click the form name in the status bar starts NiceForm and opens form that is attached to the label.

Double click on printer's name in status bar opens printer properties dialog box in which you can set various options regarding currently selected printer. If you hold <CTRL> while double clicking, printer setup dialog box is opened, in which you can select different printer.

You can quickly move objects from one open label to another by simply dragging desired object to another window while holding <ALT>. If you want to copy objects instead, hold both <ALT> and <CTRL>. Note that you must have both label windows visible to do that.

Different objects on label can be selected using the <TAB> and <SHIFT>+<TAB> keys.

Pressing cursor keys while holding <Ctrl> key can move currently selected object. This can be used to fine-tune position of the object. Holding <SHIFT> while pressing cursor keys will resize the object.

You can use the right mouse button almost anywhere on label to access most common options for that area/object. For example, if you click an object with right mouse button, a pop-up menu is displayed that contains options and actions that can be performed on selected object. Similarly clicking the other parts of label produces pop-up menu with options for that part of label.

Multiple objects can be selected by holding <SHIFT> while clicking them.

Use the element shortcuts in toolbars whenever possible. Each label element that can be connected to some Contents Provider, has a shortcut enabled to quickly access existing variables or define new ones. Click the element's shortcut handle for this shortcut. It is shown as a small arrow by the side of toolbar button:

- In the Toolbox: [Text], [Text Box], [Rich Text Box], [Barcode], and [Picture].

- In the Variable toolbar: [Variable].

---

**Label Security**

**Tracking Label Design and Printing**

**Enable Revision History Comment**

To enable the revision history functionality, do the following:

1. Select **Options** from Tools menu.
2. Go to **Settings** tab.
3. Tick the option Enable revision history logging.
Note:
If you want to be able to write a custom comment for each revision, also enable the option Prompt for revision history comment.

4. Click on the OK button.

Each time the label is saved, a revision note is saved with the label.

To review the revision history data, do the following:

1. Open your label file.
2. Select Properties from File menu.
3. Click on the Advanced button in the bottom of the dialog box to show the Revision History tab.
4. Go to the Revision History tab.
5. Review revision history data.
6. Click on the OK button to close the dialog box.

Use History Log to Track Label Printing

The labeling software has the ability to log all information about printing action in the database for later review and reports. By default the logging is disabled. To be able to track label printing, do the following:

1. Select the option Configure Log File in the Tools menu.
2. Select the option Enable logging.
3. Click on the OK button.

To view at the log of printed labels, do the following:

1. Select the option View Log File in the Tools menu. The table with the printing actions is displayed.
2. Browse the table, sort the records, filter the records (in the Advanced mode) and generate report file.

Login

The labeling software supports different access permissions to various parts of the applications. Your administrator might have set up different access profiles so you must log in to validate your credentials. Your username and password defines your permissions.

In order to use the labeling software the proper user name and password must be entered. Different users have different privileges for usage of the program. For example, the access can be granted on print only, design only, view only level, or full administrative access level.

The purpose of log in is the ability to distribute different tasks among different users and mainly, to have ability to protect the data from unauthorized access. Usually the group of label designers consists out of different people than the group of label print operators. The print operators should not have the access to label design.
Define User Passwords and Permissions

If you want to define access permissions for the users working with the labeling software, you can enable user management feature in the software. If your computer is part of a domain, you can define permissions for domain users. If you do not use domain, you must define the application users.

To enable user management and assign the permissions, do the following:

1. Start NiceLabel Pro.
2. Select Tools -> Options.
3. Click on User Rights and Access in the left pane.
4. Click on User configuration... button.

Dialog box for defining users and their permissions in the software

2. Select the Configure Users option in the left pane.
3. Click on the option Set authentication mode in the right pane. The Authentication Mode dialog box will open.
4. Select the option Mixed (Windows and Application authentication). Click on the OK button.

If you do not have or do not want to use domain users, define new user by doing the following:

1. Make sure you are still in the Configure Users dialog box.
2. Click on the button Add user in the main toolbar. For the username enter the name you want to use for your user (like 'User'), then define a password for the user.
3. Click on the OK button.

Set up the profile and define user permissions by doing the following:
1. Make sure you are still in the **Configure Users** dialog box.
2. Click on the **Add Profile** button in the main toolbar.
3. Open the General tab and define the name of the profile, for example **My profile**.
4. Go to **Permissions** tab.
   Here you will define the access permissions to all applications that will be contained in this profile.
5. Expand the NiceLabel selection, then tick the options **Label design**, **Label print** and **Label view**. The members of this profile will be able to use the label design application in full mode. They will be able to open the label, view it, design it and also print it.

![Add Profile dialog box](image)

**Definition of the permission granted by the profile**

6. Go to **Members** tab and add the user to the profile. Select the user you have created in previous steps.
Add the user 'NiceLabel User' to the profile 'My Profile'

7. Close the applications.
8. Start NiceLabel Pro, log on with the new user and see how the access permissions are applied to him.

**Lock Label**

Sometimes you do not want all users be able to open and work with your label. The access to the label can be limited on different levels. Here are some quick ideas for protecting the label:

- Use the option to lock the label in the label designer.
- Set up user management in the labeling software and allow access to label design only to certain users.
- Employ file system access permissions on the folder that stores your labels.

The easiest option seems to be to lock the label inside the label designer.

To lock the label, do the following:

1. Open the label in the label designer.
2. Select **File -> Properties**.
3. Go to **Advanced** tab.

**Note:** If you do not see the Advanced tab, click on the button **Advanced>>**.

4. Enable the option **Label locked**.
5. Optionally you can password-protect the label. Enable the option **Password protection**, then click on the button **Set password**.
Note: Make sure you remember the label password. Without a password you will not be able to open the label. If you lose the password contact the technical support.

System Folder

The labeling application uses its system folder for storing files needed to run the program. The location of the folder varies depending on the Windows operating system used.

The location of the System folder is C:\Documents and Settings\All Users\Application Data\EuroPlus\NiceLabel 5\system.

It is vitally important to own the write access to this folder on your computer system and the right to write to and modify files in this folder.

Note:
The Network clients use the System folder on the network server. If you have Network edition all clients must have the full access also to the System folder on the server.

The software stores important system settings in the System folder, as follows:

- User data and user rights
- Various application settings
- Label printing logs
- Bar code standards
- Definition of global variables (GLOBALS.TDB)
Designing Labels

Designing a Basic Label

Overview

In this section you will learn how to design a simple label file with fixed and variable objects. The variable objects can obtain values from several sources. You will learn how to:

- Provide object values with a keyboard prompt.
- Obtain object values from a database.
- Preview the label on the screen.
- Print the label.

The label you create will look like this:

![Basic label]

Create a Basic Label

Create a New Label

To create a basic label, do the following:

1. Open the labeling software.
2. Select New label under File menu or click on the icon in the standard toolbar.

Each time you create a new label, a Label Setup Wizard will start to help you setup the label and connect to the printer.

Note:

You can leave the Wizard at any time and accept the default settings for the label by clicking on the Finish button.
Select a Printer

1. Select the printer you want to use for label printing.

**Note:**
If you don’t find your printer on the list, refer to chapter Install Printer Driver for installation instructions.

Selecting a printer

2. Click on the Next button.

Define Label and Page Dimensions

1. If you want to use the label stock, select your choices in the window Select Stock.
2. Click on the Next button. A new window will open to define the label dimensions manually.
3. Leave the option Page Size on 'User defined' default and check Automatic Sizing.
4. Click the Next button. A new window will open.
5. Select label orientation and print direction.
Selecting label layout

6. Click on the **Next** button. A new window will open. Enter 10 for label width and 7 for label height.

**Note:**
Dialog box differs from thermal and office printers.
Defining label dimensions

**Note:**
To change the unit of measure from centimeters to inches or other supported units, click on the button with unit of measure below the label preview in the dialog box.

1. Click on the **Finish** button. New empty label will open.

**Enter Non-Changing Text**

1. Click on the **Text** button in the Toolbox. The text cursor appears on the screen.

   ![Cursor for text object]

2. Move the cursor to the location on the label where you want to place the text object and click on the mouse button. The dialog box with object properties will open.
3. Enter the text "SAMPLE" and click on the Finish button.

![Text Wizard dialog box with text object settings]

**Entering content for text object**

4. Click on the text object to select the object.
5. Change the font for the text object using the Text toolbar. Choose Arial font, 28 point size and bold style.

![Arial font selection in Text toolbar]

**Using format options in the text toolbox**

6. To change the position and size of the text object, select the text object and drag object with your mouse to the position where you want to have it.

The screen should show the following:
The text object is placed on the label

**Insert Bar Codes**

Now you will add a non-changeable Code128 bar code on the label.

1. To insert the bar code, click on the button in the Toolbox.
2. Move the cursor to the desired position on the label and click on the mouse button.
3. The dialog box with object properties will open.
4. Enter the value 1234567890 for the bar code contents.
5. Click on the Define button.
6. Make sure you select bar code Code128 and click on the OK button.

![Edit Bar Code dialog box](image)

Selecting bar code type
7. Click on the Finish button to return to the label.
8. Change the position of the bar code by selecting the bar code and dragging it to the desired position.
9. Change the object size by dragging the object handles. The handles are small rectangles surrounding the object when it is selected.

The label should now show the following:

![Label with text and bar code objects](image1)

**Insert Pictures**

The labeling software works with BMP, PCX, GIF, WMF, JPEG and many other popular graphic formats.

1. To insert the picture, click on the button in the Toolbox.
2. Move the cursor to the desired position on the label and click on the mouse button.
3. The Open dialog box will open allowing you to browse for your picture on your hard drive. Go to the folder Sample Graphics and select the picture LEISURE.WMF. Click on the Open button.

The screen should show the following:

![Label with text, bar code and picture objects](image2)
Save a Label

Always save your label during the design process. To save a label, do the following:

1. Select the icon.
2. Type in the name of the label. For example, enter 'label' for the name of the label.
3. The name of the label is visible in the program caption.

Use Alignment Tools

You have placed the objects on the label. Now you want to make sure they are aligned on the horizontal center of the label. You can align objects on the label by using the Align toolbar on the right side of the working window.

To align objects on the label, do the following:

1. Select all objects on the label.

   **Note:**
   The first object you select determines the alignment orientation for all selected objects.

2. Choose a select arrow in the Toolbox and draw a frame around all objects to select all objects.

3. In the Align toolbar on the right, click on the icon to arrange the objects. The selected objects will be rearranged and positioned on the horizontal center on the label.

   **Note:**
   There are also other alignment commands available in the Align Toolbar.
Note:
You can also align the objects to the label grid or the Guidelines. Both Grid and Guideline options are available in the View menu.

**Object Positioning Guidelines**

Guidelines are available to assist you in positioning objects on the label. The functionality of guidelines is similar to grid, but they allow you much more freedom regarding positioning, moving, and combining positioning delimiters.

Although the guidelines may be visible while designing the label, they will not be printed on the final product, regardless of whether the "Display Guidelines" setting is turned on or off.

**Create Guidelines**

Create vertical and horizontal guidelines:

- Click anywhere in the ruler area and drag the line out of it (the top ruler contains horizontal, and the side ruler contains vertical guidelines).
- Alternatively, you may right-click on the label and select to add a guideline to that position from the Guidelines menu.
- Finally, you can open the View menu and access the commands there.

**Using Guidelines**

The guidelines are moved at any time with the drag of a mouse. If they are drug back to the ruler area, they are deleted. It is possible to toggle between displaying and hiding the guidelines, either by using the menu or right clicking them.

The guidelines can be hidden with the `Ctrl+H` shortcut key combination, and when they are hidden, the Snap to Guideline functionality is also disabled. The menu also includes a **Delete all Guidelines** command, which removes all the guidelines on the label.

Holding down the SHIFT key while dragging objects allows you to temporarily turn on the Snap to Guidelines function.

**Guideline Properties**

Double-click a guideline or right click a guideline and choose **Edit Guideline Properties** to open the Guideline Properties dialog window. The dialog allows you to enter the numeric positioning value, choose the horizontal or vertical guideline type, or remove the individual guideline.

**Use Drawing Tools**

Now you will insert a line to separate a text object from other objects and a rectangle around the picture object.
1. Select the Line icon from Toolbox and move the cursor to the required starting point of the line.

2. Press and hold down the mouse button while drawing the line. Move the mouse to the end position of the line and release the button. The Line object is placed on the label.

3. Click on the Rectangle icon in the Toolbox and point the mouse to the upper left corner of the picture.

4. Click and hold the mouse button while you stretch the rectangle to the lower right corner of the picture.

5. To change the thickness of the vertical and horizontal line, double-click on the rectangle object to open its properties. Select the thickness you want and click on the Finish button.

6. To edit the drawing object, double-click on the line or rectangle to open the dialog box with its properties.

The label should show the following:

![Label with fixed objects](image)

**Add Variable Fields**

**Overview**

You may want to print the label on which the data changes for each label. The labeling software offers different variable fields (counters, date/time fields, operator's input from the keyboard) that you can use with text, graphics and bar code objects.

For this example a new label was created. The following steps explain how to create a label that contains a prompted field, a counter and date/time fields. The captions in the following screenshots were added separately.
The left label shows design mode, the right two labels are two consecutive labels from print preview

Create Keyboard Entry Variable Fields

The content of a prompted field can be different for every print job. Before you print the label, you enter the value for the field.

1. Click on the small arrow next to the Text icon in the Toolbox to display a list of available variable types.
2. Select New Keyboard Input from the list and click on the label where you want to position the object.
   A dialog box with the Variable Wizard will open.

Creating new keyboard input variable field

3. Type 'Enter product name' for the option Display this text to the print operator.
4. Click on the Finish button. The cursor changes its shape to an arrow with a text object.
5. Click on the label where you want to position the prompted field.

The text object is placed on the label and linked to the new variable.

Note:
When you print the label, you will be prompted to enter the product name, which will be shown in preview on the label and on the printed label.
Create Serialized Data Variable Fields (Counters)

Now create a counter field on the label. The value of that variable field will automatically increase by one on every label.

1. Click on the small arrow next to the icon in the Toolbox to display a list of available variable types.
2. Select **New Counter** from the list.
3. A dialog box with counter properties opens.

   ![Toolbox](image)

Creating new counter variable field

4. Leave everything as default so that the counter will always start from 1 and increase by one on each label.
5. Click on the Finish button.
6. Click on the label where the counter should be placed.

The new variable is linked to the text object on the label.

**Note:**
Typically, the counter will increase by 1 on each label. For example, 1, 2, 3, 4, 5, etc. You can also define different incremental steps.

Create Date and Time Variable Fields

Content of the variable field can be filled automatically with the date or time stamp from the computer clock or printer clock (for supported printer models).

1. Click on the small arrow next to the icon in the Toolbox to display a list of available variable types.
2. Select **New Date Field** from the list. A dialog box with date properties opens.

   ![Toolbox](image)

Creating new date variable field
3. Leave everything as default and the date will be used on the label using the format as defined in your Windows operating system.

To place a time stamp on the label, do the following:

1. Click on the small arrow next to the icon in the Toolbox to display a list of available variable types.
2. Select New Time Field from the list.
3. Click on the Finish button.
4. Click on the label where the counter should be placed.
   The new variable is linked to the text object on the label.

The date and time fields are updated when you preview or print the label. In this example the values will come from the system clock of your computer.

**Use Prefix or Suffix Options**

You can add a prefix and suffix to each variable field on the label. Both are added to the value when you preview and print the label.

1. Click on the small arrow next to the icon in the Toolbox to display a list of available variable types.
2. Select New Keyboard Input from the list.
3. A dialog box with variable properties will open.
4. Type the text 'Enter product weight' for the option Display this text to the print operator. Set the allowable characters to digits and click on the Next button.
5. Enter ' kg' for the Suffix option.

Defining the variable suffix

6. Click on the Finish button.
7. Click on the label where you want to position the prompted field.
   The text object is placed on the label and linked to the new variable. When you will preview or print the label, the suffix ' kg' will be appended to the entered value on the right side.

---

**Using Advanced Functionality**

**Creating a Label with GS1-128 (EAN.UCC 128) Compliance**

**Add Content to GS1-128 Using GS1-128 (EAN.UCC 128) Wizard**

Use the GS1-128 (EAN.UCC 128) Wizard to help you add the necessary Application Identifiers (AI) in the bar code. Complete the following steps with the wizard:
1. Select **10 Batch or Lot number**.

Selecting Application Identifier from the list

2. Click on the **Next** button.
3. Select **Fixed** and click on the **Next** button.
4. Enter the sample data, for example '12345'.
5. Click on the **Next** button. A dialog box showing all AI contained in this bar code will open.
6. Click on the **Add** button to start adding a new AI. For example, select AI 21 (Serial Number). Repeat steps from 1 to 5 above.
Two Application Identifiers are defined

7. When you are satisfied with the designed AI and their positions within the bar code, click on the Finish button.

The GS1-128 (EAN.UCC 128) bar code is placed on the label.

**Edit Bar Code GS1-128 (EAN.UCC 128)**

The designed label with GS1-128 (EAN.UCC 128) bar code

To define the GS1-128 (EAN.UCC 128) bar code, you first select this bar code type and assign a value to it.

1. Click on the small arrow button next to the Bar Code button in the Toolbox.
2. Select Fixed Bar Code in the context menu.
Creating a fixed bar code

3. Move the cursor to the location on the label where you want to place the bar code object and click on the mouse button.
4. The wizard with object properties will open.
5. Click on the button Define. The dialog box Edit Bar Code will open.
6. Expand the group EAN.UPC and select the bar code GS1-128 (EAN.UCC 128).
7. Click on the OK button to go back to the Bar Code dialog box.
8. Click on the Next button.
   The GS1-128 (EAN.UCC 128) Wizard will open.

**Using EPSC**

**Using the EPSC Function**

The EPSC (Electronic Product Supervision Code) is a monitoring system, set up by the General Administration of Quality Supervision, Inspection and Quarantine of the People's Republic of China. Its intent and purpose is to improve product quality and safety, as well as simplify product tracking throughout the production cycle.

EPSC Standards compliance requirements:

- Bar code type: GS1-128 (MULTI) AI=21
- Bar code structure: AI+20 supervision code
- Minimum barcode module width ≥ 7 mm (recommended minimum is 10 mm, full barcode width in this case is 42.5 mm)
- Minimum barcode height ≥ 8 mm
- Bar code quality: Above C (1.5/10/670)
- Blank area on sides = 10* minimum module width

Setting up an EPSC Variable

An EPSC code is based on a function, which draws its data from a variable. Therefore, the variable must be created first.

Use the New Variable toolbar button to create a new variable. Name it and set the following settings:

- Source = Global
- Maximum Length = 20
- Data format = Numerical
Designing Labels

- Incremental counter
- Increment by = 1
- Initial value ≥ 1

Only if the above criteria are fulfilled, will the bar code variable provide for valid EPSC codes.

Setting up the EPSC Function

Use the Function toolbar button to add a new function. Name it and select Electronic Product Selection Code in the type list. If the variable described above was correctly set up, you will be able to select it as the Global Variable in the Detailed tab. Only valid variable types are displayed, and if your variable is not available, there was an error in the variable setup.

Click the Import button and browse to the .txt file which includes the EPSC codes you have been issued. Import the file, and your list of available codes will be populated. You can preview the list by clicking on the View button.
The imported data is bound to the global variable, therefore data imported for one variable will not be available in another. Likewise, if the label is exported, the data from the global variable will not be transferred and will remain available only locally.

Insert a GS1-128 bar code onto the label and connect it with the EPSC information. Once the labels are printed, they are marked as printed in the log, along with the timestamp of their printing. It is not possible to print a code that is already marked as printed, nor is it possible to import the same list of codes twice.

**NOTE:** It is possible to delete the log of printed codes, making it possible to perform import and printing these codes a second time. Be cautious when deleting printed codes from the log, or you may lose track of past printing activities.

### Designing Label with Variable Length

In most label-printing scenarios you design and print the label with fixed dimensions. The label width and height do not change so you must make sure to fit all objects on the label.

However, in some cases you need the ability to design the label with the variable length. The label length changes in accordance to the size of the label objects. When you assign more data to the label objects, their size increases and occupies more space on the label. In order to fit such objects on the label, the label height must change.

**Note:** The requirement for variable label sizing is quite often in the textile industry, where labels print to endless label material. There are no gaps between the labels. The printer cutter cuts the material after the label prints.

To enable the variable label sizing, do the following:

1. Select **File -> Label Setup**.
2. Go to the **Dimensions** tab.
3. Click the **Advanced** button.
4. Enable the option **Enable variable label size**.
5. Make sure to set the offset to the proper value. The offset defines the amount of space between the last object on the label and the bottom label edge.

See the screenshots below to understand the automatic label resize function.

The variable label size is enabled on the label. There is always 1 cm gap from the bottom label border and the last object on the label, bar code in this case. The text object is a multi-line object. If you enter more data for the text object, the label height must increase to accommodate for the larger text object.

Variable label sizing feature increases the label height on demand

To take full advantage of the variable label sizing, you must enable the object relative positioning. In this case the objects will not always be placed on the same spot on the label. Their placement will change accordingly to the placement of parent objects.

**Note:** When you enable the variable label sizing, you cannot use the "labels across" option at the same time. However, multiband printing is available.

**Controlling Cutter in the Printer**

If you have a thermal printer equipped with the cutter, you can control the cutter action from the labeling software. You must use NiceDriver for your thermal printer if you want to control the installed cutter. To set up the cutter control, do the following:

1. Select the option Label Setup in the File menu.
2. Go to the Cutter Settings tab.
3. Select the option Enable cutter.
Enabling cutter functionality

**Note:**
NiceLabel Express edition can control the cutter. However, you cannot use the Label Setup dialog box. Instead you must define the cutter parameters in the properties of the NiceDriver printer driver. Please refer to the NiceLabel Express user guide for instructions how to set up cutter.

**Defining Label Batch Printing and Using Header and Tail Labels**

Label batch refers to a group of labels that have some property in common. The purpose of identifying label batch is to execute the actions and to enclose each label batch with header and tail label. The header and tail labels are printed in front of the first label in the batch (header label) and after the last label in the batch (tail label). They can be used as page separators and can include additional information for the label operators. To enable label batch printing, do the following:

1. Select the option Label Setup in the File menu. The Label Setup Wizard will open.
2. Select the option **Open the advanced options dialog box** and click on the button **Finish**. The main Label Setup dialog box will open.
3. Go to the tab Batch Printing.
4. Click on the button **Advanced** in the bottom part of the dialog box. The Advanced tab will open.
5. Look at the Label Batch Definition sections. If your label batch will contain 5 labels, enable the option Fixed number of labels and type 5 in the combo box in the right.

Setting up label batch

6. To enclose the main labels with header and/or tail labels, tick the option **Use header label** and/or **Use tail label**.

Header and tail label are stored in the same label file, but you can still design them as separate labels. Access to header and tail label from the View menu where you can enable and disable view on these labels.

**Designing Double-Sided Label**

The labeling software supports double side printing for office printers (inkjet, laser...) and for thermal printers. The option is enabled in the Label Setup dialog box, **Printer** tab. Look at the option **Double-sided printing**.

**Note:**
The option is available only, when the used printer driver supports double-sided printing.
As soon as you enable this option, the option Label Side in the View menu becomes available. Use it to switch between front and back sides of the label. The identification of the current page is also visible in the status line at the bottom of the window.

When printing to office printer, these two pages are always printed one after another. They are sent to the printer one after another so make sure you enable duplex functionality in the printer driver.

When printing to thermal printer, printer driver NiceDriver will take care of proper label processing and printing. You need to use the appropriate NiceDriver to enable double-sided functionality.

**Designing Labels for Mobile Devices**

The labeling software has support for mobile label printing from Windows Mobile devices. You can design the label with the desktop labeling software and then export it to the Mobile device.

The pocket edition of labeling software is not as powerful as desktop edition and does not support some features that are available in the desktop edition. You must be careful when designing the label for Mobile device. If you select some unsupported feature, the label export is not possible.

Some examples of unsupported features:

- Majority of complex functions are not supported (Visual Basic scripting, User defined check digit algorithms, HIBC, Lookup table, Link to file, etc.), but some are (Concatenate).
- Global variables are not supported.
- Variable graphics are not supported.
- Databases are not supported (but databases are supported on the form created in NiceForm).
- Variable text objects formatted in Truetype fonts are not supported (you can use variable Truetype fonts if you download them to the memory card in the printer)
- Advanced variable features are not available (prefix/suffix, advanced serialization, remembering the last value used, formatting the date/time stamps, etc.)
- etc.

To find out if your label is compliant with the export limitations, do the following:

1. Save the label.
2. Select the command File -> Export -> Export to Pocket PC.
3. If your label complies with the limitations, the label is exported. The files with extensions .PNL and .LVX will appear in the same folder, where your label is stored. You can copy them to the Mobile device with the Microsoft ActiveSync. If your label does not comply with the limitations, you will see the error dialog box that will explain which unsupported feature you use on the label. Remove that feature and try to export the label again.

NiceLabel Pro User Guide
For more information about the label design for Mobile devices refer to the white papers available online.

**Multicolor Printing**

Some thermal printers support multicolor printing. They use multiple heads, each head for a ribbon of a different color. The colors for each printer head are customizable and can be defined in the printer driver. Each print head is assigned a color that matches the used ribbon. The same colors become available in the labeling software. For multicolor printing to work you need to use the appropriate NiceDriver.

Color palette synchronizes the available colors with settings in the printer driver. All colors you have defined in the printer driver are retrieved in the labeling software and made available for color selection. Color palette, color selection dialog box and label setup dialog box all display only the available colors from the printer. Each label element can then easily be assigned some of the available colors. The element is then printed using that color. More than one color cannot be used with a single label element.

When you use color images on the label, their appearance on the label changes. They cannot be printed in more colors than supported by the printer. The images are not displayed in full color. Each image is converted to monochrome graphics and previewed on the label as such. Conversion from color to monochrome graphics is done using dithering setting in the driver. You can assign the image one color and thus the print head where the image will be printed.

The colors on the label identify which printer head will be used for printing the elements.

**Setting up Stock Manager to List Commonly Used Labels**

When you create a new label, you can base the new label on some pre-designed label format referred to as stock, or you can design the new label from the scratch. The labeling software comes with a library of pre-defined stocks, based on the labels from different manufacturers. You can also add the definition of your own labels into the library by using the Stock Management. To open Stock Management, do the following:

1. Select the option Stock Management in the File menu. A new window will open showing all defined stocks listed in a table.
2. Under the Stock type option, select the group from the combo box for which you wish to show the stocks. The table will contain stocks from this group only.

Define your own group by doing the following:

1. Click on the ellipsis button. The dialog box of Stock Types will open.
2. Click on the Add button and provide the name of the group. Click on Save and Close.
3. Select your new group and click on the button New in the bottom part of the dialog box. The stock definition dialog box opens.
4. Open the General tab and define the identification properties of the stock.
5. Open the Dimensions tab and define the width and height of the label.
6. Click on the OK button.

The stock will be saved in the library and available for selection whenever you will create a new label.

**Tracing Variable Values**

Each value of the variables can be traced and logged into the log file.

By default the tracing functionality is disabled.

To enable tracing, do the following:

1. Select **Variable Trace Setup** from Data menu.
2. Select the variables you want to trace.

**Note:**
By default, values for all variables on the label are traced.

3. Select **Configure Log File** from Tools menu.
4. Enable logging functionality.
5. When you will print labels, the values for variables as were used on the label are saved to the log file.

**Using Contents Mask**

Contents mask is very useful when you must display the input data differently on the label. With contents mask you can simply reformat the data to suit your needs.

For example, you must use differently formatted human interpretation text below bar code than the data is formatted in the bar code. You do not want to define two variables for this purpose and enter the similar data twice.

The mask character will be replaced by the actual data and any other used character will be used as-is. If the current bar code value is "AD951"

and the contents mask is "**C - ** /*/"

the resulting output will be "ADC - 95 /1/"

Powerful formatting structures can be defined using Contents mask, but it is only available with bar codes that allow custom formatting of the human interpretation.
You should also make sure to print bar codes as graphics, otherwise the contents mask is not available.

**Note:**
If your data contains the asterisk "+*" character, then you will have to change the default mask character to something else. It should be a unique value, not appearing anywhere in the data.
The contents mask functionality is available with Text and Bar code objects.

**Using Expression Builder**

The labeling software has a simple text editor built-in. You can use it to design your own simple VB Scripts or .JOB batch files with NiceCommands.

The Expression builder is a programming text editor with constant access to command reference of the script language you are currently using. The Expression Builder can be used with Visual Basic Script and with NiceCommands.

The Expression Builder lets you edit your scripts and expressions with ease. The Load and Save buttons allow you to import/export Visual Basic scripts from/to external text files.

**Note:** The expression editor understands syntax highlighting. The editor will highlight the NiceCommand and VB Script commands for easier understanding of the code.

**Available Keyboard Shortcuts**

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cursors</td>
<td>Standard positioning of the cursor.</td>
</tr>
<tr>
<td>Ctrl + F</td>
<td>Find some text.</td>
</tr>
<tr>
<td>Ctrl + R</td>
<td>Find &amp; replace some text.</td>
</tr>
<tr>
<td>Ctrl + Space</td>
<td>Code completion. When typing the command press this shortcut to display all commands that match the partially entered name.</td>
</tr>
<tr>
<td>Ctrl + Shift + digit</td>
<td>Define the bookmark at the current cursor position. Next to the row number you will see a bookmark number. You can use up to 10 bookmarks simultaneously. To remove the bookmark go to the row where the bookmark is defined, then press the same keyboard shortcut again.</td>
</tr>
<tr>
<td>Ctrl + digit</td>
<td>Go to the bookmark with the selected number.</td>
</tr>
</tbody>
</table>

**Working Window Description**

The working window is divided into four parts.

| Category | This section contains the groups of available commands, functions and operators. Similar objects have been grouped together for easier identification and faster search. The groups are displayed as tree-view. Select the main group name to display all its contents into the Name section. Or you can click the plus sign in front of the group name (if available) to display all |
defined sub-groups. Then select the sub-group name to display only its contents.

**Name**

This section will display the contents of the selected group in the Category section. All available commands, functions, operators etc. will be listed here. If you select one of them its properties will be displayed in the Description section. If you want to insert the selected operands into the Expression field double click its name or click the Insert button.

**Expression**

This section is the main workplace of the Expression Builder. Use it to write and modify the script your are working on.

**Description**

This section displays the name, sample use and description of the currently selected operand in Name section. You will get an idea how the current operand should be used.

Script Help: button will open the help file with the detailed reference of the currently used script (Visual Basic Script or NiceCommands). Click it to find out more about the command you are working with.

**Using Label Inspector**

Label Inspector is a tool for advanced element and data manipulation on the label. It is used for overview of label's structure and modifying label components, all element's properties can be simply modified from Label Inspector. You can of course still double click the element and change its properties from dialog box, but for smaller changes it is much quicker to change them in Label Inspector. Besides functionality you were used to earlier, Label Inspector brings some entirely new features, not available in previously.

Now you can change properties of several selected elements at the same time. If elements are of the same type, for example, all texts, you will be able to change their every property. If elements are of different types, for example, one text, one bar code symbol and one rectangle, only the properties common to all elements could be changed.

With Label Inspector you change some element's properties that are not accessible otherwise. Each element can have its own name, so you can distinguish between them. Whenever you select the element on the label, it will be highlighted in the list of elements within Label Inspector and its properties will be displayed in the bottom part of the Inspector (Properties section).

Label Inspector can be used to change the current view of the label elements, variables, functions and databases. The following views are available, the first on being the default one.

- **View by Objects:**
  All label elements are listed alphabetically by their type. First listed are text elements, then paragraph, bar code, graphics, rectangle and line elements. You have probably noted this is the same order of elements as they appear in the
Toolbox. When you select one or more elements in the upper part of the Inspector, its (their) properties are displayed in the bottom part of Inspector. You can interactively change them and changes will be reflected automatically on the label. You can right-click any element and quickly access frequently used commands from the drop-down menu. You can find out to which variable some element is connected to by clicking the plus sign in front of the element's name. If it is not fixed, the view will be expanded and variable name displayed.

- **View by Variables:**
  All variables used on the label are listed here. They can be either prompt (their value is typed in by the user at print time), database (acquired from database fields) or function-generated variables. If you click the plus sign in front of variable's name, the view will be expanded. You will be able to review from where the variable gets its data (database, function) and to which element(s) it is connected to. At the top of the upper section you can define a new variable. You can right-click any variable name and quickly access frequently used commands from the drop-down menu.

- **View by Functions:**
  All functions used on the label are listed here. If you click the plus sign in front of function's name, the view will be expanded. You will be able to review which are input and output variables for the function. At the top of the upper section you can define a new function. You can right-click any function and variable name to quickly access frequently used commands from the drop-down menu.

- **View by Databases:**
  All databases used on the label are listed here. If you click the plus sign in front of database's name, the view will be expanded. You will be able to review which are output variables from the database. At the top of the upper section you can define a new database. You can right-click any function and variable name to quickly access frequently used commands from the drop-down menu.

- **View as List:**
  This view is similar to View by objects with one difference. Not only objects are listed here, but also all variables, functions and databases. You can right-click any name to quickly access frequently used commands from the drop-down menu.

The rightmost button **Inspector properties** is used to define the default behavior: should the view to Inspector's elements be expanded by default or not. If the elements are expanded then all the properties for all of them are visible. If they are not expanded, you will have to manually expand the view of the element, you are interested in.

**Using Pictures from the Memory Card**

To select the picture from the memory card, do the following:

1. Open the label where you want to use the pictures from the memory card.
2. Make sure the printer has inserted the memory card that contains the pictures.
Designing Labels

3. Select the command **Printer Settings** in the File menu.
4. Go to **Printer Memory** tab.
5. Look at the Slot where you have inserted your memory card in the printer.
6. Change the Slot Type to Memory Card.
7. Select the appropriate .MMF file, created by the application NiceMemMaster.
8. Close all dialog boxes.
9. Select the Picture object in toolbox, then click on the label.
10. Browse to the picture on the disk that you want to use.

### Note:
This is the same picture as you have downloaded to the memory card. You need to insert it from the disk for previewing purposes only. When the label is printed, the picture already stored in the memory card will be used.

11. Tick the option **Picture is stored on the memory card**.
12. Click on the **OK** button.

---

### Designing an RFID Smart Label

#### Overview

The concept of RFID (Radio Frequency IDentification) can be simplified to that of an electronic bar code. First emerging in the 1980s, RFID was primarily used to track objects in industrial environments where bar codes were unable to sustain the harsh surroundings. Today, RFID is being used to track proprietary assets, automate access control and has many more additional fields of usage.

Some thermal printers have the ability to program a RFID tag at the same time as they are printing the label. Two different technologies and their encoding methods are joined on the same label. Of course a label must have embedded a RF tag. The tag is paper thin, flexible and small in size which allows it to be placed inconspicuously under the label. It consists of an etched antenna and a tiny chip that can store ID number or your custom data in larger quantities. This contrasts with a bar code label, which does not store any enhanced information, but merely some code number.

Radio frequency identification (RFID) refers to technologies that use radio waves to automatically identify individual or groups of items. The labeling software and NiceDrivers support programming and printing of RFID tags embedded in a label.

### Note:
You can use RFID functionality in the labeling software only if you have installed a NiceDriver with RFID support. Make sure you install the NiceDriver of your RFID printer before you design and print an RFID smart label.
Create RFID Smart Label

1. Click on button in the Standard toolbar. Label Setup Wizard will start.
2. Select the printer that supports RFID smart label printing.
3. Click on the Finish button.
   You will see that ‘RFID Tag’ command is enabled in the Toolbox on the left side of the labeling software working window.

   RFID Tag is available for use

4. Click on the RFID Tag option in the Toolbox and define the data you want to encode into the RFID tag.

Encode RFID Tag

The RFID tags embedded into the label are usually of two types: ISO tags, which encode blocks of data; or UHF tags, which can encode one string of data.

1. Click on the button in the Toolbox to begin encoding the data. The RFID Tag dialog box opens.
Encoding contents for RF Tag

2. Select the type of the RFID Tag you want to use from the list box on the top of the dialog box. Click on the **Tag Settings** button to review RFID tag contents and define the encoding advanced properties.

3. Enable the option **Write data to RFID tag** if you want to program the tag at the same time as the label is printed.

**Note:**
If you don’t select this option, the definition of tag content is saved but not sent to the printer.

4. Select the appropriate entry from **Data Fields** section.
   For RFID Gen2 tags you are able to select from different data fields. For other RFID tags usually only one data field is possible - RFID Tag Memory.

5. Go to the first available block in the section **Data Blocks** and click on the **Data** cell in the table.

**Note:**
You might not see the table-like structure. Instead you can see edit fields to enter the RFID data. The typo of data entering depends on the type of selected RFID tag.

4. Type in the value you want to encode into this block. Repeat the process for other blocks.

5. Click on the OK button. A schematic view of the RFID Tag antenna will open in the label background identifying the definition of the RFID data on the label.
RFID Tag antenna in the background

7. You can continue designing the smart label with non-RFID data as described in the previous sections.

Whenever you print the label, the RFID data will be sent to the printer. The printer prints the RFID smart label and programs the RFID tag embedded into the label at the same.

Note: The labeling software can work with Unique RF Tag numbers. Each RFID tag has embedded a unique serial number. Some printers can read the Unique RF Tag number and it can be used on the label linked with some label objects.

**RFID Tag Settings**

**Tag Information:** This section provides the information about the selected tag type. You can see the structure of the selected RFID tag. The outlook of the information depends on the selected type of the tag. For RFID Gen2 you will see table-like structure with the information about the available data fields, number and size of the block, read or write support.

For other RFID tags you can review the following structure:

- **Number of blocks:** The number of blocks that are available in the RFID tag.
- **Reserved blocks:** The number of blocks that cannot be accessed and used.
- **Block size:** The size of each block (in bytes).
- **Unique RF Tag:** This property is set to Yes, if you have the printer and/or the tag type that can provide you with the Unique Tag ID. Each tag has a unique ID encoded already in the production line. If your printer can read this information from the tag, you can use it with the label objects using **RFID Tag Contents contents provider**.

For example: The printer scans Unique Tag ID, remembers it and prints it on
the label encoded in a bar code element. The value of Unique Tag is never returned to the labeling software. It is handled internally by the printer.

**RFID Tag Data Read:** This property is set to Yes, if you have the printer and/or the tag type that allows the extraction of the encoded data. You can extract all or part of the data encoded in the RFID tag and use it with the label objects.

**Tag Settings:** This section provides more control for RFID programming.

- **Antenna offset:** To achieve better programming accuracy of the tags here is the option to define the offset for the antenna in the printer. This is the distance from the antenna to the to the embedded tag on the label. This option will help you program the tags more accurately.

- **Maximum tags to stop:** When the programming of the RFID tag fails, usually the word "VOID" is printed on the label. With this option you can specify how many tags can be programmed wrongly, before the printing of labels stops. The option can be used as a precaution measure to prevent endless consumption of labels.

- **Number of retries:** The number of times the printer will try to program the tag if first attempt fails. The parameter is sent to the printer with the rest of the data.

- **Check for a valid tag:** Before the tag programming begins, the printer will verify if there is a proper RFID tag available in the smart label. The printer will also verify if the tag can be programmed at all. If the printer cannot check the currently selected RFID tag, the option will not be accessible.

- **Verify data write:** Once the data has been encoded into the RFID tag, the printer will check if the written data is equal to the original value.

**EAS Settings:** This section provides settings for Electronic Article Surveillance.

EAS is not available for all printers and drivers. If your RFID Tag Settings do not include EAS Settings, you may need to update your printer driver or select a different printer. For more information, see your printer and driver documentation.

- **Preserve original EAS setting:** The original EAS setting cannot be retrieved, but the default option assumes that the tag setting should remain unchanged.

- **Enable EAS:** Enable Electronic Article Surveillance in the RFID tag. If this was the original setting, the tag will remain unchanged.

- **Disable EAS:** Disable Electronic Article Surveillance in the RFID tag. If this was the original setting, the tag will remain unchanged.

- **Permanently lock EAS tag setting:** Checking this box will permanently lock the chosen setting for the EAS. This lock cannot be undone.

**RFID Tag Locking**

Tag locking is not available for all tag types, printers, and drivers. If the Locking Settings... button is not displayed in the RFID tag dialog window, you may be using
Designing Labels

an unsupported RFID tag type, printer, or driver. The locking settings are available for
some GEN2 tag types. For more information, see your printer and driver
documentation.

RFID tag locking enables the user to lock the RFID tag, so that no changes can be
made to it without unlocking the tag first. If the tag is permanently locked, it is not
possible to unlock it, and the RFID tag can never be changed.

Preserve original locking setting: The original locking setting cannot be retrieved,
but the default option assumes that the tag setting should remain unchanged.

Lock: The RFID tag is locked and further changes to it are prevented.
Unlock: The RFID tag is unlocked, so that it can be changed.
Relock: The RFID tag is unlocked, the changes are applied, and the tag is locked
immediately after.

Permanent lock/unlock: Checking this box will apply your selection above
permanently and prevent later changes to it. This setting cannot be undone.

Support for RFID Tags

With the labeling software you can program RFID tags of different manufacturers. It
is important to use NiceDriver printer driver for your thermal printer. You cannot
program RFID tags, if you do not use NiceDriver.

NiceDriver will let the labeling software know which types of RFID tags the printer
supports.

Not all tag types are always available. It depends on each printer model what kind of
RFID tags can be used with it. There are generally two types of tags:

- ISO tags (TagIt, iCode, ISO...): These are block oriented tags. The data can be
  encoded in multiple blocks.
- UHF tags (EPC): The data is encoded in one block of data.

You can input content for RFID tags using different methods, dependant on the tag
type (UHF or ISO).

For UHF tags

Data type: Data type of the selected tag can be specified here.

Data source: Incoming data that is encoded in the tag can be fixed value or
acquired from some variable, defined in the label.

Data size: The currently used data is previewed here. You can see the amount
of space still available in the tag. The occupancy of the tag is seen graphically
with growing bar and numerically with the digit, explaining the number of
already used bytes.

Block locked: If you set the block as locked, the data will be permanently
encoded into the tag. You will not be able to erase this block to re-program it
with some other value. Use this option with caution!
For ISO tags

The blocks that are dimmed and unaccessible are reserved blocks that cannot be used.

**Block Number:** The successive number of block in the tag.

**Data source:** Select where the data block will receive the value from. It can be Fixed, where you will manually type in the value or can be Variable, where the value is acquired from some variable defined in the label.

**Data:** Type in the tag value manually, if the selected data type is Fixed. Select the variable defined in the label, if the selected data type is Variable. If your variable length is greater than the block size, the next block will automatically be reserved for the data.

**Size:** The currently used data is previewed here. You can see the amount of space still available in the tag. The occupancy of the tag is seen graphically with growing bar and numerically with the digit, explaining the number of already used bytes.

**Data type:** The data can be encoded as ASCII string or as HEX encoded string.

**Locked:** If you set the block as locked, the data will be permanently encoded into the tag. You will not be able to erase this block to re-program it with some other value. Use this option with caution!

**RFID Read and Store Data**

Here you can define which RFID data fields from the RFID tag will be stored in the selected storage type. Put the tick mark next to the data field you want to store. The list of available data fields might change with the selected RFID tag type.

Once you have selected the RFID data fields, you can select the storage type that matches your requirements. Some of the storage plugins ship with the software. So you can select the database and text storage plugin.

**Note:** If no storage plugin is selected the selected RFID Data Fields will still be stored into the regular log file.

**Database Storage Plugin**

The RFID database storage plugin defines how the RFID data is stored in the selected database. The printer driver receives the RFID data from the RFID reader embedded in printer. The database plugin defines into which database field the RFID data should be stored.

**Storage Database tab**

Here you can create a link to the database and its table, where you want to store the RFID data. You can use direct database access to open the supported database, or use the connection using ODBC, OLE DB and BDE drivers.
Note: You must select a true database that is accessible using SQL sentences. This rules out spreadsheets like MS Excel.

Storage Fields tab

Here you can select the table field into which you want to store the RFID data. You can insert new records in the database, or you can update the existing records in the database.

**Update existing data records in the table**

Use this option to insert RFID data values into the existing records in the database table. In the first table below select the field into which you want to store RFID data. Make sure that the Data Source is set to 'RFID Data'. At the same time you can also store the values of other variables (not just RFID data) into the database fields.

In the second table define the query condition, when to store the values in the database. The data values are stored to the database, when all conditions are met. This feature allows you to define a condition based on the fixed values or variable values. Create a join between the field name and the data source.

**For example:** Usually you create a join between the ProductID field in the database and the label variable ProductID. If both IDs are the same, you can be sure you will write the data into the correct field.

**Insert new data records into the table**

Use this option to insert RFID data values into new record in the database table. In the first table below select the field into which you want to store RFID data. Make sure that the Data Source is set to 'RFID Data'. At the same time you can also store the values of other variables (not just RFID data) into the database fields.

Error Logging

If you do not see the RFID data stored into the selected database, you can enable error logging to catch the error messages. The RFID data storage takes place outside of the labeling application by another software component. The RFID data is returned by the printer driver when the printer actually prints the label and reads the RFID data. It might not be immediately after you issue the print command, the job might be delayed in the spooler out of several reasons.

When you enable the error logging, select the text file into which you would like to store error message. The error messages will help you resolve the error situation. Usually the conditions you have defined in the Storage Fields tab are not met.

**Note:** RFID data is always stored in the XML data structure.
Designing Labels

Changing Printer Settings

Changing Common Printer Settings

When you start designing a label you tell the labeling software to what printer the label should be connected. Each label file remembers the printer settings for the selected printer driver on the label.

As an example, you will change the printing speed and darkness. To change the printer settings, do the following:

1. Go to File – Printer Settings. The window with the printer settings will open.
2. Open the Options tab.
3. Change the Speed and Darkness options.
4. Click on the OK button.
5. Save the label by clicking the button in the Standard toolbar or selecting the command Save in the File menu.

### Printer driver properties

**Note:**
Any changes in the printer settings dialog box will be saved to the label and applied to future print actions.

You can also change the printer settings right before the label is printed.

1. Select the Print command in the File menu.
2. Go to the Printer tab.
   This tab allows you to change the printer just before printing begins, but it also enables you to change common printer settings like speed, darkness and print direction.

**Note:**
Changes to the settings in the Printer tab will not be saved in the label but used only at print time.

Changing Dithering Options

Dithering is a process of converting color or gray scale pictures to black and white pictures that can be printed on thermal printers. Thermal printers normally cannot print color images and can either print a dot on the label or not. There are no intermediate shades of grey.
During the dithering process all colors and shades of grey in the picture are converted to black and white dots, creating the illusion of new colors and shades by varying the pattern of dots. Different shades of gray are produced by varying the patterns of black and white dots. There are no grey dots at all. In printing, dithering is usually called halftoning, and shades of gray are called halftones.

To change the dithering settings, do the following:

1. Go to File – Printer Settings. The window with the printer settings will open.
2. Open the Dithering tab.
3. Change the Dithering type option to suit your needs. Look at the preview on the right side how you can expect the selected type to be applied on the label.
4. Click on the OK button.
5. Save the label by clicking the button in the Standard toolbar or selecting the command Save in the File menu.

Defining Unprintable Area

Unprintable area is the part of the label where the printer cannot print. You can virtually increase the size of the label by enabling unprintable area in the printer driver. The thermal printer can only print labels that are placed below the print head. If you have wider labels and the print head does not completely cover the label, the label part jutting out of the print head cannot be printed.

With unprintable area feature you can let the application know that there is unusually wide label inserted into the printer. The labeling software will draw vertical red lines identifying the unprintable area. The unprintable area is usually the label area left and right of the printer head.

The unprintable area is not margin. the label objects are not shifted on the label.

To define the unprintable area on the label, do the following:

1. Open the label in NiceLabel Pro.
2. Select File -> Printer Settings.
3. Go to Options tab.
4. Enter the values for Unprintable Area.

For example:
You have a printer with 10 cm (4”) printer head and a 12 cm wide label. You insert the label centrally in the printer, so it sticks out of the print head evenly on both sides. You define a new label in the labeling software with 12 cm width. By setting the unprintable area to 1 cm on the left and 1 cm on the right side you let the labeling software know that the actual label width is 10 cm. There will be two vertical red lines on the label identifying the unprintable area.

Note:
You might also see the vertical red lines when you switch the printer on the label. The original printer might had wider print head than the new printer. Maximum widths of the labels are not the same for both printers. The labeling software will try to preserve
the original label dimension and automatically define the unprintable area for the new printer.

Using Toolbars

Using Standard Toolbar
Click on the icons in the standard toolbar will execute the following actions:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Create New Label" /></td>
<td>Create new label.</td>
</tr>
<tr>
<td><img src="image" alt="Open Existing Label" /></td>
<td>Open existing label.</td>
</tr>
<tr>
<td><img src="image" alt="Save Label" /></td>
<td>Save currently opened label.</td>
</tr>
<tr>
<td><img src="image" alt="Cut to Clipboard" /></td>
<td>Cut the selected objects to clipboard.</td>
</tr>
<tr>
<td><img src="image" alt="Copy to Clipboard" /></td>
<td>Copy the selected objects to clipboard.</td>
</tr>
<tr>
<td><img src="image" alt="Paste from Clipboard" /></td>
<td>Paste the objects from the clipboard.</td>
</tr>
<tr>
<td><img src="image" alt="Undo Action" /></td>
<td>Undo last action.</td>
</tr>
<tr>
<td><img src="image" alt="Redo Action" /></td>
<td>Redo last action.</td>
</tr>
<tr>
<td><img src="image" alt="Print" /></td>
<td>Access to the print functionality. Click on the small arrow for more commands.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom" /></td>
<td>Access to the zoom functionality. Click on the small arrow for more commands.</td>
</tr>
<tr>
<td><img src="image" alt="View" /></td>
<td>Access to the view functionality. Click on the small arrow for more commands.</td>
</tr>
<tr>
<td><img src="image" alt="Variables" /></td>
<td>Access to the variables. Click on the small arrow for more commands.</td>
</tr>
<tr>
<td><img src="image" alt="Database" /></td>
<td>Access to the databases. Click on the small arrow for more commands.</td>
</tr>
<tr>
<td><img src="image" alt="Help" /></td>
<td>Open the help file.</td>
</tr>
</tbody>
</table>

Using Database Toolbar

![Database Toolbar Image]
First field shows the list of currently active databases. It allows you to browse through the attached databases.

<table>
<thead>
<tr>
<th>User Information</th>
<th>List box lists the links to the databases that are available in the label.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Define a link to new database using Database wizard. The Database wizard will guide you through the necessary steps to link database on the label. The result will be database fields available as variables.</td>
</tr>
<tr>
<td></td>
<td>Define new link to the database manually.</td>
</tr>
<tr>
<td></td>
<td>Edit the properties of the selected link to the database. You can change the database driver, select which records will be printed and define if quantity of the labels comes from the database.</td>
</tr>
<tr>
<td></td>
<td>Delete the selected link to the database. <strong>Note:</strong> Make sure that database fields are not used anywhere on the label, linked to objects or used in the functions. Otherwise the link cannot be removed. If you are not sure, where the database fields are used, use the Label Inspector to find that out.</td>
</tr>
<tr>
<td></td>
<td>Click on this button to open the database table in database management application NiceData.</td>
</tr>
<tr>
<td></td>
<td>Database navigator buttons can be used to move through the records in the database. Use these buttons to see how data from different records will be used on the label. You can quickly verify if the objects fit on the label. <strong>Note:</strong> The buttons are accessible only when you have enabled Data view on the label and when record selection in the properties of database link is disabled.</td>
</tr>
</tbody>
</table>

**Using Design Toolbar**

The design toolbar is used for:

- Changing color of the objects.
- Aligning objects.
- Rotating objects.
- Arranging objects.

**Using Printing Toolbar**
Preview labels on-screen.

Print the current label.

**Test print** the current label.

Print the label using the form generated in the application NiceForm. If you want to print a label from the form, you must have a label already defined. The form file must also be prepared and linked to the label.

**Note:** To link a form to the label, use the command Tools -> Design Form.

Open the dialog box with printer properties. You can change the settings in the printer driver.

Quickly change the print direction of the label.

### Using Text Toolbar

You can use text toolbar to quickly format the text objects on the label.

Here is how:

1. First select the text object by clicking it.
2. Click the appropriate shortcut button in the text toolbar.
3. To change the font, select the appropriate font from the list in the list box.

**Note:**

You can limit the display of fonts in the list. You can list all fonts on the system, only graphic fonts (true type, opentype, type1, bitmap Windows fonts) or only thermal printer resident fonts. Click on the two icons next to the list of fonts.

4. To change the size of the text, click on the list with font sizes and select appropriate size. You can also click on the buttons that will enlarge/reduce the size of the font to the next step.

**Note:**

You can change the fonts size also directly on the label by resizing the text element with a mouse.

5. To format the text bold, italic or underline, click on the appropriate formatting buttons.

Formats the selected text in bold style.
Designing Labels

Formats the selected text in italic style.

Formats the selected text in underline style.

6. To change the alignment of the text object, click on the appropriate alignment buttons.

**Note:**
These buttons are accessible only for multi-line text objects.

Aligns text to the left edge.

Aligns text to the horizontal center.

Aligns text to the right edge.

**Using Toolbox**

To use the toolbox, do the following:

1. Click on the icon in the toolbox to select the object.
2. Move the mouse over the label. See how the cursors has changed.
3. Click on the label where you want to place the selected object.

Some objects have additional shortcut on the right side of the icon. Using this shortcut you can quickly create a new object with fixed content, create a new variable and connect it to the selected object or connect the object to one already defined variable.

**Using Variable Toolbar**

The list box contains the variables available on the label. If you have selected some variable object, the list box displays variable linked to that object. If no object is selected, selecting a variable then clicking on the label places new text object and links it to the variable.

Create new variable using the **Variable wizard**. If you click on the small arrow, you can specify the type of the new variable.

Create new variable manually.

Edit the properties of the selected variable.

**Note:**
If you select the variable object, the variable linked to the object will be automatically listed in the list.

Delete the selected variable.

**Note:**
If you want to delete the variable, you must not use it on the label linked to label objects or used in functions.

Disconnects the variable from the object. The object becomes fixed, but will preserve the formatting. The number of the characters in the object will be equal to the length of the variable. This might be useful when you are changing the database on the label and want to conserve current position and format of the objects. When you re-connect the other database, you can simply link the objects to new variables.

Access to the labeling software Functions dialog box. If you click on the small arrow, you can select which new function you want to create.

There are several methods to connect a variable to some label element that should contain variable values.

- If you have the element already positioned on the label, select it, then choose the appropriate variable in the list.
- If the element is not already on the label, you can first select the variable in the list and then click the label where you want the element positioned. Text element will appear there and will be connected to the selected variable.
- If you want any other element (and not text) connected to the variable, you can first select the variable in the list, then click the desired element in the Toolbox and then click the label.
- You can click on the small arrow button next to the object icon in the toolbox, select the option Use Existing Variable, select the variable from the list and click on the label.

Variable toolbar always shows the name of the variable, which is attached to the current selected element. If there are two or more elements selected, and do not have the same variable attached to it, then the variable combo box is empty.

**Using Zoom Toolbar**

- **Zoom in**: This command increases the selected element or part of the element.
- **Zoom out**: This command decreases the selected element or part of the element.
- **Factor**: You can define your own factor of zoom (in %).
- **Zoom to label**: You will see the entire label on the screen.
- **Zoom to page**: You will see the entire page on the screen.
Zoom to objects: You will see all the objects on the screen.

Note: To be able to zoom into the label at custom zoom factor, you can click on the button and draw a frame on the section of the label you want to zoom in.

---

Working with Objects

Using Text Wizard

Text Wizard

First screen of Text Wizard

Text Wizard guides you to define all parameters for the text object.

Fixed text: Select this option if you would like to have a fixed non-changeable content of the object. If you select this option, you can enter the text directly in this dialog box.

Variable text: Select this option, if you would like to have variable content of the object. Defining the content is defined in the next step.

Font: Currently selected font type is shown in this field.
- **Inverse:** Enable this option to use the text in inverse.

**Note:**
The option is not available for all printers.

- **Select button:** You can select different font type for this text object among available fonts in the system.

**Text Wizard - Choosing Variable Text**

![Text Wizard - Choosing variable text](image)

Select the type of the variable field you want to use. If some of the option in the list is not accessible, the functionality is not available.

**Variable name:** Type in the name of the variable that will be linked to the bar code object and will provide the value for it.

The next page of the wizard depends on your selection here.

**Text Wizard - Keyboard Input**

Use this variable type when you want the operator to enter a value of the variable from the keyboard before printing the specified numbers of labels.
Dialog box for Text Wizard when Keyboard input option is chosen

**Prompt text for this variable field**: Fill in the message that will be shown to the user when he will enter the values for the variable field.

**Format**: Select the format of data you allow to be entered for the variable field.

**Set maximum number of characters**: Define the maximum length of characters that can be entered for the variable field.

**Text Wizard - Counter**

On this page of the wizard, you define the counter variable.
Dialog box for Text Wizard when Counter option is chosen

Starting Value: Set the starting value for the counter. The counter will increment or decrement from the starting value.

Note:
You can enter only digits for the starting value.

Prompt for value before print: Tick this option to enable entering the starting value of the counter when you start printing labels. Enter the text that will be shown to the user before printing.

The message will be shown on the screen each time when the label is to be printed.

Set maximum number of digits: Define the maximum length of digits the counter can occupy.

Increment or decrement: You can define that the variable value will increase from label to label, or decrease.

Preview: The field shows the preview of the counter, based on your selection.

Text Wizard - Counter Continuation

Step: Define the step for your counter. The counter will increase by this number on every label.
Change value every \(<n>\) labels: Define the number of labels, when the counter will change the value.

Rollover when reached: Enter the value, when reached, will cause the counter to reset the value to the starting value.

Text Wizard - Date Field

Define the properties of the date field. The variable field will get the value from a computer clock.

Dialog box for Text Wizard when Date field option is chosen

Format: Select the format for your date from the list. You can also enter the custom format.

Date offset: You can add a certain numbers of days, months or years to a current date and print that date instead of the current one.

Preview: The printer will print the date as shown on the Preview field. This way you can see how the selected date format will look on the label.

Text Wizard - Time Field

Define the properties of the time field. The variable field will get the value from a computer clock.
Dialog box for Text Wizard when Time field option is chosen

**Format**: Select the format for the time from the list. You can also enter the custom format.

**Preview**: The printer will print the time as shown on the Preview field. This way you can see how the selected time format will look on the label.

**Text Wizard - Database**

Variable field linked to the database gets the value from the specified database field.
Dialog box for Text Wizard when Database option is chosen

**Define:** Click on this button to open the database wizard that will help you define the link to the database.

**Field:** Choose one of the available database fields as a source for the variable field.

**Length:** Define the maximum length of the string in variable. If field in database contains more characters, they will not be printed. This option is useful if the field length in your database is not fixed (for example tab delimited ASCII file), or if you don't want to reserve space for all the characters in database's field.

**Text Wizard - Prefix and Suffix**

The variable element can have a prefix and suffix values. The prefix text is placed in front of the variable's value. The suffix text is place at the end of the variable's value.
Setting Prefix and Suffix string for the variable text element

**Note:**
If you leave the edit fields empty, the prefix/suffix will not be used.

Prefix and suffix can be used in situations where they are required only if the variable has set some value. If the variable is empty, the prefix/suffix will not be printed as well.
Using Bar Code Wizard

Bar Code Wizard

Bar Code Wizard guides you to define all parameters for the bar code object.

**Fixed bar code data:** Select this option if you would like to have a fixed non-changeable content of the object. If you select this option, you can enter the text directly in this dialog box.

**Variable text:** Select this option, if you would like to have variable content of the object. Defining the content is defined in the next step.

**Note:**
When entering values for RSS composite bar codes, you need to provide the value for the linear and composite (2D) parts at the same time.

Use the following syntax for entering values for RSS composite bar codes. The pipe character (|) is used to distinguish between the components.

**The syntax:** `<linear part>|<composite part>`  
**The example:** `12345|description`

**Bar Code Wizard - Choosing Variable Bar Code**

Select the type of the variable field you want to use.
Variable name: Type in the name of the variable that will be linked to the bar code object and will provide the value for it.

The next page of the wizard depends on your selection here.

**Bar Code Wizard - Keyboard Input**

Use this variable type when you want the operator to enter a value of the variable from the keyboard before printing the specified numbers of labels.

**Prompt text for this variable field:** Fill in the message that will be shown to the user when he will enter the values for the variable field.

**Format:** Select the format of data you allow to be entered for the variable field.

**Set maximum number of characters:** Define the maximum length of characters that can be entered for the variable field.

**Bar Code Wizard - Counter**

On this page of the wizard, you define the counter variable.

**Starting Value:** Set the starting value for the counter. The counter will increment or decrement from the starting value.

**Note:**
You can enter only digits for the starting value.

**Prompt for value before print:** Tick this option to enable entering the starting value of the counter when you start printing labels. Enter the text that will be shown to the user before printing.

The message will be shown on the screen each time when the label is to be printed.

**Set maximum number of digits:** Define the maximum length of digits the counter can occupy.

**Increment or decrement:** You can define that the variable value will increase from label to label, or decrease.

**Preview:** The field shows the preview of the counter, based on your selection.

**Text Wizard - Counter Continuation**

**Step:** Define the step for your counter. The counter will increase by this number on every label.

**Change value every <n> labels:** Define the number of labels, when the counter will change the value.

**Rollover when reached:** Enter the value, when reached, will cause the counter to reset the value to the starting value.
**Bar Code Wizard - Date Field**

Define the properties of the date field. The variable field will get the value from a computer clock.

**Format:** Select the format for your date from the list. You can also enter the custom format.

**Date offset:** You can add a certain numbers of days, months or years to a current date and print that date instead of the current one.

**Preview:** The printer will print the date as shown on the Preview field. This way you can see how the selected date format will look on the label.

**Bar Code Wizard - Time Field**

Define the properties of the time field. The variable field will get the value from a computer clock.

**Format:** Select the format for the time from the list. You can also enter the custom format.

**Preview:** The printer will print the time as shown on the Preview field. This way you can see how the selected date format will look on the label.

**Bar Code Wizard - Database**

Variable field linked to the database gets the value from the specified database field.

**Define:** Click on this button to open the database wizard that will help you define the link to the database.

**Field:** Choose one of the available database fields as a source for the variable field.

**Length:** Define the maximum length of the string in variable. If field in database contains more characters, they will not be printed. This option is useful if the field length in your database is not fixed (for example tab delimited ASCII file), or if you don't want to reserve space for all the characters in database's field.

**Bar Code Wizard - Prefix and Suffix**

The variable element can have a prefix and suffix values. The prefix text is placed in front of the variable's value. The suffix text is placed at the end of the variable's value.

**Note:**
If you leave the edit fields empty, the prefix/suffix will not be used.

Prefix and suffix can be used in situations where they are required only if the variable has set some value. If the variable is empty, the prefix/suffix will not be printed as well.
**Defining Objects**

**Defining Text Object**

To place the text object on the label, do the following:

1. Click on the **Text** icon in the Toolbox.
2. Click the position on the label, where you want to place the object. Text Wizard dialog box will open.
3. Define the contents for the text object.
4. Click on the **Next** button to advance to the next step of the wizard.
5. Follow on-screen instructions in the next steps.
6. Click on the **Finish** button.

**Note:**
Should you later want to edit the object, select it then double-click it. The wizard with properties appears.

**Defining Text Box Object**

The Text Box object enables you to use free-flow text inside the designed Text Box frame without being limited to a one-line text. To create a Text Box object, do the following:

1. Click on the **Text Box** button in the **Toolbox**. The text box cursor appears on the screen.
2. Move the cursor to the location on the label where you want to place the text box object and click on the mouse button. The properties of the object will open.
3. Open the **Value** tab and type in the text content.

![Entering value for Text Box object](image)

Entering value for Text Box object
4. Click on the **OK** button. The Text Box object is placed on the label.
5. Double click the Text Box to open its properties.
6. Go to the **Detailed** tab and select the option **Best fit**.

**Note:**
When you change the size of the Text Box frame, the content will automatically align to the new size.

All three text objects are available in the labeling software

**Defining Rich Text Box (RTF) Object**

The Rich Text Box object enables you to format text in any kind of font types and styles. To create a Rich Text Box object, do the following:

1. Click on the **Rich Text Box** button in the **Toolbox**. The rich text box cursor appears on the screen.
2. Move the cursor to the location on the label where you want to place the text box object and click on the mouse button. The rich text editor will open.
3. Enter the content.
4. Use the text toolbar in the editor to format the characters.
5. Click on the **OK** button. The Rich Text Box object is placed on the label.
6. Double click the Rich Text Box to open its properties.
7. Go to the **Detailed** tab and select the option **Best fit**.
8. Click on the **OK** button.

   The text size in the Rich Text Box object automatically changes when you resize it.

**Defining Bar Code Object**

To place the bar code object on the label, do the following:

1. Click on the **Bar Code** icon in the Toolbox.
2. Click the position on the label, where you want to place the object. Bar Code Wizard dialog box will open.
3. Define the contents for the bar code object.
4. Click on the **Next** button to advance to the next step of the wizard.
5. Follow on-screen instructions in the next steps.
6. Click on the **Finish** button.

**Note:**
Should you later want to edit the object, select it then double-click it. The wizard with properties appears.

### Defining Picture Object

To place the picture object on the label, do the following:

1. Click on the **Picture** object in the Toolbox.
2. Click on the label, where you want to place the picture.
   The **Open** dialog box opens.
3. Browse for the picture on the hard disk, then click on the **Open** button.

**Note:**
Should you later want to edit the object, select it then double-click it. The wizard or dialog box with properties appears.

### Defining Rectangle Object

To place the rectangle object on the label, do the following:

1. Click on the **Rectangle** icon in the Toolbox.
2. Click the position on the label, where you want the upper-left position of the object to be set.
3. Drag to bottom-right direction until the object size is as requested.
4. The other method of positioning the rectangle object on the label is simply selecting the Rectangle tool and then clicking the label. A default-sized rectangle will appear and you can resize it using handles around the object.

**Note:**
If you want to draw a square, grab a handle a on one of the rectangle corners, simultaneously press and hold Shift key, then resize the rectangle. A square will be drawn. For more useful shortcuts available in the software refer to the chapter **Shortcuts**.

4. To move a rectangle to a different position simply select it and drag it elsewhere on the label.

**Note:**
Should you later want to edit the object, select it then double-click it. The dialog box with properties appears.
**Defining Line Object**

To place the line object on the label, do the following:

1. Click on the Line object in the Toolbox.
2. Define the line starting point by clicking the mouse at the start position.
3. Move the cursor to the end point, while holding down the mouse button. A line will be drawn from the left to right side of the label.

**Note:**
If you need to draw a vertical line, just click for starting point then drag the cursor in the up-down direction.

**Defining Ellipse Object**

To place the ellipse object on the label, do the following:

1. Click on the Ellipse icon in the Toolbox.
2. Click the position on the label, where you want the upper-left position of the object to be set.
3. Drag to bottom-right direction until the object size is as requested.
4. The other method of positioning the object on the label is simply selecting the Ellipse tool and then clicking the label. A default-sized ellipse will appear and you can resize it using handles around the object.

**Note:**
If you want to draw a circle, grab a handle a on one of the ellipse corners, simultaneously press and hold Shift key, then resize the ellipse. A circle will be drawn. For more useful shortcuts available in the software refer to the chapter **Shortcuts**.

4. To move a ellipse to a different position simply select it and drag it elsewhere on the label.

**Defining Inverse Object**

To place the inverse object on the label, do the following:

1. Click on the Inverse icon in the Toolbox.
2. Click the position on the label, where you want the upper-left position of the object to be set.
3. Drag to bottom-right direction until the object size is as requested.

**Note:**
If you want to draw a square, grab a handle a on one of the rectangle corners, simultaneously press and hold Shift key, then resize the rectangle. A square will be drawn. For more useful shortcuts available in the software refer to the chapter **Shortcuts**.

4. To move a inverse to a different position simply select it and drag it elsewhere on the label.
Using EAN.UCC 128 Wizard

Using GS1-128 (EAN.UCC 128) Wizard

This wizard allows you to define the data structure for GS1-128 (EAN.UCC 128) bar code. This kind of bar code has different areas of application that include trade items, logistic units, assets and locations.

The GS1-128 (EAN.UCC 128) bar code is an extremely flexible symbology. It allows representation of data of variable length, and makes it possible to encode several pieces of information in one bar code symbol. This is called concatenation. An Application Identifier is the field of two or more characters at the beginning of an data value. Application identifiers are prefixes that uniquely identify the meaning and the format of the data field following. The data fields are either of fixed or variable length, depending on the AI.

Step 1: Choosing the application identifier

The dialog in the first step of Wizard allows you to select the GS1-128 (EAN.UCC 128) bar code data structure. Each bar code is composed out of one or more Application Identifiers and the corresponding data.
Choose one of the Application Identifiers in this list. You can add, edit or delete Application Identifiers from the bar code later in the process.

GS1-128 (EAN.UCC 128) Wizard: How check digit should be applied

If you have selected the Application Identifier which data includes a check digit (for example, AI (01) - GTIN, Global Trade Item Number), then first you will have to select how the check digit will be applied. The possible options are:

- **Automatic calculation**: Check digit will be calculated by the application.
- **Check digit to be entered with data**: Manually enter the data and check digit. The application will verify, if the entered check digit is valid.
Step 2: Application Identifier Input Type

When the Application Identifier is selected, you will have to define where is the data for its value obtained from. There are three possible options:

- **Fixed**: The application identifier will have the fixed value on every label.
- **New variable**: The application identifier will be linked to the variable and have variable value on each label. You will define a new variable.
- **Use existing variable**: The application identifier will be linked to the variable and have variable value on each label. Select the existing variable from the list.

Step 3: Entering the value for the Application Identifier

Entering fixed value for the application identifier
Entering fixed value for the application identifier

If you have selected fixed value in the previous dialog box, you should enter value for the Application Identifier here. The Wizard will let you know about the required data format for this AI and how long the AI value should be. For some AI's the field length is fixed to certain number of digits, for others only the maximum number of possible digits is stated. You will also be reminded of the AI's proper field format (numeric, alphanumeric) if you enter incorrect data.

**Entering variable value for the application identifier**
Creating new variable for the application identifier

If you have selected new variable value in previous dialog box, a new variable field will be created. You will have to provide some information about variable being used.

**Calculating Check Digit**

Select how the check digit will be calculated.

1. You can enter the check digit with the data and the software will validate it.
2. The software can calculate the check digit.

**Defining New Variable**

Define the properties of the variable that will provide value for the application identifier.

**Prompt:** Enter the text that will be displayed to the user at print time.

**Format:** Define the format of the variable.

**Counter:** If the variable will be a counter, define its properties.
Step 4: List of selected application identifiers

Listing the selected application identifiers

This is the last step of the GS1-128 (EAN.UCC 128) Wizard. Here you can add, edit or delete Application Identifiers and define separator among them.

Application Identifiers selected: In this field all selected application identifiers for the bar code are listed in the order of creation. You can change the order with the arrow buttons.

Add, Edit or Delete buttons: Use these buttons to add additional application identifiers and edit or delete existing ones.

Input Application identifier delimiter: Define left and right separator among different application identifiers. The default setting is to use round parenthesis.

Preview: A sample bar code content based on your application identifier selection is shown here.

Click the Finish button to exit the wizard.
Selecting Bar Code Type

Settings for Advanced Bar Codes

GS1-128 (EAN.UCC 128) Bar Code

This bar code is combined from one or more input values and standard AI - Application Identifiers. Each AI must be followed by the standard values. These values can be fixed or variable.

When the GS1-128 (EAN.UCC 128) bar code is selected, the Bar code data field in the Bar code Wizard dialog box is disabled. To define the contents of the bar code, click the Next button.

From the list of available Application Identifiers select the first identifier. It will be written in bracket below the bar code.

When the Application Identifier includes also check digits, you have to define whether it will be calculated or entered together with data.

Next, define how you will set the values for the selected identifier. You may enter fixed value or define variable value.

Fixed values

When values are fixed, the Wizard dialog box will inform you what is expected to be entered – digits the maximum places...

The defined AI is presented on the list of selected Application Identifiers. Click the Add button to add a new AI or on the Delete to delete existing one.

Should you need to change the AI and the data, select the AI and click the Edit button.

You can sort the listing of AI by using the Up and Down buttons.

All the settings can be previewed on the Preview field.

The separator among Application Identifier can be defined by entering the required separator for the left and for the right side of the Application Identifier. The default separator is bracket.

Variable values

GS1-128 (EAN.UCC 128) bar code supports keyboard variables – the variable data will be entered from the keyboard.

You can define the Prompt – the message for the operator, who will enter the data.

The data can be numeric only or the operator is allowed to enter all characters.

The value can be fixed or incremented/decremented on every label or certain number of labels with the desired step.

The variable data will be written in the Preview field as a series of "A" character.
When you are satisfied with the settings, click the Finish to put the GS1-128 (EAN.UCC 128) bar code to the label.

PDF 417 2D Code

**General tab**

**Y expansion factor**
This option defines the height of the bar code symbol.

**Security tab**
Accordingly to the standard, you can select among 9 levels of security. Higher security level allows more reliable reading regardless errors, but the bar code symbol is bigger.

Truncated bar codes can be used where label damage is unlikely and there is no demand for very high level of security. The truncated symbol is smaller.

**Aspect Ratio**
It is the ratio between number of columns and number of rows.

**Contents**
PDF 417 code can encode:

- Full 128 ASCII character set
- All 128 Extended ASCII characters
- 8-bit binary data

DataMatrix Bar Code

**General tab**

**Y expansion factor**
This option defines the height of the bar code symbol.

**Aspect Ratio**
It is the ratio between number of columns and number of rows. Enter the wanted value in the fields.

**Details tab**

**ECC Type**
Error Correction Codes define the security level. You can select one from the standard levels in the pull-down menu.

**Format ID**
This option defines which character set will be used in the bar code. You can select one of the formats with the following filter.

<p>| 01 and 11 | 0..9, space |</p>
<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>02 and 12</td>
<td>A..Z, space</td>
</tr>
<tr>
<td>03 and 13</td>
<td>A..Z, 0..9, space</td>
</tr>
<tr>
<td>04 and 14</td>
<td>A..Z, 0..9, space, .- /</td>
</tr>
<tr>
<td>05 and 15</td>
<td>7-bit ASCII lower part (from 0 to 127)</td>
</tr>
<tr>
<td>06 and 16</td>
<td>all</td>
</tr>
<tr>
<td>07 and 17</td>
<td>7-bit ASCII</td>
</tr>
</tbody>
</table>

The formats from 1 to 7 allow the data length to 500 characters, while formats from 11 to 17 allow to 2000 characters.

**Border Size**

Factors from 1 to 15 set the dimension of the border in the shape of the character “L”.

**Data Matrix** can encode:

- Full 128 ASCII character set
- All ISO characters
- All EBCDIC characters

**MaxiCode**

MaxiCode is a public domain, machine readable symbol system originally created and used by United Parcel Service (UPS). Suitable for tracking and managing the shipment of packages, it resembles a barcode, but uses dots arranged in a hexagonal grid instead of bars.

A MaxiCode symbol (internally called "Bird's Eye" or "Target") appears as a 1 inch square, with a bullseye in the middle, surrounded by a pattern of hexagonal dots. It can store about 93 characters of information, and up to 8 MaxiCode symbols can be chained together to convey more data. The centered symmetrical bullseye is useful in automatic symbol location regardless of orientation, and it allows MaxiCode symbols to be scanned even on a package traveling rapidly.

All MaxiCode symbols include a Structured Carrier Message containing key information about a package. This information is protected with a strong Reed-Solomon error correction code, allowing it to be read even if a portion of the symbol is damaged. These fields include:

- A national postal code. MaxiCode supports both numeric postal codes (e.g. a ZIP Code), and alphanumeric postal codes.
  - A 3-digit country code encoded per ISO 3166
  - A 3-digit class of service code assigned by the carrier
  - A 20-character tracking number
  - A 2-4 character code indicating the originating carrier
Additional information can be encoded in a MaxiCode symbol, but it may require reduced error correction protection:

- Purchase order number
- Customer reference
- Invoice number

The labeling software supports two Maxicode modes:

- Mode 2 - Used for numeric postal codes (primary use is US domestic destinations)
- Mode 3 - Used for alphanumeric postal codes (primary use is international destinations)

You can define the values for individual data fields. The values can be fixed, just type in the value. You can also link the Maxicode fields with some of the variable defined in your label template.

**Edit Bar Code Dialog Box**

This dialog box is displayed when you click the Define button on the Bar Code dialog box.

In this dialog box you specify the type of bar code you want to use on the label and all bar code properties:

- How the bar code should be generated
- Automatic or manual check digit calculation
- Position of the human readable
- Other options dependant on the bar code type

Click the option **Enable preview** to preview the bar code. The bar code symbol was displayed on the right side of the dialog box.

Click the **OK** button to confirm the changes you made.

Click the **Cancel** button to discard the changes.

**General Tab**

On this tab you can select the bar code type you want to use and the properties of the bar code.
Edit bar code dialog box – General tab

**Type of bar code:** The required bar code symbology is selected from the tree list of available bar codes.

**Symbol height:** The height dimension of a bar code can be specified either by entering a value here or by resizing the bar code symbol directly on the label.

**Narrow bar width:** The width of the narrowest bar in the bar code. This is the base bar width. The widths for all wider bars are calculated by the formula: 'narrow bar width' * 'ratio'. The result of the formula must be a whole number (it represents number of pixels).

**Ratio:** This is the ratio between narrowest and widest bar in the bar code. The ratio is locked for majority of bar codes and you cannot change it. However, for some bar codes you can change it and adjust the bar code size to your needs.

**Space correction:** Enable this option to insert additional white pixels for each white space in the barcode. The option is useful for InkJet printers where the ink can spill out and you need an extra space between bars for the reader to decode the bar code properly.

**Base object width:** Shows the width of a narrowest bar in the bar code.

**Print bar code as graphics:** Select this option to convert the bar code object into the image and sent to the printer as image. If not selected, the bar code will print as printer internal object. Printing bar codes as internal printer objects will speed up label printing, because less data must be transferred to the printer.
Note: To disable the option Print bar code as graphics, you must use the printer drivers that ship with the software, NiceDrivers.

Enable preview: Enable this option to see the preview of the selected bar code type. The preview will show on the right side of the dialog box.

**Check Digit Tab**

This tab is used to specify if you want to use the check digit in the bar code or not. This option can only be modified for the bar codes that allow you to enable and disable the check digit.

Some bar code standards include the check-digit by the definition and it cannot be omitted. An example of such bar codes are EAN and UPC bar codes, where check digit cannot be disabled at all. But some codes allow you to freely enable/disable check-digit.

Note: It is always recommended to include the check digit character in the bar code. It will increase the scanning reliability.

![Edit Bar Code dialog box – Check digit tab](image)

You can choose whether you want to input the check digit value, or let the program calculate it for you:

**Auto-generate check digit:** Check digit is calculated by the software. You must only enter the bar code data. For example: when using EAN-13 bar code input the first 12 digits, check digit on 13th place will be calculated and added automatically.
Verify the provided check digit: Use this command when you want to enter the value for the check-digit. At print time the entered check digit it will be verified for validity.

Enable custom check digit algorithm: You can set some other algorithm you want to use for calculating the check digit. Click on the button Select to choose the algorithm.

Human Readable Tab

On this tab you can set the options regarding position and format of the bar code interpretation.

No interpretation: Bar code object does not have any human interpretation.

Below bar code: All data encoded in the bar code is placed beneath the bar code symbol as human readable characters.

Above bar code: All data encoded in the bar code is placed above the bar code symbol as human readable characters.

Font: Using the Font button, you can choose the suitable font for auto-translation text. The option Auto font scaling will adjust the font of the auto translation text to the size of the bar code.

Note:
You can only format the font for human interpretation, if the bar code is printed as graphics. When printing bar code as internal printer object, the printer will print the interpretation using resident built-in fonts.

Contents mask sets the custom format of the human interpretation.
Designing Labels

Edit bar code dialog box – Human readable tab

**Details Tab**

On this tab you can define advanced settings for the bar code.

**Note:**
Not all of these options are available for all bar codes and printers.

**Include quiet zones:** By checking this field you set, that the bar code will have some white space in the front and in the end for increased readability.

**Descender bars:** Some bars of a bar code will be longer than others. This is typically used with EAN and UPC bar codes that have longer bars in the begging, in the middle and in the end of the bar code.

**Mirror horizontally/mirror vertically:** The bar code can be mirrored vertically and horizontally. bar code will usually have to be printed as graphics for this option to be accessible.

**Intercharacter gap:** Some bar codes allow you to change the gap between characters in the bar code (e. g. Code-39).

**Include EAN white space:** Before and after the bar code a special character is inserted, < or >. It indicates the width of the bar code. If you put any other object in the extent of the bar code, it will reduce the readability of the bar code. This option is only valid for EAN bar codes.
Supported Bar Code Types

<table>
<thead>
<tr>
<th>Bar code Group</th>
<th>Bar code Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>EAN and UPC</td>
<td>EAN-8, EAN-8 + 2-digit supplement, EAN-8 + 5-digit supplement, EAN-13, EAN-13 + 2-digit supplement, EAN-13 + 5-digit supplement, EAN-14, DUN-14, UPC Case Code, UPC-A, UPC-A + 2-digit supplement, UPC-A + 5-digit supplement, UPC-E, UPC-E + 2-digit supplement, UPC-E + 5-digit supplement, UPC-E(1), GS1-128 (EAN.UCC 128), SSCC, Bookland, Addon 2, Addon 5</td>
</tr>
</tbody>
</table>
| GS1 Databar    | **Linear GS1 Databar symbologies**<br>RSS14, RSS14 Truncated, RSS14 Stacked, RSS14 Stacked Omnidirectional, RSS Limited, RSS Expanded<br>**Composite GS1 Databar symbologies**<br>RSS14, RSS14 Truncated, RSS14 Stacked, RSS14 Stacked Omnidirectional, RSS Limited, RSS Expanded, UPC-A, UPC-E, EAN-8, EAN-13, EAN.UCC 128 & CC-A/B, EAN.UCC 128 &
Working with Images

Working with Pictures

Place pictures on the label

Images can be various sizes. If the original size of the graphics is not valid for your label, you can freely resize the image by dragging the handles surrounding it. The image can be resized proportionally or stretched in both directions.

The graphics objects can also be placed on the label from the clipboard or imported from another application (i.e. Corel Draw, scanning programs...), using either the Insert Object or Paste command from the Edit menu. In this case, the graphics is embedded in the label file. The graphics is entirely stored in the label file not separately on the hard disk.

Note: When you insert the graphics as OLE object on the label (copy/paste from other software), the entire design environment of that other software is available in label design. When you double click such OLE object, that other application opens on the label. When using OLE object, the label processing might be slower. A label also occupies more space on the disk and takes more RAM. If possible, avoid using OLE objects on the label.

Use variable pictures

When you use variable pictures on the label, usually you will provide the path and filename of the picture stored in some file system. The labeling software will locate the image file and use the picture on the label. The picture name can be acquired from different sources (contents providers): keyboard prompt, field in a database, result of some function etc.

However, you can also use the pictures stored in the database BLOB fields. These fields do not contain the reference to the image location in some file system (path and filename), but contain the image itself. The labeling software will read the image from the BLOB field and use it with the picture object on the label.

When you define graphics as an variable object (some variable defines the path an filename of the picture), The labeling software does not know the size of the picture in advance, because this information is provided only at print or preview time. Until the picture name is known, the picture is previewed as a question mark.

Once you place a fixed picture on the label, you can embed it in into the label. The picture will be saved inside the label, so you no longer need the original picture on the disk. It makes the label more portable.

Handle missing pictures
The labeling software remembers the path and filename of the picture that you place on the label. Each time you open the label, the labeling software checks if the pictures is accessible and then uses it on the label. If the picture is missing, you will see a warning dialog box. You can:

- Ignore the error and temporarily design the label without the needed picture.
- Discard the missing picture and permanently remove it from the label.
- Browse to the missing picture if you have changed the picture folder location or filename.

You can also embed the picture in the label. The picture is saved with the label and makes the label more transportable. If you copy the label to some computer the picture goes with the label. To embed the picture in the label, open the picture properties and select the option **Embed into label**.

To embed all pictures into the label use the command **Transformations -> Embed all Pictures into Label**.

To enable automatic embedding of all pictures, enable the option **Embed graphics into label** in Tools -> Options.

### Place Images on the Label

Images can be various sizes. If the original size of the graphics is not valid for your label, you can freely resize the image by dragging the handles surrounding it. The image can be resized proportionally or stretched in both directions.

The graphics objects can also be placed on the label from the clipboard or imported from another applications (i.e. Corel Draw, scanning programs...), using either the Insert Object or Paste command from the Edit menu. In this case, the graphics is embedded in the label file. The graphics is entirely stored in the label file not separately on the hard disk.

**Note:** When you insert the graphics as OLE object on the label (copy/paste from other software), the entire design environment of that other software is available in label design. When you double click such OLE object, that other application opens on the label. When using OLE object, the label processing might be slower. A label also occupies more space on the disk and takes more RAM. If possible, avoid using OLE objects on the label.

Once you place a fixed picture on the label, you can embed it into the label. The picture will be saved inside the label, so you no longer need the original picture on the disk. It makes the label more portable. If you copy the label to some computer the picture goes with the label.

There are the following types of image embedding:

- To embed the selected image in current the label, open the picture properties and select the option **Embed into label**.
- To embed all images into the current label use the command **Transformations -> Embed all Pictures into Label**.
To enable automatic embedding of all images that you will place on the label from now on, enable the option **Embed graphics into label** in Tools -> Options.

### Use Variable Images

When you use variable pictures on the label, usually you will provide the path and filename of the picture stored in some file system. The labeling software will locate the image file and use the picture on the label. The picture name can be acquired from different sources (contents providers): keyboard prompt, field in a database, result of some function etc.

To create a variable picture object, do the following:

1. Make sure you already have an appropriate variable designed that will store the path and name of the picture on the disk.
2. Click on the small arrow button next to the Picture object in the toolbox.
3. From the drop-down menu select the option **Use Existing Variable**.
4. Select the appropriate variable from the list of available variables.
5. Click on the label where you want to create the variable image object.

**Hint!** If all images are of the same file format and you store all images in the same folder you can define a prefix and suffix to the variable. When the variable will obtain the image name as its value, prefix will provide the path to the image and suffix will provide the file extensions. This way the whole path and extension of the graphics file will be added automatically, you just have to provide the image name.

**For example:** If you set the variable prefix to "C:\GRAPHICS\" and suffix to ".JPG" while the variable has the value "ROSE", the result will be "C:\GRAPHICS\ROSE.JPG". The labeling software will try to locate this image and use it on the label.

When you define graphics as an variable object (some variable defines the path an filename of the picture), the labeling software does not know the size of the picture in advance, because this information is provided only at print or preview time. Until the picture name is known, the picture is previewed as a question mark.

Usually you will print the images from files that originate in some file system. However, you can also use the images that are stored in the database BLOB fields. In this case there is no filename on the disk; the whole image is in fact stored in the database.

### Using Variable Pictures from Blob Fields

You can use the pictures stored in the database BLOB fields. These database fields do not contain the reference to the image location in some file system (path and filename), but contain the image itself. The labeling software will read the data from the BLOB field.
If the data from blob field is identified as the image it will display as the image on the label, when you link such database variable with the picture object. You can connect such field to any label object, not only picture object. But the field value will be as follows:

\[ \text{IMAGE ext=XXX} \] ID

where:

XXX stands for the image extension that defines the image type ID stands for the internal number that identifies each image from the database uniquely.

When you use the BLOB fields with MS SQL database server, you can embed different image types into the fields (BMP, JPEG, GIF, PCX, TIFF, PNG, TGA, PXM, ICO, JP2, J2K). However, when you use some other database type, not all types might be accessible. Bitmap (BMP) format is always supported.

**Handle Missing Images**

The labeling software remembers the path and filename of the picture that you place on the label. Each time you open the label, the labeling software checks if the pictures is accessible and then uses it on the label. If the picture is missing, you will see a warning dialog box. You can:

- Ignore the error and temporarily design the label without the needed picture.
- Discard the missing picture and permanently remove it from the label.
- Browse to the missing picture if you have changed the picture folder location or filename.

**Designing Objects with Relative Positions**

During the regular label design process you put the objects on the certain spot on the label and they occupy that space whenever the label prints. If you link object with variables, the objects become variable object. If linked variables contain more data, the objects will usually increase their size and occupy more space. You must be careful to anticipate the maximum variable length and design your objects accordingly so the objects do not overlap each other or exceed the label boundaries. However, in some cases you need the object to change its placement on the label.

**For example:** You have a multi-line text object and bar code on the label. The bar code must always print below the text object. To solve the problem, you must link the objects together. The text object is a parent object, the bar code is linked to is as a child object. You can lock the vertical position of the bar code to the bottom of the text object. You can also define the offset between the object.

See the scheme below. The bar code changes its vertical placement. The vertical distance between the text and bar code object is always 1 cm, no matter the number of lines in the text object.
Variable positioning of the bar code object (linked to the bottom of the text object)

The placement of each label object can be variable. You can define the placement based on the label border or based on the distance from some other label object. In each case, you can define the offset from the border or other object. Of course, you can define object horizontal and vertical relative positions independently of each other.

To enable the relative positioning of the object, do the following:

1. Open the object's properties.
2. Go to the Appearance tab.
3. Click the Advanced button in the Anchoring Point section.
4. Define the appropriate horizontal and vertical relative position.
5. Click OK when ready.

When defining the relative object positions you might also want to enable the variable label sizing. The length of the label can also adapt to the size of the objects.

Rotating Label

To rotate the label on the screen, do the following:

1. Click on the icon in the top left corner of label design area (where vertical and horizontal ruler collide).
2. The label will rotate for 90° clockwise.

Each click on the button will rotate the label for additional 90 degrees. The initial rotate position is portrait. Each click will rotate the label to the next position. The positions in line are: portrait, landscape, rotated portrait, rotated landscape.

Rotating the label on screen will help you define label easier, when the objects on the label must be printed rotated, but you want to be able to design the label in the upside orientation.

Note: If you do not use NiceDriver or your printer does not support 180° printing, then only two rotations are possible (portrait and landscape).

Selecting Objects

To select two or more objects, you should press the <Shift> key, and hold down, while clicking the object with a mouse.
The objects can be selected, cut, copied, pasted and edited with the right mouse button. If you click the right mouse button on the object, the menu shows all the available commands. Note that these commands are equivalent to correspondent menu commands.

You can also change the anchoring point of a selected object by holding <CTRL> while clicking the placeholders (corners of the bounding box) of the object.

**Editing Objects**

To edit the properties of the object, do the following:

1. Double-click the object on the label.
   The dialog box with object properties will open.

   **Note:**
   You can also press the <Enter> key, while the object is selected.

2. Make modifications to the object properties.
3. Click on the **Finish** button.

**Moving Objects**

To move the object on the label, do the following:

1. Select the object.
2. Click on the object with the left mouse button.
3. Hold the mouse key pressed.
4. Move the position of the cursor on the screen.
   The object will move with the cursor.

   **Note:** When you move the object, it fades in the preview window, so that you may be able to position it more accurately. The opacity will return to normal when the object is placed in its new position.

**Aligning Objects**

First you have to select objects that you want to align.

   **Note:**
   All objects are aligned relatively to the first selected object.

Then click appropriate buttons in the **Design toolbar** to align selected objects to each other. If Align toolbar is not visible (by default it is located on the very right side of the window), enable the Design toolbar in Toolbar option in View menu.

You can align objects to:

- ![Left](img)
- ![Right](img)
- ![Horizontal center](img)
Designing Labels

- Top
- Bottom
- Vertical center

You can also distribute object evenly, so that spacing between them is equal:
- Horizontally
- Vertically

**Note:**
If you hold the <CTRL> key while clicking the buttons, objects are aligned relative to label and not to the first selected object.

The shortcut <Ctrl> + A opens the Align dialog box with same functionality as the Design toolbar.

**Resizing Objects**
To resize the object on the label, do the following:

1. Select the object.
   The selected object is framed with a rectangle.
2. Click on one of the small rectangles in the corners of the rectangle.
3. Hold the mouse key pressed.
4. Move the position of the cursor on the screen.
   The object will resize with the cursor.

**Rotating Objects**
To rotate the object, do the following:

1. Select the object.
2. Click on the icon in the design toolbar.
   The object will be rotated for 90° clockwise.

**Note:**
If the design toolbar is not visible, select the command Toolbars in the View menu, then click on the Design.

**Grouping Objects**
You can work with individual objects on the label, or you can group the objects into groups of objects. When you group two or more objects into a group, the objects behave as one single object on the label. In some cases the grouping feature will make the label design easier.

To group objects on the label, do the following:

1. Select two or more objects on the label.
2. Select the Group from Transformations menu.
   The individual objects will be grouped into one group.
Note:
To ungroup the objects in a group you must use the command Ungroup from Transformations menu.

Clipart Galleries

The distribution of labeling software includes a library of frequently used clipart images that you can use on your labels. Images are stored in .GIF and .WMF file formats. They are black & white images.

Clipart Galleries incorporate useful images from retail, logistics, chemical, automotive and other industries. Subset of these galleries is included within the two Font files, but for the whole collection of available symbols you should browse the galleries.

Font Files

Along with the labeling application you have also got two fonts with graphical symbols. You can use them on your labels. They contain frequently used care symbols (used in textile industry), symbols for handling dangerous materials (used in chemical industry) and many other useful industry symbols. The fonts are not automatically installed on your system, but should you require them, they are stored on your CD-ROM. They are accessible from the folder X:\AddOns\Fonts, where X represents the letter of CD-ROM drive in your system.

The fonts are in standard TrueType format and can be installed using Fonts utility in Control Panel. They are accompanied with two document files that include all symbols from the fonts in a easily scanned formatted table.

![Character map of Care Symbols Font - CARESYM.TTF](image)

Character map of Care Symbols Font - CARESYM.TTF
Supported Graphics Formats

The following graphical formats are supported:

<table>
<thead>
<tr>
<th>File extension</th>
<th>Graphics type</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMP, DIB, RLE</td>
<td>Windows Bitmap</td>
</tr>
<tr>
<td>GIF</td>
<td>CompuServer Bitmap</td>
</tr>
<tr>
<td>JPG, JPEGM JPE</td>
<td>JPEG Bitmap</td>
</tr>
<tr>
<td>TIFF, TIF, FAX, G3N, G3F</td>
<td>TIFF Bitmap</td>
</tr>
<tr>
<td>PNG</td>
<td>Portable Network Graphics</td>
</tr>
<tr>
<td>WMF</td>
<td>Windows Metafile</td>
</tr>
<tr>
<td>EMF</td>
<td>Enhanced Windows Metafile</td>
</tr>
<tr>
<td>ICO</td>
<td>Windows Icon</td>
</tr>
<tr>
<td>CUR</td>
<td>Windows Cursor</td>
</tr>
<tr>
<td>TGA, TARGA, VDA, ICB, VST, PIX</td>
<td>Targa Bitmap</td>
</tr>
<tr>
<td>PXM, PPM, PGM, PBM</td>
<td>Portable Pixmap, GreyMap, BitMap</td>
</tr>
</tbody>
</table>
Working with Text Objects

There are two modes of operation, which can be set by setting program preferences. The first (default) is "On screen edit". This means, you can enter text directly on the label, similar to a word processor program. When you have typed the contents, you can cancel typing by pressing <Esc> key, or confirm it by pressing <Ctrl+Enter>. The text object is created.

The second mode immediately opens the dialog box for the text, where you can enter the contents and set all other properties of the text. This dialog box can also be opened any time by double clicking the text object or by right clicking the object and selecting Edit from menu.

Working with Variable Data

Dynamic Data Overview

You may want to print labels on which data changes for each label, for example, counters, serial numbers, date and time, weight, article pictures… To accommodate the changing data, the labeling application can easily be used to format labels using variable data, special functions on variables, and databases.

There are several types of variables you can choose, and functions, which you define, to best suit your needs. Data that must be printed as a variable is prepared at the time of printing, and can be entered in the program from different sources i.e. keyboard, databases, system clock, etc. The variable data can be the same for a quantity of labels or/and specific for one label only.

To understand how variable data is handled, a few terms must be explained: variables, functions and database access.

Variables

Variables in this labeling application are much like ordinary variables; they simply don't have constant value. The basic idea of variables was to allow you to type the variable value just before printing the label, but this has expanded a lot. You can now automatically get correct value from a database or perform a calculation on existing variables and take the result as a variable value.
A variable also has several properties: its name, type (text, numeric, date…), maximal length of value in characters and many more. One other important, but fixed property is the input for specific variable (keyboard, database, function, system clock…).

**Functions**

Functions are very powerful tool, which offers almost unlimited possibilities to the user, when processing data for the label. The function takes some variables as input, make some processing on the data, and return the result in one or more variables that contain new values. Complexity of function varies from simple concatenating of two variables to very complex manipulation of external data.

For example, you can use functions to concatenate two strings of data to one if they are separate in database like FIRST\_NAME+LAST\_NAME. You can also do numeric calculations on variables. That way you can for example have the weight on a label displayed in pounds, although the weight in database is in kilograms. Using the built-in Visual Basic scripting you can add any functionality to the labeling software you can possibly need.

**Database access**

If you have existing database on your computer (or network) you can use that database to print labels. Simply create a special database function that gives you variables you can use to access the specific records in your database. That way you can completely automate the process of printing the labels for your product.

For example, as new products are created, you fill a special table with serial numbers of those products. The application then uses this table as source to print appropriate labels.

**Contents Providers**

**Contents Providers**

**Contents Provider** is an expression for any method that can be used as an source of data for objects on the label. It is applicable to all label objects that can have some sort of data associated with them (Text, Text box, Rich text box, Bar code and Picture).

The contents provider for objects can be one of the following:

<table>
<thead>
<tr>
<th>Fixed</th>
<th>When you select Fixed, you can enter a desired value in the edit box. This value will remain the same on each label. To edit the text, all standard Windows editing features (cut, copy, and paste) can be used. If you need to enter some special character, that is not accessible via keyboard, click the button with the arrow to the right of the dialog box. You can also right-click anywhere in the edit box and select &quot;Insert special character&quot; from the menu.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable</td>
<td>When the Variable option is selected, you can connect any variable field to the object, just select the appropriate variable name from the</td>
</tr>
</tbody>
</table>
Designing Labels

<table>
<thead>
<tr>
<th>Functions</th>
<th>When this type of contents provider is selected, you can select the proper function from the list of defined functions and then also the output function-generate variable. This variable will be the source of data for the object. Click New to create new function. Click Edit to change function's properties.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database</td>
<td>When this type of contents provider is selected, you can select the proper database from the list of defined database connections. Then select the proper field from this database. This field will be the source of data for the object. Click New to create connection to new database (click Wizard to use the wizard for the connection). Click Edit to change function's properties.</td>
</tr>
<tr>
<td>Expression</td>
<td>Expression is an simplified version of Visual Basic Script. Expression can be used in situations when you want to manipulate existing variables, extract some sub-string or perform a quick calculation and you do not want to write a dedicated Visual Basic script. For this purpose Expression will do just fine. You can enter one-line expression in the edit field that will be validated at print-time. Of course all Visual Basic scripting commands can be used in here.</td>
</tr>
<tr>
<td>Visual Basic Script</td>
<td>An entire Microsoft Visual Basic Script functionality can be included on the object. Each object can have assigned its own programming script for advanced functionality. Visual Basic Script option will allow you to use a complete implementation of Visual Basic programming scripting, provided by Microsoft Corporation. This makes it possible to perform advanced data manipulations, comparisons and calculations directly</td>
</tr>
</tbody>
</table>
on the label. If you are not familiar with Visual Basic scripting, a comprehensive help system is accompanying the labeling application. To access is, click the VB Script Help file. Once your script is written, it will be check for the consistency and syntax errors and you will be notified of the exact positions of any possible error for easier problem solving. There is one thing you have to pay special attention to: your script has to define an output variable `Result`. The value of variable `Result` is output of the function and is used for setting of Visual Basic Script variable.

For more complex scripts click the Build script button to edit your code in Expression Builder.

<table>
<thead>
<tr>
<th>Link to File</th>
</tr>
</thead>
<tbody>
<tr>
<td>The value for the label object is acquired from the specified text file in this case. The contents of the file is used for the object. You can link the object to some fixed filename on the disk. Or you can use variable filenames. To achieve that connect the object to the variable containing the path and filename of the file.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lookup Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lookup Table is a facility for the user to simplify working with data tables. Although the software can interact to any database, sometimes there is a need only for one quick simple table that stores your data. Lookup Table provides a shortcut to database usage. Lookup Table is used when you want to use a data from a simple database on your label. You can use some external databases as data source for all variable fields. But Lookup Table greatly simplifies this task. It is in fact a table stored within the label file. Built-in database editor can be used to manage the data records. Every Lookup table can have a Key (Primary) and Secondary Key that are used for actual data query. Using these keys you can make a query into the table and extract only fields that comply to the condition. Both keys can be either fixed or get a value from some variable. When the record from the table is found based on information from one or both keys, the value of the database field selected in Output fields is returned as the object contents. The object on the label now has its value from the database. The button Configure tables will let you manage your Lookup Tables.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ASC (FACT)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASC (FACT) is used when you want to encode the data using this standard for Data Identifiers (DI). It is much like GS1-128 (EAN.UCC 128) standard and its Application Identifiers (AI).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>HIBC</th>
</tr>
</thead>
<tbody>
<tr>
<td>There is the ability to encode data in the object using HIBC standard.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Rich Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>This contents provider is available only for RTF object. It provides</td>
</tr>
</tbody>
</table>
### Editor

You with the RTF editor, where you can define the fixed or variable contents for the object.

### Structured RSS bar code

This contents provider is available only when using RSS type of bar code. It provides you with the functionality to provide linear and composite (if applicable) data to the bar code.

### RFID Tag Contents

This contents provider is available for text and bar code objects. It is available when you have RFID-aware printer driver connected to the label and the printer can extract part of the RFID encoded data and print it on the label.

Two types of data are usually available:

1. **The Unique Tag ID**
   
   It is the number that is programmed in the RFID tag during the manufacturing process. The number is unique and usually cannot be changed.

2. **RFID Tag Data**
   
   Any part of the tag data can be extracted.

The printer will read the data from the tag, remember the value and use it with the text or bar code objects on the label. The data is never returned to the labeling software, but is handled internally in the printer.

**Note:**

The text or bar code objects to which you assign the value from the RFID tag must be formatted as printer internal objects. Format the text object with some internal printer font. Select the bar code object to print as internal printer object, not as graphics.

For on-screen previewing purposes you can enter some data into the **Preview** edit field.

---

**Working with Variables**

**Using Variable Wizard**

**Variable wizard**

The variable wizard simplifies and speeds up the creation of the most common types of variables. You cannot however set the advanced options in variables. These can only be set in a Variable dialog box.
Variable Wizard - Choosing the type of variable

First you must type in the variable name and select the type of variable. You can chose among:

<table>
<thead>
<tr>
<th>Variable Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyboard input</td>
<td>The value of the variable will be typed in before printing.</td>
</tr>
<tr>
<td>Counter</td>
<td>The variable will automatically increment when the labels are printed.</td>
</tr>
<tr>
<td>Date field</td>
<td>The value for the variable will be current date (optionally with offset).</td>
</tr>
<tr>
<td>Time field</td>
<td>The value for the variable will be current time.</td>
</tr>
</tbody>
</table>

Generic variable name based on the type of a variable field selected will be auto-generated, but you should change it to a more descriptive name. Use the name that will clearly on first sight determine the contents of this variable.

When all data, that wizard needs are provided (you click the Finish button), the text with variable content will be inserted at the specified point of the label. You can later edit the text object and variable itself just as any other text and variable on the label. See Text command and Variable dialog box above for further information.
Variable Wizard - Keyboard input

Use this variable type when you want the operator to enter a value of the variable from the keyboard before printing the specified numbers of labels.

Dialog box for Variable Wizard when Keyboard input option is chosen

**Prompt text for this variable field:** Fill in the message that will be shown to the user when he will enter the values for the variable field.

**Format:** Select the format of data you allow to be entered for the variable field.

**Set maximum number of characters:** Define the maximum length of characters that can be entered for the variable field.

Variable Wizard - Counter

On this page of the variable wizard, you define the counter variable.
Dialog box for Variable Wizard when Counter option is chosen

**Starting Value:** Set the starting value for the counter. The counter will increment or decrement from the starting value.

**Note:**
You can enter only digits for the starting value.

**Prompt for value before print:** Tick this option to enable entering the starting value of the counter when you start printing labels. Enter the text that will be shown to the user before printing.

The message will be shown on the screen each time when the label is to be printed.

**Set maximum number of digits:** Define the maximum length of digits the counter can occupy.

**Increment or decrement:** You can define that the variable value will increase from label to label, or decrease.

**Preview:** The field shows the preview of the counter, based on your selection.

Variable Wizard - Counter Continuation

**Step:** Define the step for your counter. The counter will increase by this number on every label.
**Change value every <n> labels:** Define the number of labels, when the counter will change the value.

**Rollover when reached:** Enter the value, when reached, will cause the counter to reset the value to the starting value.

Variable Wizard - Date Field

Define the properties of the date field. The variable field will get the value from a computer clock.

**Format:** Select the format for your date from the list. You can also enter the custom format.

**Date offset:** You can add a certain numbers of days, months or years to a current date and print that date instead of the current one.

**Preview:** The printer will print the date as shown on the Preview field. This way you can see how the selected date format will look on the label.

Variable Wizard - Time Field

Define the properties of the time field. The variable field will get the value from a computer clock.
Dialog box for Variable Wizard when Time field option is chosen

**Format:** Select the format for the time from the list. You can also enter the custom format.

**Preview:** The printer will print the time as shown on the Preview field. This way you can see how the selected date format will look on the label.

**Available Data Types**

Here you can define the input format and output format of the variable.

Supported format types are:

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>This format is used when you don't need any special format.</td>
</tr>
<tr>
<td>Date</td>
<td>This format is used to insert the date. Input and output pictures can be set. Allowed values for input are shown in drop-down list. More on date inputting can be found in section Variable Wizard - <a href="#">Date Field</a>.</td>
</tr>
<tr>
<td>Time</td>
<td>This format is used to insert the time and is similar to date inserting. More on time inputting can be found in section Variable Wizard - <a href="#">Time Field</a>.</td>
</tr>
<tr>
<td>Floating Point</td>
<td>This format is used to insert large numbers. This type enables you to put comma and points in the right places.</td>
</tr>
</tbody>
</table>
Money | This format lets you choose the currency unit, and put it on the correct place.

Pick List | This format enables you to define a list of values for the input values. Entered entries in the pick list are available to the user in the combo box that is displayed when the label is printed. The user can select one of the pre-defined values.

Binary | This format enables the insertion of a binary value on the input. The output is ASCII character.

**Available Date Formats**

The date fields can be printed in various formats. In this field you define, how the date will look. You can select some of the predefined date formats or enter you own. When defining the formats, the following notation is used:

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>D</td>
<td>Number of the day in a month. Can occupy one or two characters.</td>
</tr>
<tr>
<td>DD</td>
<td>Number of the day in a month. Always occupies two characters. (leading zeros will be added as necessary).</td>
</tr>
<tr>
<td>M</td>
<td>M is number of the month. Can occupy one or two characters.</td>
</tr>
<tr>
<td>MM</td>
<td>MM is number of the month. Always occupies two characters.</td>
</tr>
<tr>
<td>YY or YYYY</td>
<td>The year as 2 or 4 digits number.</td>
</tr>
<tr>
<td>DDD</td>
<td>Abbreviation of the day of week name.</td>
</tr>
<tr>
<td>DDDD</td>
<td>The full day of week name.</td>
</tr>
<tr>
<td>MMMMM</td>
<td>The full name of the month.</td>
</tr>
<tr>
<td>MMM</td>
<td>The abbreviation of the name of month.</td>
</tr>
<tr>
<td>J</td>
<td>The number of days since 1. January. Can occupy from one to three characters.</td>
</tr>
<tr>
<td>JJJ</td>
<td>The number of days since 1. January. Always occupies three characters.</td>
</tr>
<tr>
<td>W</td>
<td>The week number in current year. Can occupy one or two characters.</td>
</tr>
<tr>
<td>WW</td>
<td>The week number in current year. Always occupies two characters.</td>
</tr>
</tbody>
</table>

Any other sequence of characters will be displayed unchanged. This way you can insert dots, commas and other characters needed to properly write the date.
**The examples:**

<table>
<thead>
<tr>
<th>Format</th>
<th>How the date will look</th>
</tr>
</thead>
<tbody>
<tr>
<td>D/M/YYYY</td>
<td>10/3/2005</td>
</tr>
<tr>
<td>DD/MM/YY</td>
<td>10/03/05</td>
</tr>
<tr>
<td>DDDD, D. MMMM YYYY</td>
<td>Thursday, 10. March 2005</td>
</tr>
<tr>
<td>JJJWWYYYY</td>
<td>069102005</td>
</tr>
</tbody>
</table>

**Available Time Formats**

The time can be printed in various formats. In this field you define, how the time will look. You can select some of the predefined time formats or enter you own. When defining the formats, the following notation is used:

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>h</td>
<td>Hours in 12-hour format (AM/PM will be added if they follow the time). Can occupy one or two characters.</td>
</tr>
<tr>
<td>hh</td>
<td>Hours in 12-hour format (AM/PM will be added if they follow the time). Always occupies two characters. (leading zeros will be added as necessary).</td>
</tr>
<tr>
<td>H</td>
<td>Hours in 24-hour format. Can occupy one or two characters.</td>
</tr>
<tr>
<td>HH</td>
<td>Hours in 24-hour format. Always occupies two characters.</td>
</tr>
<tr>
<td>mm</td>
<td>Used for minutes.</td>
</tr>
<tr>
<td>ss</td>
<td>Used for seconds.</td>
</tr>
</tbody>
</table>

**The examples:**

<table>
<thead>
<tr>
<th>Format</th>
<th>How the time will look</th>
</tr>
</thead>
<tbody>
<tr>
<td>h:mm {AM/PM}</td>
<td>8:25PM</td>
</tr>
<tr>
<td>H:mm</td>
<td>20:25</td>
</tr>
<tr>
<td>hh:mm:ss</td>
<td>08:25:36</td>
</tr>
</tbody>
</table>

**Changing the Order of Entering Prompted Variables**

When you are using variables, value has to be assigned to them before printing. And one way of doing this is by using prompted variables (other are counters, functions, databases, ...). You are asked for the value of every prompted variable before every
printing. Then you fill in the values. The order in which you are entering the values may or may not be the order you want. If it is not it's probably the best solution, to change it.

The order can be changed in Variables dialog box.

1. Click Variables in Data menu to display a dialog box. All variables you are using are listed here alphabetically.
2. Click the button 1, 2, 3, ... in the lower right part of the dialog box.
3. Prompt order dialog box pops up. This is where you can change the order in which you are entering values to variables. Select the variable from the list on the left and roll it to appropriate position using buttons Up and Down. Repeat the procedure for every variable, that needs its position changed.

Creating a Prompted Variable

1. Create a new variable. Instructions for this step can be found in how-to topic Create a serial number, counter.
2. Name the variable "Prompted". Set the length of the variable.
3. Go to the Prompting tab.
4. Type in the Display this text to the print operator field the content "Please enter a value".
5. If you want to be prompted for every label that is printed, change setting to Every to 1.
6. If you want the variable to have a default value, go to the Prompting tab. If you do not want to be prompted for value at print time, change the mode to Do not prompt for value. The variable will behave like a constant.
7. Press the on OK button and link the variable with text or bar code.

Creating a Serial Number, Counter

The easiest way of creating new variable is using Variable Wizard.

1. Click the arrow button in the button on variable toolbar to start Variable Wizard
2. From drop-down menu select Counter as the type of the variable, set the name of the counter and click Next
3. Type in Starting value and you are finished with setting up this simple counter.

However, using Variable Wizard you are also capable of changing other properties of the counter: prompt for value before printing, maximum number of digits, step of incrementing/decrementing and much more.

The other method of creating counter is by creating a new variable directly (not using the Wizard) and then setting its parameters appropriately:

1. Click on the button New variable on variable toolbar or
2. Click command Variables in menu Data and press New button.
3. Name the variable e.g. "Counter". Set the length of the variable. Go to the Serialization tab of the dialog and set the parameters:
Designing Labels

- Incremental/decremental counter
- Step - value of the variable will be increased in steps
- Change value after the number of labels

If you want to make counter filled in with leading zeroes, do the following:

1. Go to the **Data Processing** tab.
2. Set **Position relative to the variable value** to On left.
3. Type 0 for the **Character**.

If you want the variable to have a default value, do the following:

1. Go to the **Prompting** tab.
2. Enter the value into the Default value field.

**Note:**
If you do not want to be prompted for variable value at print time, change the option **Prompt** to Do not prompt for value. The counter will always start counting from the default value.

Press on the **OK** button and link the variable to text or bar code.

### Make a Counter that Preserves Last-used Value

Counter which preserves last-used value is applicable in cases when continuing of numbering from last label production is required (e.g. serial number). The last value of the counter that was used on the label is stored and the numbering is continued from this point at next use.

1. Create a new variable. Instructions for this step can be found in how-to topic [Create a serial number, counter](#).
2. Name the variable e.g. "Counter". Set the length of the variable and Format to **Numeric**. Go to the "Increment" page of the dialog and set the parameters:
   - Incremental/decremental counter
   - Step - value of the variable will be increased in steps
   - Change value after the number of labels
3. Go to the **Prompting** tab, select the option Prompt and enter the Default value you want to use as the starting value for the counter.
4. Then tick the option **Remember last used value (dynamic value)**. This will enable the counter to remember the last used value.

**Note:**
The counter which preserves last-used value cannot be made with Variable wizard, but only using dialog for adding new variables.

The last used value is stored in the same folder, where the label is. The file extension with last used value is .DVV, the filename is the same as the label.

Last-used values are stored in the external text files in the same folder where the label resides. The external files have the same filename as the label file, but the extension .DVV. The label file does not have to be saved to store the dynamic values. If you use labels with dynamic values and exchange them with other users, make sure to
exchange not only label files (.LBL) but also files with last used dynamic values (.DDV).

**Note:**
If you want to use the counter that remembers last-used value, you must have the permissions to write in the folder with the labels.

This type of a counter will remember the last value that was used for it on this label. If you want to share the same counter on many labels and it should progress no matter which label is printed, look at the **global variable**. It too can remember last-used value and can be used on different labels.

### Global Variable

Global variable is a type of variable that can be used on many different labels. Once it is defined, it is stored outside the current label so it is available for any other label as well.

Its last value is stored even after closing the label file and exiting the application. It is useful when continuing of numbering from previous printing is required. Values of global variables are stored in a separate file on disk GLOBALS.TDB.

The location of the folder is C:\Documents and Settings\All Users\Application Data\Euro Plus d.o.o\NiceLabel5\System.

Global variable is an advanced option for power users, and is not available in the Variable wizard. Global variable can only be created manually in the Variable dialog box. Make sure to select Global as the **Source** for the variable in the General tab.

If you copy your label file, which uses global variables to another computer, you have to copy the file GLOBALS.TDB to the new computer as well. If you miss this step, then the labeling application won't find appropriate global variable and will notify you of this situation. At the same time a substitute global variable will be created, but last value of old variable will not be known, nor will the correct variable properties be restored. Check the settings of substitute global variable and change them appropriately to suit your needs.

The same global variable is not limited for use on only one label. You can use it on as many labels as you like. Please note, that only one label, using the same global variable, can be printed at a time. When using global variables, they are locked for one label and this prevents more labels to use the same global variable at the same time.

### Groups of Allowable Characters

The format of a variable is selectable to filter the input data. This helps avoiding mistakes when entering data. You can only enter characters, which are included in the specified format range.

<table>
<thead>
<tr>
<th>All</th>
<th>Select this format when there is no need to limit the variable data. For example: one variable can be used to define changes in the</th>
</tr>
</thead>
</table>
### Designing Labels

You can enter all characters from the keyboard.

<table>
<thead>
<tr>
<th>Numeric</th>
<th>Use this format you need numeric variables, for example, serial numbers or EAN and UPC bar code. Only numeric characters in the range 0 to 9 can be entered.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alphanumeric</td>
<td>Use this format when numbers and characters are mixed in the same variable - for example, identity codes... Characters from 0 to 9, a to z and A to Z can be entered.</td>
</tr>
<tr>
<td>Letters</td>
<td>Use this format when you need the character variable.</td>
</tr>
<tr>
<td>7-bit ASCII format</td>
<td>The variable will contain only characters with ASCII code from 0 to 127.</td>
</tr>
<tr>
<td>Hex</td>
<td>Use this format to allow input of hexadecimal numbers.</td>
</tr>
<tr>
<td>Date</td>
<td>Use this format to print date stamp.</td>
</tr>
<tr>
<td>Time</td>
<td>Use this format to print time stamp.</td>
</tr>
<tr>
<td>Digits and Capitals</td>
<td>Use this format to limit the usage only to digits and capitals of English alphabet.</td>
</tr>
<tr>
<td>CUSTOM</td>
<td>You can define your own data format. The allowable characters can be defined in the Serialization tab.</td>
</tr>
<tr>
<td>&lt;printer family name&gt; FORMAT</td>
<td>Use this formats do enable usage only of characters that are allowed in the internal fonts of the currently selected printer.</td>
</tr>
<tr>
<td>Code 39, Code 128A, Code 128B, Code 128C, Code 128, Codabar</td>
<td>Use this formats to enable usage only of characters that are allowed by these bar codes standards.</td>
</tr>
</tbody>
</table>

### Internal Variables

Internal variables are filled automatically by the software and you do not have any influence on them. They cannot be edited and modified, but only used in the functions and on the label. Their value is updated for every printed label.

Internal variables are represented with the 📡 icon so they can be easily distinguished from the other types of variables.

The list of available internal variables:
<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ComputerName</td>
<td>Contains the information about the computer name of a PC computer where labels are processed, as specified from Windows system.</td>
</tr>
<tr>
<td>CurrentBatchQuantity</td>
<td>Contains information about the label quantity reached in the current label batch. The value is reset at beginning at each batch in the printing process.</td>
</tr>
<tr>
<td>DefaultPrinterName</td>
<td>Contains the name of the default printer on the system.</td>
</tr>
<tr>
<td>LabelFileName</td>
<td>Contains full name of the current label, including the path to the file.</td>
</tr>
<tr>
<td>LabelPrinterName</td>
<td>Contains the name of the printer that is used on the label.</td>
</tr>
<tr>
<td>RequestedQuantity</td>
<td>Contains the quantity of the labels as specified by the user or external application.</td>
</tr>
<tr>
<td>ShortLabelName</td>
<td>Contains the name of the label without the path. Only filename with the extension LBL is available.</td>
</tr>
<tr>
<td>SystemUserName</td>
<td>Contains the name of the system Windows user that is logged in and is running the application.</td>
</tr>
<tr>
<td>TotalQuantityPrinted</td>
<td>Contains the quantity of all unique labels printed. Label copies are not included in this variable, only the number of different labels is.</td>
</tr>
<tr>
<td>UserName</td>
<td>Contains the name of the user that is logged in and is using the application. This variable has some value only when you have enabled user management in the software.</td>
</tr>
</tbody>
</table>

**Types of Variables**

Each type of variable has its own icon to easier distinguish variables among each other. The icon in front of the variable name determines its type.

The available types of variables are:

- ![System Date/Time variable](image)
- ![Printer Date/Time variable](image)
- ![Counter variable](image)
- ![Counter variable with enabled Dynamic Value](image)
- ![Prompt variable](image)
Using Printer Internal Increment Counter

Almost all thermal printers offer internal increment counter. This is a special printer counter that counts labels internally. The printer only receives the first value of the counter and then automatically increments the counter in steps of 1 on the subsequent labels. Using this option reduces the amount of data transferred between computer and printer as only start value is sent to printer. This can significantly speed up label production.

1. Create a new variable "Counter". Instructions for this step can be found in the topic [Create a serial number, counter](#).

2. To use counter as internal printer element please pay attention to the following settings:
   - The variable's maximum length is limited by your printer. You should find this value in your printer's Owner Manuals. If you cannot find this value, experiment.
   - The variable length has to be set to Fixed.
   - The variable format has to be set to Numeric.
   - The text object linked to the variable must be formatted in the internal printer font.
   - Tick the option Use printer internal counter in the Contents tab of the Text element's dialog box. This option is available only if the counter variable has been set up properly.

3. There should be two symbols in the lower right corner of text box. The first one tells that this text will be printed in internal printer font. The second one tells that this counters is internal printer increment counter.

Using Variable Quantity

Variable Quantity is a special variable in the label. You use this variable, when you do not know exact number of labels for printing. Using this variable, you can enter the number of labels to print during printing itself.

**The example:**
You have a label of a product. Already defined variables are "Name" and "Price".
We want to print labels as follows:

- Enter Name and Price values
- Enter quantity for this product
- Print
- Start with new product.

Do the following:

1. Create new variable, named "Quantity".
2. Tick the option **The variable value is used as label quantity** in the **General** tab.
3. Edit variables "Name" and "Price". Go to the Prompting tab (assuming, the variables are already defined as prompted variables).
4. Change the **Prompt** setting to Based on variable quantity.

When you start printing labels, the quantity parameter in the print dialog is already set to **Variable quantity (defined from label variable)**.

**Working with Functions**

**Defining a Function**

Define a Function

When you want to define the first function, the list of functions will be empty and, you must click the **New** button to define the function. The Function dialog box is then displayed.
Function dialog box – General tab

This dialog box is also displayed when you want to change the existing function. To define (change) the function all required parameters must be entered and confirmed by clicking OK button.

Dialog box has several pages – tabs. Note that only General tab is fixed, all other tabs change according to the function type you select on General tab. Each other tab is described separately for each function.

**Using Functions to Manipulate Label Data**

Using Functions to Manipulate Label Data

The labeling software enables you to work with variable values on the label, manipulate the values and use them with other label objects. The labeling software offers a group of functions that help you work with the variable values. There is always some input to the function that the function manipulates and always some output that is stored to a function-generated variable. The function-generated variable can be linked to label objects or used in other functions.
There are many functions available, such as Concatenate (for linked fields), Subset, Date addition, FACT, HIBC and Visual Basic script. Visual Basic script is a powerful function allowing you to perform advanced data manipulation.

Using Concatenate Function

The concatenate function merges two or more variables into one new variable. To create a concatenate function, do the following:

1. Click on the button in the Standard toolbar or select Open in the File menu. Select the label file ID_CARD.LBL from the sample folder. The label has a link to the database so you see how the concatenate function operates on a set of records.
2. Select the command Functions in the Data menu.
3. There is already one function defined in the label. Ignore it and click on the New button. The dialog box with the properties of the new function will open.
4. In the General tab type 'My Concatenate function' for the name for the function.
5. Select the Concatenate function from the list of functions.
6. Click on the Detailed tab to define details for the function. Look at the top of the dialog box. The left side contains the available variables defined on the label.
7. Select the variables ID and NAME. Note that they have appeared in the right list box.
8. The name of the output variable is 'Concatenate' and delimiter is set to 'None'. Click on the OK button.
Definition of the Concatenate function

9. Click on the **Close** button to close the Functions dialog box.
10. The function-generated variable is defined on the label. You should link it to a text object on the label.
11. Click on the small arrow next to Text Object in the Toolbox.
12. Click on the option Use existing variable and select the variable Concatenate.
Selecting the function-generated variable Concatenate

13. Click on the label where you want to place the text object. The text object is linked to the new variable Concatenate.

The values of variables 'ID' and 'NAME' are merged and saved to the function-generated variable 'Concatenate' every time the label is processed for preview or print.

Using Visual Basic Function

Visual Basic function allows you to perform the most demanding and difficult data manipulation on the label. Available are all the functions, procedures and operands from Microsoft Visual Basic script. Your script can take values from all label variables, work with the values and save the result in a function-generated variable.

To create a visual basic function, do the following:

1. Click on the button in the Standard toolbar or select Open in the File menu. Select the label file ID_CARD.LBL from the sample. The label has a link to the database so you see how the concatenate function operates on a set of records.
2. Select the command Functions in the Data menu.
3. There is already one function defined in the label. Ignore it and click on the New button. The dialog box with the properties of the new function will open.
4. Type in the name for the function, for example 'My Visual Basic function'.
5. Select the Visual Basic Script function from the list of functions.
Select the Visual Basic Script option

6. Click on the Detailed tab to define properties for the function. The variable NAME on the label provides the first and last names of the person. The Visual Basic script should break them apart and use only the first name as the result of the function.

For the Visual Basic script enter the following code:

```vbscript
Dim Spc
Spc = InStr(NAME, " ")
if NAME <> "" then
Result = Mid(NAME, 1, Spc-1)
end if
```

The above script will search for the first space in the variable NAME and save all characters until this space character as a result.

**Note:**
Refer to the online help or User Guide for more information about Visual Basic Script functionality.
7. The result from the Visual Basic Script function is automatically stored in the function-generated variable (VBScript1) every time the label is processed for preview or print.
8. Click on the **OK** button.
9. Click on the **Close** button to close the Functions dialog box.

To link the function-generated variable VBScript1 to an object on the label, do the following:

1. Click on the small arrow at the right end of the Text object. Click on the option **Use existing variable** and select the variable VBScript1.

![Selecting the function-generated variable VBScript1](image)

Selecting the function-generated variable VBScript1

2. Click on the label where you want to place the text object. The text object is linked to the new variable VBScript1.

Every time the label is processed for preview or print the Visual Basic script will recalculate the result and store it in the function-generated variable VBScript1.

**Note:** Visual Basic script is capable of handling Unicode-encoded values. If you use multilingual values on the label (typically for chemical labels), you can manipulate the values in Visual Basic script.

---

**Working with Databases**

**Using Database Wizard**

Using Database Wizard

Process of defining a new Database access function consists of four steps (pages). On those pages you enter the data required by Wizard. You can go to the next step (page) by clicking **Next** button or return to previous with **Previous** button.
When all data needed has been entered, **Finish** button will become available, allowing you to complete the process of defining a new Database access function. Note that some options have predefined values, so you don't really need to go through all the steps of a wizard.

Selecting Database File

[Database and Table dialog box]

Enter the full path name of the database file in edit box or use Browse button to find the file on your computer.

Note that you can only select databases that are stored in files. If you use databases via ODBC or OLE DB drivers, you will have to set that manually in **Database** dialog box.
Selecting Desired Fields

Database wizard – Selecting fields

On this page you can select the fields you want to use on the label. All fields in a table are selected by default, but you will probably want to de-select some of them, especially if you have large table. Variable will be created for each selected field and can later be attached to objects.
Selecting Which Records will be Printed

Select the desired option how you want to use the records in the database. By default the option I want to print all records from the table is set and all records in a table will be printed one at a time. Each record will be printed only once.

If you do not want to print the entire database, you can select which records should be printed. In this case select the option I want to select which record to print. Prior printing you will be shown a dialog box with all records from the database. Then you will be able to select which records should be printed.

By default records are used once for a single label. If you would like to print several copies of a label with database data, you can define it in the second part of this step of the Wizard.

A field in table contains quantity to print option will let you chose some field in the database. This field has the information about the quantity of labels for each record.

For example:
You have database with records of your products. It contains a field with a numeric value, where the required number of label copies is stored. Select this field and let the application print the quantity of labels specified here.

I will enter print quantity for each record: This option is only accessible if you have defined to select which records should be printed. Prior printing you will be able
to select which records will be printed in the selection dialog box. At the same time you will be able to type in the exact label copy for each selected record.

Selecting Variable Quantity from the Database Field

Select a field in the database that contains the label quantity information. The database record will be printed on as many consecutive labels as the selected field contains.

Note:
Make sure to select the field that has been formatted with the numeric data.

Adding the Fields to the Label

Database wizard – Adding fields to the label

On this page you specify if you want the wizard to generate text objects on the label that are already linked to the corresponding fields in table. Text objects are created in upper left corner of a label, but you can later move them to another position.
Finishing the Process with Database Wizard

The summary of tasks you have completed will be shown in the last step of the Wizard. If you are satisfied with your selection, click Finish to complete the process of creating a new database access function.

## Linking Label to Text Databases

### Overview

Text databases are text files containing data values that can be used for variable objects on the label. The text database is not a real database. It contains the data values but lacks the information of the data structure, name of the fields and maximum lengths of the fields. You have to provide the missing information before the labeling software can use the data from such a text database.

The label in design mode (on the left) and preview of the five labels with data from the database

### Connect to a Database

The labeling software offers a Database Wizard that guides you through the necessary steps to connect the database to a label. To connect your label to a database using the Database Wizard, do the following:

1. Click on the Database button in the Standard Toolbar.
2. Click on the Browse button and point to the text database "c:\Program Files\EuroPlus\NiceLabel 5\Samples\Database\data.txt".  
   Note: Your labeling software might not include the text database sample.
Selecting the text database

3. Click on the Next button.

**Note:**
If you connect to the database for the first time, you need to define the database structure. Continue with the next section.

Format the Data with the Text File Wizard

Because the text files do not contain the structural information like real databases do, you must define the fields and their data structure. When you use the same text database some other time, you won't have to define the structure again.

1. Select the encoding of the data in your text file. The encoding selection is important when your file has multi-lingual contents (Unicode data). If in doubt what to use, first try the option **Automatic detection**. Refer to the preview, it must display to correct values.
Defining the file encoding

2. Choose the data type for the selected text database. The fields are aligned in columns, so you must select the option **Fixed**.
Defining the type of the text database

3. Click on the **Next** button.
4. Define the widths of the individual columns by placing a break line before the second column and before the third column.

![Data preview table](image)

5. Click on the **Next** button.
6. Accept the default field names and click on the **Next** button.
7. Review the text database structure. The field names and their maximum lengths are displayed. Click on the Finish button to close Text File Wizard.

The link to the database has been created and database fields are available on the label.

The labeling software brings you back to the Database Wizard.

**Place Database Fields on a Label**

The next step in the Database Wizard opens the dialog box with the list of available fields from the database.

1. By default all fields from the database will be used on the label. Click on the Next button.

![Select fields](image)
Using all fields in the text database

2. Specify what records and how many you want to print:
   Select the options **I want to select which record to print** and **I will enter label quantity for each selected record**. Before printing labels, the table with the records will open and you will be able to select the records you want to print and the quantity of labels for each record.

   - Select which records do you want to print.
     - I want to print all records from the table
     - I want to select which record to print

   - Specify how the label quantity information is defined.
     - Print one label for each record in the database
     - One field in the table contains the label quantity information
     - I will enter label quantity for each selected record

Specifying which records from the database will be printed and in what quantity

3. Click on the Next button.
4. Select if the Database Wizard should link all selected fields from the database to the text objects on the label or if you want to link the fields manually to the label.
5. Click on the Next button.
6. Select **I want a text object for each selected field** and click on the Finish button.

   - Define how you want the selected database fields to be used on the label:
     - I want a text object for each selected field
     - I will link the database fields to the objects myself later

Each field from the database will be linked to a text object

The label will show several text objects. Every field from the database is linked with the text object on the label.

Use Print Preview to Select Data and View a Label

Now you will simulate label printing using print preview.

1. Click on the print icon in the Standard Toolbar.
2. The Print dialog box opens with the Quantity of labels set to **Variable quantity (entered for each database record)**. This setting corresponds to your selection in the Database Wizard when you have selected the options **I want to select which record to print** and **I will enter label quantity for each selected record**.
Only the records you select will be printed in the defined quantity.

Print / Print preview dialog box

3. To choose which records to print from the database click on the **Select Records** button. The **Record Selection** dialog box will open.

4. Select the records from the database you want to print and enter the number of labels you want to print for each selected record.

Record selection dialog box
5. Click on the OK button. You will return to the Print dialog box.
6. Click on the Preview button. Now you can preview the labels on the screen. Note that the text objects on the label change for each new record.

7. Click on the Next button in the command window to advance to the next label in the series. After you see the last label in the preview series, the labeling software will re-open the Print dialog box.
8. Click on the Close button to close the Print dialog box.

Print a Label

When you are certain that the label design is correct and label preview shows the correct values from the database, you can start sending the labels to the printer. To print a label, do the following:

1. Click on the print icon in the Standard Toolbar. The Print dialog box will open (same as the print preview dialog box).
2. Click on the button Select Records and select the records you want to print and specify the label quantity for each record.
Selecting records and specifying label quantity

3. Click on the OK button.
4. Click on the Print button to start printing labels.
5. Click on the Close button to close the dialog box.

**Using Text File Wizard**

Text File Wizard

When the input database file is a plain ASCII text file or formatted CSV (Comma Separated Values), **Text File Wizard** will be started within Database Wizard and it will guide you through quick and easy steps of text data acquire. The main difference between real database and text file is in their data structure information. Databases include the whole information about their fields (names, data format, length) and can be automatically used with the application. Text files, on the other hand, do not have stored such information and you will have to instruct the application how the data is encoded.

When Text File Wizard finishes, it will return control back to Database Wizard, that will guide the rest of the way.

Choosing Data Type

Before you can use text file, you will have to define its data structure. Fields can be delimited by some sort of a separator (tab, semicolon, comma or some entirely user-defined separator) or can be of a fixed length.
Database Wizard – Choosing Data Type

Choose Delimited, if you know that data fields are separated with some special character. File preview at the bottom of the dialog box can be helpful, if you do not know exactly how the data is organized.

Choose Fixed if you know, that your data fields always occupy the same number of characters.

Start import at row option is useful, when you do not want to import some rows at the top of the file. Most usual situation, when you would want to use this option is when text file contains some header on top of actual data fields.
Setting the Fields

Database Wizard – Setting separator and delimiter

In the second step of the Text File Wizard you have to set the fields in the text file. If you have selected Delimited in the previous step, choose the appropriate separator here. The ones that are usually used with text files are already pre-defined. But if you require some other, there is an option to use a custom-defined one.

You can also select the Delimiter character that is used when separator character is used in the text field itself. The delimiter should be used to enclose such field. Text between two delimiter characters is treated as one field although it contains the field separator character.

The data preview in the bottom part of the dialog box will let you know if your choice of a separator character is a correct one. Fields will be separated with vertical lines, if a separator is valid.
Database Wizard – Setting column breaks

If you have selected that your data is formatted with fixed widths, the second step of the Wizard will be slightly different. Instead of selecting character for field separation, you will have to define field widths. The Wizard makes it as simple as possible. Use a mouse and draw a vertical line to the start positions of the fields. Lines will indicate where the new field starts.
Designing Labels

Formatting the Fields

Database Wizard – Formatting the fields

In this step of the Wizard you can review the fields’ names and lengths and modify them, if necessary. You will probably use more friendly field names, so you can distinguish between them more easily.

When you are finished with Text File Wizard, the structure information of the used text file is stored to a separate file with an extension of .SCH (Scheme File). If you will try to use the same text file some other time on a different label, you will be spared all efforts of structure creating. SCH file will be automatically used and Text File Wizard will be skipped entirely.

Note, that SCH file is created also with add-on database manager NiceData, when you open the text database in NiceData for the first time.

**Linking a Label to Advanced Databases**

Overview

You can use the labeling software to retrieve data from any database on your computer or network. If you have the appropriate database drivers, you can connect to the database and use the records on the label.

**Note:**
NiceLabel Express does not have all database options available. You can only use
data from text databases and Excel spreadsheets in (Undefined variable: Variables.Edition Express).

With the labeling software you can connect to any database type as long as you have the appropriate database drivers installed on your computer. The labeling software supports different database drivers like ODBC, OLE DB and BDE. Your computer comes pre-installed with database drivers for frequently used database types, but you can always install additional drivers.

You have total control over which records in the database table will be printed. By default all records are printed, but you also have the option to select the records for printing. Before the labels are processed you can select the records in the table that you want to print. You can also specify the print quantity for each record.

Advanced record selection techniques are also available in the labeling software. You can create database filters and obtain only the records that match the conditions. The same functionality allows you to join two or more database tables together and obtain values for the same product from multiple databases.

Manual modification of the SQL sentence is available for advanced users.

Link to a Database Using Database Wizard

1. Click on the button in the Standard Toolbar. The Database Wizard will open.
2. Select the option Direct database access and click on the Browse button. Use the option Direct database access, if you use file-based databases like Microsoft Access, Paradox, dBase, Excel or .TXT files.
Selecting the type of database connection

3. Point to the Access database c:\Program Files\EuroPlus\NiceLabel 5\Samples\Database\IDENTITY.MDB.
   Note: The database might not be included with your labeling software.

4. Click on the Next button. The next step Fields Selection of the Database Wizard will open.
   The dialog box will show all fields defined in the database table.
All fields defined in the database table are displayed

5. Leave the default settings and click on the Next button. A next step Records Printing of the Database Wizard will open.
6. Leave everything on a default settings in this dialog box.
   What this means is that all records from the database will be printed and each record is used on one label.
Select how the records from the database will be used on the label

Click on the **Next** button. A next step Fields Usage of the Database Wizard will open.

7. Leave everything on the default settings.
   The wizard will automatically connect all database fields to the text objects on the label.
8. Click on the **Finish** button.
   The Database Wizard will connect to the database, obtain the fields and make them available on the label as variables. The variables will be linked to the text objects.

**Link to a Database Manually**

The Database Wizard does not support your database if it is not listed in the direct database access or does not have an ODBC driver. In just a case you have to link your database to your label manually by doing the following:

1. Click on the button `Database` in the Standard Toolbar. The Database Wizard will open.
2. Select the option **Other databases (ODBC)**.
   Use this option, if you use server-based databases like SQL server, Oracle, Informix or some database not directly supported by the option **Direct database access**.
3. Select the available ODBC definition in the list.
4. Click on the **Define** button, if the connection to your database is not already defined.
5. The dialog box Database opens.
   Here you can define the connection to your database.

### Manual definition of the database connection

6. Click on the **OK** button.
7. Continue from the step 4 in the chapter **Link to a Database Using Database Wizard**.

### Print All Database Records

By default the Database Wizards sets up the database connection to print all records in the database. The Database Wizard step Records Printing is where you can define which records are printed.

To print all records in the database table follow the steps in the chapter **Link to a Database Using Database Wizard**.

**Note:**
To print all records in the database it is important to select the option 'I want to print all records from the table.' By default each record is printed once on the label.
Print Selected Database Records

You can define which records from the database you want to print in the Records Printing of the Database Wizard.

1. Follow the steps in the chapter Link to a Database Using Database Wizard until the step 5.
2. Select the option I want to select which record to print to be able to select which records are printed.

![Database Wizard](image)

You will be able to select which records are printed

3. Click on the **Finish** button.
   The link to the database is created and text objects linked to the variables are positioned on the label.
4. Click on **Print** to open Print dialog box.
   The button **Select Records...** becomes available.
5. Click on the button **Select Records...**
   The Record Selection dialog box opens.
6. Tick the records you want to print.
   You can select individual records or group of records by selecting the first record, press and hold the Shift key and then select the last record in the series.
Selecting of multiple records is only available when using real databases and not when using data from spreadsheets like Microsoft Excel or text CSV data files.

Selecting records for printing

Query and Create a Database Filter

The labeling software allows you to perform queries on the database table to extract only the records matching some condition. Please note that you have to enable record selection in the database properties to be able to query the database. To enable database filter, do the following:

1. Refer to the chapter Link to a Database Using Database Wizard. Follow the steps from 1 to 6.
2. Select the option I want to select which record to print.
3. Click on the Finish button.
   The link to the database is created and database fields are linked to text objects on the label.
4. Click on the Print button or select the command Print in the File menu.
5. Click on the Select Records button in the Print dialog box.
   Record Selection dialog box opens.
6. Click on the small arrow button next to the field names in the table and choose the condition.
Defining the filter by clicking the arrow button

You can display only the records that are equal to the selected value in the list or you can define your custom filter.

All records matching the condition will be filtered from the database and displayed in the table.

**Note:**
You can define conditions on multiple fields at the same time.

**Database Access**

Database access functions are functions used to retrieve data from the database.

The records can be obtained from the database using different approaches.

1. You can successively read record by record from the database and use them all on the label.
2. You can select records for printing.
3. You can define filters that will be used to retrieve just a subset of records from your database, that will comply to your conditions.

The result of the database access function is a set of variables, one for each selected field of database table. Each database variable is named the same as the database field, but has additional prefix of a database name. This allows you to quicker identify from which database table the variable comes from.

**For example:**
If you have a field name Product in the database table DBPROD, the resulting label variable will be named DBPROD.Product.

The labeling software supports all types database. The only condition is that you have the appropriate database driver installed in the Windows system. The labeling software can work with OLE DB, ODBC, BDE and other database drivers.

For connectivity to modern multi-lingual Unicode databases the OLE DB provider is available. Using this technology the Unicode values can be used on the label. These
are the data values in different codepages. You can use the tables with different language settings on the same label.

**Changing the Order of Database Records**

You can change the order in which the labeling software prints the records from the database table. By default the records are printed from the first one to the last one in order as they appear in the table (if you do not enable record selection feature).

To order records by one field from the database, do the following:

1. Connect the database table to the label.
2. Make sure the Database toolbar is visible, then click on the (Edit) button. The **Database Access** dialog box opens with **General** tab displayed.

   **Note:**
   If the Database toolbar is not visible, select Toolbars from the View menu, then click Database.

3. In the **Order** dialog box select the field, by which you want to sort the records. When you will print or preview the label the records are ordered by the selected field in ascending order.
4. Click **OK**.

To order records by multiple fields from the database, do the following:

1. Connect the database table to the label.
2. Make sure the Database toolbar is visible, then click on the (Edit) button. The **Database Access** dialog box opens with **General** tab displayed.

   **Note:**
   If the Database toolbar is not visible, select Toolbars from the View menu, then click Database.

3. Click on the **Advanced** button next to the Order combo box. The **Table Order** dialog box opens.
4. Look at the **Available fields** section. Select all fields by which you want to sort the records.
5. Look at the **Selected fields** section. Define the order or appearance of the fields.
6. Define the sort order for each field.
   When you will print or preview the label the records are first ordered by the first field in the list, then by the second field, and so on until the last field in the list.
7. Click **OK**.

**Quickly Editing Database**

Click the icon in the Database toolbar. The application NiceData will open the currently selected database.
Read Data from the Database

To read data from the database, create a new connection to the database using either of the two methods below:

- Click the "New database wizard" button in the Database toolbar
- Select Database access from Data menu and clicking on the Wizard button.

Follow the on-screen instructions until the Database Wizard finishes.

For every field in the table, you now have a text object on the label. Each database field is available as a variable on the label.

If your database type is not available in the Wizard or you want to use different driver (OLE DB provider) for connection to the database, you will have to use direct database set-up option and not the Database Wizard.

Using ODBC Databases

To be able to use ODBC databases, you first have to setup your ODBC drivers properly. You can do this in advanced by starting ODBC setup program in Control Panel and modifying Data Source Names (DSNs) to suit your database file locations. Or you can do the same thing from the labeling software.

Connection to already defined ODBC data sources can be done using the Database Wizard.

If data source is not defined in the system yet, you will have to use direct connection method and by pass the Wizard.

1. Open Database Access dialog box, then click the Define button in General tab.
2. In the list of database connection types first find the OLE DB drivers, then ODBC Data sources.
3. In the right side of the dialog box select already prepared data connection or create a new one.
4. Once you have the ODBC data connection prepared, select it and close the dialog.
5. The fields from the selected database can now be used on the label.

Creating Custom Check Digit

Creating Custom Check Digit

You can add new or edit and delete existing algorithms by clicking appropriate buttons. Algorithm's parameters are defined in Edit algorithm dialog box, which has following options:
Editing check digit algorithm

To understand all parameters, you must know, how check digit is calculated. First of all, we must have a numeric value and on top of that the check digit will be calculated. If weights are required, we will need them as well. Let's look at EAN13 check digit calculation:

Value: 123456789012
Weights: 1, 3

When starting calculating, each digit has its weight. When only two weights are specified, the third digit gets the first weight, the forth the second, and so on. If only one weight is specified, all digits have the same weight. According to Sum determination, we can use weights (sum of the products) or not (sum of the digits). EAN13 algorithm uses products, so we define Sum of the products.

The sum is: $1 \times 1 + 2 \times 3 + 3 \times 1 + 4 \times 3 + 5 \times 1 + \ldots + 2 \times 3$

When the sum is calculated, we take modulus parameter and divide the sum with that number and remember the remainder of division. This can already be the result.

If Result complemented is specified, we subtract the result from modulus and so we get the new value. When this value is less than 10, we already got check digit. If it is greater value (two digits), we take the whole value or just the least significant digit (One digit only) as the result of check digit algorithm.

**Special Characters**

**Using Special Characters**

Special characters are the kind of characters you usually cannot find directly on your keyboard. In spite of that, some of them can be typed in using combinations of Alternate and Control keys.
The problem usually does not appear with your language-specific characters (ä, í, ñ, ş, č, A etc), you can enter them directly on the keyboard or using Alt+<key_code> combination. Alternatively Windows utility Character Map can be used to find appropriate character and paste it to the label.

You might have problems using other kind of special characters. Sometimes there is a need to include a character with ASCII code below 32. These are so-called control characters. They cannot be normally entered to labeling or any other application. There is an alternative method of entering such characters, explained later in this topic.

There are several methods how special characters can be typed in to the labeling software.

**Entering characters with <#hex_code> syntax**

Another method of entering special characters is using the syntax <#hex_code>. The hex_code stands for a two-character mark in hexadecimal numerical system. The appropriate values go from 0 (decimal 0) to FF (decimal 255).

For example, <#BC> (decimal 188) would be the same as <FNC1>, as they both would encode the character with ASCII code 0188.

**Entering characters with Alt+<ASCII_code>**

This method is valid only for characters that are above ASCII code 32. A typical example would be FNC codes that are used to encode GS1-128 (EAN.UCC 128) bar code data. The labeling software will encode this type of bar code according to standards and normally you would not have to change anything about it. However, sometimes it is necessary to manually add such character to label data.

To include Function Codes just type in the appropriate character for Function Code. ASCII codes of Function Codes are as follows:

<table>
<thead>
<tr>
<th>Function Code</th>
<th>ASCII Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>FNC1</td>
<td>0188</td>
</tr>
<tr>
<td>FNC2</td>
<td>0189</td>
</tr>
<tr>
<td>FNC3</td>
<td>0190</td>
</tr>
<tr>
<td>FNC4</td>
<td>0191</td>
</tr>
</tbody>
</table>

To type in character for FNC1, press and hold down left Alt key, then type in digits 0188 on the numeric keyboard. Note the leading zero, it is mandatory. Release the Alt key and FNC1 character should appear.

These characters can be typed in directly using the keyboard.
Pre-defined Character Shortcuts

The labeling application has several control characters pre-defined and they can be selected from a drop-down menu in any dialog box, where a text input is enabled. Just look at the right side of the edit field and find a button with arrow. Click it for a list of all available shortcuts to pre-defined characters. The same list can be accessed with right-click on the edit field, where you select Insert special character. For example: FNC1 character can simply be encoded as <FNC1>.

If special characters you want to use on the label is not available in this list of shortcuts, consult additional input methods.

<table>
<thead>
<tr>
<th>ASCII code</th>
<th>Abbreviation used in the application</th>
<th>Description of the character</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>SOH</td>
<td>Start of Heading</td>
</tr>
<tr>
<td>2</td>
<td>STX</td>
<td>Start of Text</td>
</tr>
<tr>
<td>3</td>
<td>ETX</td>
<td>End of Text</td>
</tr>
<tr>
<td>4</td>
<td>EOT</td>
<td>End of Transmission</td>
</tr>
<tr>
<td>23</td>
<td>ETB</td>
<td>End Transmission Block</td>
</tr>
<tr>
<td>25</td>
<td>EM</td>
<td>End of Medium</td>
</tr>
<tr>
<td>5</td>
<td>ENQ</td>
<td>Enquiry</td>
</tr>
<tr>
<td>6</td>
<td>ACK</td>
<td>Acknowledgement</td>
</tr>
<tr>
<td>7</td>
<td>BEL</td>
<td>Bell</td>
</tr>
<tr>
<td>8</td>
<td>BS</td>
<td>Back Space</td>
</tr>
<tr>
<td>9</td>
<td>HT</td>
<td>Horizontal Tab</td>
</tr>
<tr>
<td>11</td>
<td>VT</td>
<td>Vertical Tab</td>
</tr>
<tr>
<td>13</td>
<td>CR</td>
<td>Carriage Return</td>
</tr>
<tr>
<td>10</td>
<td>LF</td>
<td>Line Feed</td>
</tr>
<tr>
<td>12</td>
<td>FF</td>
<td>Form Feed</td>
</tr>
<tr>
<td>14</td>
<td>SO</td>
<td>Shift Out</td>
</tr>
<tr>
<td>15</td>
<td>SI</td>
<td>Shift In</td>
</tr>
<tr>
<td>16</td>
<td>DLE</td>
<td>Data Link Escape</td>
</tr>
<tr>
<td>17</td>
<td>DC1</td>
<td>XON - Device Control 1</td>
</tr>
</tbody>
</table>
Working with Memory Cards

Using the Printer Memory Card

Usage of printer memory card is recommended whenever faster label printing is required. A memory card boosts performance because there is no need to transfer large bitmap images or custom font files to printer over and over again. Every element that is needed on the label is already stored on the memory card.

Let's take a look at how you can prepare and use your memory card.

1. First of all, go through the user manual of your memory card. Memory cards are sensitive devices and misuse could damage the card as well as your printer.
2. Insert memory card into Slot 1. The slots are usually located at the back of the printer. Switch on the printer.
3. Start the application NiceMemMaster, memory card manager. If the icon for NiceMemMaster is not shown in the labeling software folder in the Start menu check your installation. Reinstall the labeling software if necessary.
4. We'll assume that memory card is empty or safe to delete. First step is, to let NiceMemMaster know what type of card is inserted in printer. Click Print Setup in Card menu. Select your thermal printer from the list. If your printer is not listed, you will have to install the appropriate NiceDriver. Click button Properties then click button Memory to open dialog box Printer memory. Here we have to activate the memory card in Slot 1. Look at section Slot 1. In field Type select Memory Card, leave field Connected file intact. Keep clicking OK until you return to NiceMemMaster.

**Note:**
NiceMemMaster works only in conjunction with NiceDrivers.

5. We will format the memory card and prepare it for downloading our data. Be careful, if the card contains any previously downloaded elements, they will be deleted. Click Format from Card menu or click . Formatting will take a few seconds.

6. Next step is to build a list of fonts and graphics that we want to store on memory card. The information about these fonts and graphics is stored in memory card file (.MMF).

Let's make a sample memory card file. Select New from Card menu, or click . Name the file Sample and click OK. In dialog Card setup type in description and select proper card size in kilobytes. You can always return to this dialog by selecting Memory card information in Card menu or clicking .

On the left side of the NiceMemMaster windows is place for inserting fonts; on the right side is a place for graphics files. To add a font select Add from Font menu or right-click Fonts side of the window. Select font to be downloaded and its style and size. Next dialog allows you to select only the required characters in this font. Only selected characters will be downloaded to memory card. Use this option if you are running low on kilobytes on memory card. Let's add the whole font in our sample. Next we'll add some graphics to our list. Select Add from Graphics menu or right-click Graphics side of the window. Select some pictures (e.g. SAMPLE.PCX or PRINTER.BMP).

In the lower part of the window you can see information about selected font or graphics: preview, used memory, width and height. Every element can be printed to label, just to see if everything is all right. Use command Test print. Add some more fonts and graphics to get a grip. Undesired elements can be removed from the list. Use Delete from Font/Graphics menu or right click the element and select Delete.

7. When layout is complete and every font and graphics is in the list, we are ready for download. You can download the whole list to the printer at once. Right-click left or right side of the window and select Download All from the list. Or you can download one element at a time by selecting it and clicking Download from Fonts/Graphics menu or right clicking it and selecting Download from the list. If for some reason you want to remove a downloaded element from memory card, but keep it in the list for later, use command Remove.
Now let's do a status print. Printer will report some useful information of memory card usage. Click **Status Print** from **Card** menu.

Memory card is now filled with elements (fonts and graphics) and is ready to be used from the labeling software.

1. Start the label designer
2. Create new label. Click **New** from **File** menu or click ![New]. Choose your printer from the list. Select predefined label stock or design your own label.
3. We have to tell the label designer that our printer is equipped with memory card and what kind of data is stored on the memory card. Double-click the printer name in the status line in the bottom of the window. Click button **Memory**, and in section Slot 1 for **Type** select **Memory Card** and for **Connected file** select **SAMPLE**. This is the name of the memory card file (.MMF) we created before. Click OK to return to the label designer.
   Click Text icon ![Text] or Paragraph icon ![Text Box] and type in some text. From text toolbar select the font, you downloaded to memory card before. If text toolbar is not shown on your screen, switch it on using command **Text tool** in **View** menu. You will recognize downloaded font by special printer symbol in front of its name 📽️. To make sure, you have selected the proper font, the same symbol is shown in the lower right corner of the element on the label. If the symbol is not there, you didn't select the right font or you do not have switched on displaying of printer element. In this case select **Object properties** in **View** menu and click **Printer elements**.
5. Using downloaded graphics.
   Click Graphics icon ![Picture] and select the picture you downloaded to memory card before. Click OK. Inserted picture is used from disk and not from memory card yet. To change this double click the picture and select **On memory card** in General tab. Click **Browse** and select the picture from memory card. To make sure you are using picture from memory card look at the picture on the label. It should be framed in blue box. Regular picture doesn't have any frame.

If you need further explanation on how NiceMemMaster works please refer to NiceMemMaster documentation.

---

**Using Label Setup Wizard**

**Using Label Setup Wizard**

Label Setup Wizard offers defining dimensions of the label and changing printer setup. It consists of a few simple steps. Click on the **Related Topics** button for more information.

**Defining Label Dimensions**

Here you can enter the label dimensions.
Label setup Wizard - defining the label format

**Width, height:** Define the label dimensions.

**Margins:** Define the label margins.

**Rows, columns:** Define the number of labels in horizontal and vertical directions. This option is commonly used with office printers (laser and inkjet printers).

**Gaps:** Define the gaps between the labels.

**Note:** Define gaps only if you have changed rows and columns option. If you have rolls of labels, the gaps between the labels are auto-identified by the gap sensor in the printer.

**Unit of measure:** Change the unit of measure you want to use.

When you are satisfied with the label dimensions, click on the **Finish** button to close the Label setup wizard.
Label setup Wizard - selecting Label Stock

If you use one of the standard predefined label formats, you can specify it here.

**Stock Type**: Select the type of stock.

**Stock name**: Select the stock from the list.

**Stock information**: The information about label dimensions, printer settings, background images as defined by the selected stock.

**Label linked to stock**: If you enable this option, you cannot change the dimensions of the label, because the stocks locks the dimensions.

**Note**: Using pre-defined stocks simplifies the process of label creation as you do not have to define the label dimensions manually.

Click on the **Next** button to continue with the next step.
Selecting label layout

**Orientation:** Select the label orientation. Look at the screen and printer layouts for suggestion how the label will really be printed from the printer.

**Print directions:** Tick the option **Rotated** to rotate the label for 180 degrees, when printed.

Click on the **Next** button to continue with the next step.
Defining the Page Size

Label setup Wizard - choosing Label Dimensions

Select the page size for your labels. This step is only necessary for the office printers.

**Automatic Sizing:** Tick this option, if you are using thermal printer with NiceDrivers. The labeling software and NiceDrivers will negotiate about the label dimensions.

Click on the **Next** button to continue with the next step.
**Selecting Printer**

Select desired printer and optionally click **Properties** button if you want to set the printer parameters. Print setup dialog box is shown, allowing you to set the printer parameters such as print speed, print darkness and print direction. Note that this is standard Windows printer setup dialog box and its options may differ from printer to printer as it is based on the printer driver.

If the check box **Always use default printer** is checked, the default window's printer and its settings will be used always when opening this label.

Click the **Next** button to continue with the next step.

**Using Document Storage Server**

Traditionally label templates are stored on the hard disks. User can have the label repositories available locally on their driver. In multi-user environments the administrators frequently define a common network shared disk system that allows the users to simultaneously use the same label templates from different workstations.

With NiceLabel Enterprise Series there is an additional storage possibility available. With the software you not just gain the central system management component, but also the Document Storage System.
The Document Storage System is part of the Enterprise Print Manager and provides a web-based label repository. It is based on the WebDAV communication and basically allows the authenticated users to use the labels from a web-based server. You can use the Document Storage System from within your company (using LAN connection). However, you can also grant access to the outside internet-connected users. The Document Storage System can become a web-based document storage for larger groups of people.

The system can host not only label templates, but also forms and graphics.

To use the data from the Document Storage System, do the following:

1. Make sure you have activated your software with the license from the Enterprise Print Manager. The Document Storage Server does not work with other types of the activations (hardware key, single-user software key or multi-user software key).
2. Select **File -> Open**.
3. Look at the left pane with shortcut icons. Click on the icon **Storage Server**.
4. Select the appropriate document in the browse pane.

**Note:** The Document Storage Server is available with the Enterprise Series of products only.
Printing and Previewing Labels

Preview and Print a Label

If you want to print a label, you can use the print preview to simulate a print output. The label preview shows the label on the screen.

Simulate printing 10 labels on the screen to check label layout and printing procedure.

1. Click on icon in the Standard toolbar or select the command Print in the File menu. The Print dialog box appears.
2. Enter 10 for Label Quantity and click on the Preview button. The software will close the dialog box and simulate the production for 10 labels on the screen.

Note: You can select between the quantity of the labels and the quantity of the pages. The page can have one or more labels and the labels are arranged on the page in columns and rows. If you have eight labels on the page, the quantity of ten pages will print 80 labels.

When you are certain that the labels will be printed correctly and the preview shows the correct values, you can proceed to real printing. To actually print the labels, do the following:

1. Click on icon in the Standard toolbar. The Print dialog box appears.
2. Enter 10 for the Label Quantity and click on the Print button. Your printer will now print 10 labels.

Note: To manage fast and easy label printing, you can print labels from the application NicePrint or the form generated with NiceForm. For more information refer to the chapter Other Applications.

Store and Recall Printing Mode

Store and Recall printing mode is the method of optimized label printing.

In this mode the software does not send the data for each label individually to the printer, a process that used in standard printing mode. Instead for each print action label recall command is sent to the printer. The obvious benefit is reduction of data sent to the printer. Typically a few bytes of data is sent to the printer, compared to a few kilobytes with normal printing.

Store and recall printing method is a perfect solution for label printers, where high response and high-throughput is required. Usually with embedded and integration systems. Once you have defined the store and recall printing mode in the label
designer, the same benefits are available from the form designer and middleware integration module.

Instead the label printing process is broken into two processes:

- **Store label**
  During this process the software creates a description of the label template formatted in the printer command language of the selected printer. For example, if you have Zebra printer, the description is encoded into the ZPL file. The software then sends the created command file to the printer memory and stores it there.
  Once the label has been stored in the printer, it remains there until you format the printer memory, or switch off the printer. There are various memory locations in the printer and some of them are non-volatile and you can lose the contents, when the printer switches off.

- **Recall label**
  The label stored in the printer memory can be immediately printed out. Using the recall process the software creates another command file to instruct the printer which label from the memory to print. The recall label command can occupy a few bytes of data only. It depends on the situation you have.
    - Fixed labels: If you have labels without any variable contents, the recall command file contains just the recall label command.
    - Variable labels: If you have labels with some variable fields, the command file will include the values for these variables and the recall label command.

To use the store and recall printing mode, do the following:

1. Make sure to select the appropriate printer driver for your label printer. Not all label printers have the ability to use the store and recall printing mode.
2. Select **File -> Label Setup** and go to the Printer tab.
3. Enable the option **Store label template and recall for printing** in the Print Mode section.
4. Click **OK**.
5. Define you label template.
   All object on the label for which you want to be variable should be formatted as internal printer objects. You must format text objects in printer internal fonts (not Truetype fonts). You must format the bar code objects as printer internal bar codes. You can still use variable objects formatted in Truetype fonts, or variable pictures, or database fields, however, during the label store process default values will be sent to the printer.
6. When ready for printing, select **File -> Print**.
7. Go to the **Store Label Template** tab.
8. Make sure the 'Store location' points to the correct memory location in the printer.
9. Type in or select the values for variable objects that are not formatted as internal printer objects. These variables will have the same value on each label, they will behave as they are objects with fixed value.
10. Click on **Store** button to create the command file with label template description and send it to the printer.

11. Go to the **General** Tab.

12. Type in the values for prompted variables on the label. These variables link to the internal printer objects on the label, that's why you can set their values to different value with every print.

13. Click on **Recall** button to send the variable values and recall label command to your label printer.

14. You can preview the data that is sent to the printer using the Store and Recall function. In the **Print** dialog window, select **Analyze Stream** on the **Advanced** tab. A **Print Stream Analysis** window will open, displaying the stored data in the **Store Stream** frame. The **Recall Frame** will display the data that is sent to the printer during subsequent printing of a stored label.

---

### Previewing Pictures

When you place a picture on the label, in design mode it is always shown in color-depth as defined in the picture.

However, when previewing the labels on-screen, the preview of the pictures depends on the dithering option set in the printer driver. All color pictures (except WMF and EMF files) are converted to monochrome images. The illusion of colors and shades of grey is accomplished by varying the pattern of dots. More dots close together will provide darker shade of grey.

The preview of the label will show pictures in the same way as they will be printed accordingly to the dithering setting. More accurate print preview is guaranteed this way.

If the picture is not previewed as you would like to print it, change the dithering setting in the printer driver.

---

### Optimize the Printing Speed

There are many factors that affect the printing speed. By following the guidelines below you can dramatically increase the speed of printing:

- If your printer supports parallel and serial port, use the parallel port. Computer can send data to printer over parallel port much faster than over serial port.

- Use printer's internal fonts instead of Windows' true-type fonts. True-type fonts must be sent to printer as graphics and therefore the size of data sent to printer is much bigger (couple of kilobytes). When using internal fonts, only the text is sent to printer (couple of bytes). If you must use true-type fonts, use the NiceMemMaster program, to download these fonts to printer's memory and
later access these fonts as internal printer fonts (only if your printer supports this).

- Avoid use of graphics on labels. If you must print graphics on labels, use the NiceMemMaster program to download these graphics to printer's internal memory (only if your printer supports this).
- When using bar codes, make sure that you don't print bar codes as graphics, if your printer supports printing bar codes.
- When using counters, the printer will internally increment the numbers if the internal fonts are used. (if supported by the printer) This means, that the printer will only receive the first number of object, and will later increment this number to print other labels. Using this option also reduces the amount of data transferred between computer and printer, but the difference is noticeable only with high quantity of labels.
- Set the printing speed to a higher value (if your printer supports it). Note that setting the printing speed usually affects the quality of printing. The higher the speed, the lower the quality. You will have to find an acceptable compromise for this.
- Don't print too much data on labels. If the speed of printing is an important factor, you should consider using preprinted labels, and only print the data, that is different on each label.

### Reprint Labels

The ability to reprint labels is one of a stronger key values of the labeling software. When you have the print logging enabled, the software will keep track of all printed labels. The Microsoft Access database stores all information about the printed labels. Not just basic information like the user name, the label name, label quantity, time of printing, printer name and similar data, but also advanced information like the values of variable fields on the label, status of counters, printed quantity and label job status.

Because all information about the printed label is remembered, you can reprint the whole print jobs, or individual labels from the job. The reprint feature is available as long as the information about the printer job is stored in the log database. You can use the reprint feature to print the label with the same information on the same printer as originally used, or to any other available printer.

**Note:** The reprint feature works with the same data on the label, but not with the same job files. The software recreates the print jobs on-the-fly using the information of variables fields from the log file.

Before each reprint action, the software checks the status of the printed label, as follows:

| Label Version Change | Version of the label file is checked against the label version information in the log database. If the label version on the disk is greater than the version of the printed label, you will need to confirm printing of changed label. |
To reprint labels, do the following:

1. Select **Tools -> View Log File**.
2. Select the log entry in the table that you want to reprint.
3. Click on the **Reprint** button.
4. Visually check the label preview if the selected label is really the correct one.
5. Select which label or labels you want to reprint from the print job. Put a tick mark in the selection box before the line. You can reprint the currently selected label, all labels from the beginning of the print job, all labels until the end of the print job, or select individual labels.

**Note:** To find a label with some particular value of variable field, use the **Find** toolbar. The labels matching the criteria will be selected in the table.

6. Select the printer to which you want to reprint the labels.

**Note:** You can select any available printer, not the original printer only, because the software will process the label again, not just send the same print job to the printer.

6. Click **OK**.
7. Click **Close**.

---

### Use Custom Edit Forms

If you have a lot of prompted variables on a label, you can use custom forms that allow user-friendly data entry.

Do the following:

1. Open your label.
2. Select **Label Setup** from the File menu.
3. Go to Printing tab.

**Note:**
If Printing tab is not visible, click on the button **Advanced** at the bottom of the dialog box.

4. Type in the name of the form file you want to use for printing.
5. If the form does not exist, click on the button **Define** to create it.
6. Click on the **OK** button.

When you will select the Print command, the form will start and replace the standard Print dialog box in the labeling software.
NicePrint

NicePrint is a standalone application that enables fast and easy label printing. You can start it from labeling software program group in the Start menu. Using the application, you can perform all printing steps in one single window:

- Select the label for printing
- Set the values for variables
- Select records in the database
- Change the printer and its properties
- Define label quantity
- See label preview
- Print the label

The Application provides fast access to label printing

NicePrint is available in NiceLabel Suite edition.

Note: If you provide the label name as a parameter in the command line next to the NicePrint executable name, the application will open that label.
Integration and Connectivity

Overview

The most common method is to print labels directly from the labeling software. But sometimes there might be other requirements of label production. The labeling software has a wide connectivity and integration options so you do not have to use the labeling software interactively but through ActiveX interface or DDE connectivity. You can use a "print-engine" totally integrated to your custom application and invisible to end-user's eyes.

If you do not require such tight integration to your application, you can use NiceWatch, add-on utility for non-programming integration to existing systems and fully automated printing. A set of actions is defined that are trigger if pre-defined event occurs. These actions can open the label, connect it to database, fill variable's values, connect to proper printer and print the required number of labels. You can even build your custom data-entry and printing applications with NiceForm in a totally user friendly way without any programming skills required.

Command Files

Use Command Files

You can use command files to instruct the print engine what to do. The command files use the structure of NiceCommands in order to send the commands to the print engine.

The following command files are supported:

- JOB file
- XML file
- CSV file

You can use the command files from several applications:

- From labeling software interactively (command File -> Command Files), or automatically (the name of the command file specified as parameter in the command-line, works for JOB files)
- From NiceForm in action Run Command File
- From NiceWatch in action Run Command File

The command files are always processed in order from top to bottom of the file. The first command in the file is processed first. The order of appearance is important. For example: you need to specify the printer first and then print the label.

The command files are stored in a text file. Unicode values are supported.
Command File: JOB File

The commands available in the JOB command files are NiceCommands.

See the chapter of NiceCommands for more information about their syntax and method of usage.

Automatic Print with JOB Files

Use this facility for automatic un-attending printing from the labeling software. The JOB file is a plain text file with commands that instruct the labeling application what to do automatically. Usually the scenario goes like this:

1. The software opens the label file, as defined by LABEL command.
2. The software sets the values of variables on the label, as defined by SET commands.
3. Optionally, the software selects some other printer for printing, as defined by PRINTER command.
4. The software prints the required amount of labels, as defined by PRINT command.

The Automatic Print can be used interactively in the application or with command-line parameter.

To start Automatic Print with JOB file interactively, do the following:

1. Open label designer.
2. Select File -> Command Files -> Print.
3. Browse to the .JOB file and click Open.

Note: Interactive mode is useful for testing your .JOB files. If there is any syntax error with the command in the JOB file, you will be notified about it.

To start Automatic Print with command-line parameters, do the following:

1. Make sure the syntax of your commands in the .JOB file is correct.
2. Start the software from command prompt with the following syntax:

   NLABEL5.EXE <full path to your .JOB file>

For example: NLABEL5.EXE c:\My Labels\PRINT.JOB
You can find the file NLABEL5.EXE in the Bin folder in the Program Files folder structure.

Using JOB Files

JOB file is one option to automate label printing. When you do not want the user to interact directly with label designer to print labels using JOB file can help. The print operator does not need to be confronted with the label designer and see all design options not really important during the print-out. Instead a JOB file drives the printing process.

JOB file is a plain text file that contains commands. The text can have Unicode formatting. The commands instruct the label print engine what actions must be
executed to successfully print the label. The commands are executed in order from top to bottom. The order of commands is important.

The JOB files are commonly used to automate label printing process. Here are some ideas where to use JOB files:

- **Command-line** option in the labeling software. The software will open the JOB file and process the commands within. If last command is QUIT, the software will close when printing completes.

  For example:
  c:\Program Files\EuroPlus\NiceLabel 5\bin\NLABEL5.EXE
  c:\MyJOB\FILE01.JOB

- **Action Run Command File** in applications NiceForm (application generator) and NiceWatch (middleware integration module).

**Note:** When working with job files make sure to remember that the '\n' sequence is understood as the newline character. If you have the folder names beginning with '\n' you have to put an extra backslash character in front of the sequence. You must encode the path and filename 'c:\NewJobs\Print.JOB' as 'c:\\NewJobs\\Print.JOB'.

**Command File: CSV File**

The commands available in the CSV command files are a subset from NiceCommands. You can use the following commands: Label, Set, Port, Print and Printer. Of course, the syntax of the commands differs a little bit when used in CSV file.

**CSV Command File Structure Explained**

The CSV stands for Comma Separated Values. This is the text file where field values are delimited by the comma (,) character. The text file can contain Unicode value (important for multi-language data).

Each line in the CSV file contains the commands for one label printing.

The first row in the CSV command file must contain the column names. This is important for the labeling software to know what is the order of appearance of fields and how is the data organized. Several column names are pre-defined.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@Label</td>
<td>The name of the label to use. It is recommended to include label path and filename. Note: You can provide label name only, but be sure that print engine will try locate the label in the correct folder. Is required.</td>
</tr>
<tr>
<td>@Printer</td>
<td>Use this field to override the printer defined on the label. Print the label to some other printer. The other printer must be accessible from this computer. Use the printer name for value of this attribute. Not required.</td>
</tr>
</tbody>
</table>
### @Quantity
Use this field to specify the number of labels to print. Possible values: numeric value, VARIABLE or UNLIMITED. Is required.

### @Skip
Use this field to specify how many labels to skip at the beginning. This feature is useful if you print sheet of labels to laser printer, but the sheet is partial already printed. Not required.

### @IdenticalCopies
Use this field to specify how many label copies should print for each unique label. This feature is useful when printing labels with data from database or when you use counters, and you need label copies. Not required.

### @NumberOfSets
Use this field to specify how many times the printing process should repeat. Each label set defines the occurrence of the printing process. For example: setting this value to 5 will cause the printing process to repeat five times. Not required.

### @Port
Use this field to specify the port name for the printer. You can override the default port as specified in the printer driver. Not required.

### Other fields
All other fields define the name of the variables from the label. The fields provide values for variables.

The order or appearance of the columns in the CSV file is no important. But it is important that all rows in the same CSV file have the same structure.

Session print is used automatically. Session printing is disabled when you change the printer or label within the same CSV file.

All columns in the CSV file are used when setting the values to the label variables. If the variable with the name from CSV does not exist on the label, no error message is displayed.

### Command File: XML File
The commands available in the XML command files are a subset from NiceCommands. You can use the following commands: Login, Quit, Label, LabelClose, Set, Port, Printer, SessionEnd, SessionStart, SessionPrint, SetDatabase and SetTable. Of course, the syntax of the commands differs a little bit when used in XML file.

The root element is Nice_Commands that must be present in the XML command file. The next element that must follow is Label, that specifies which label to use. Next you have two options for label printing:

1. Print labels normally using the element Print_Job.
2. Print labels in session using the element Session_Print_Job.
You can also change the printer to which the labels will print, you can set the variable value and you can change the database that is currently used on the label.

**XML Command File Structure Explained**

Below is the description of the command file structure. There are several elements that contain attributes. Some attributes are required, other are optional. Some attributes can occupy pre-defined values only, for other you can specify the custom values.

**Nice_Commands:** Is root element with two attributes
- *login:* Performs login procedure into the program. Not required.
- *quit:* Closes the print engine when the actions execute. Will remove the print engine from the memory. Is required.

**Label:** The element that opens the label in the print engine. If the label is already opened, it will be re-used. You can use this element several times within the command file.
- *name:* Attribute contains the label name. It is recommended to include label path and filename. Note: You can provide label name only, but be sure that print engine will try locate the label in the correct folder. Is required.
- *close:* The attribute instructs the print engine, if the label should close after printing, or it should remain open. Possible values: true, false. Is required.

**Print_Job:** The element that unions the commands for printing labels. You can use this element several times within the command file.
- *printer:* Use this attribute to override the printer defined on the label. Print the label to some other printer. The other printer must be accessible from this computer. Use the printer name for value of this attribute. Not required.
- *quantity:* Use this attribute to specify the number of labels to print. Possible values: numeric value, VARIABLE or UNLIMITED. Required.
- *skip:* Use this attribute to specify how many labels to skip at the beginning. This feature is useful if you print sheet of labels to laser printer, but the sheet is partial already printed. Not required.
- *job_name:* Use this attribute to specify the name of your job file. The specified name is visible in the print spooler. Not required.
- *print_to_file:* Use this attribute to specify the file name where you want to save the printer commands. Not required.

**Session_Print_Job:** The element that unions commands for printing labels. It considers session print rules. You can use this element several times within the command file. For available attributes lookup the attributes for the element Print_Job. All of them are valid, you only cannot use the quantity attribute. See the description of the element Session to find out how to specify label quantity in session printing.

**Database:** The element that overrides the database selection on the label. Use it whenever you do not want to use data from the database that is configured on the
label, but some other database. You can use this element several times within the command file.

- **name**: The attribute contains the database name. Required.

**Table**: The element that overrides the table selection on the label. Use it whenever you do not want to use data from the table that is configured on the label, but some other table. You can use this element several times within the command file.

- **name**: The attribute contains the table name. Required.

**Variable**: The element that sets the value of variables on the label. You can use this element several times within the command file.

- **name**: The attribute contains the variable name. Required.

---

**Automating the Software**

**Automation with ActiveX**

**Programming interface: Automation (ActiveX)**

The information in this chapter is for advanced users and application developers only. If you don't plan to write applications that use the embedded print engine to print labels, you can skip this chapter entirely.

The labeling software can act as an OLE Automation server. Its class name is NiceLabel5.Application.

The commands actually allow you to have more control over the labeling software from your own application. ActiveX allows also the status of variable managing procedure to be returned to your application so you can control printing process more accurately. A lot more programming functionality is allowed. The ActiveX interface makes is possible to query every label element for its properties. The same goes for variables and functions defined on the label. The properties of all label elements can be modified prior printing if for some reason you do not want to use label-defined settings. You can even create a label preview in your own application.

For more information about programming interface please refer to the manual **ActiveX and DDE Programming manual** available on the product CD-ROM and on the product website.

You can also auto-generate the description of the interface using /typelib command-line parameter. It will create NLABEL5.OLB with description of methods, properties and events that the labeling software. Appropriate application for viewing .OLB files is required to be able to see the file contents.
Programming Samples

Programming samples demonstrate how you can use the labeling software as a print-engine from your applications. The programming samples are not installed with the labeling software. However, they are available for separate install as the add-one, Integration Pack. You can install the Integration Pack from the product CD or from the product web site.

The samples are available for different development platforms (MS Visual Basic, Borland Delphi, C++ and other). You can take a look at the ready made sample and use the similar code immediately inside your application. Refer to the documents enclosed to the Integration Pack to see how to embed the label print engine inside your application. The whole programming API is documented in the Programming Guide. It will help you start using the label print engine from your custom application.

Automation with DDE

DDE Communication

You can use DDE connection to print the labels from your Windows applications, that you develop in standard programming environments such as Microsoft Visual Basic, Borland Delphi, C, Microsoft Access…

To create the DDE communication the client application must use the following DDE parameters:

Service = NiceLabel5
Topic=LINE or JOB

When you are using topic JOB the content is the name of the command file, which must be run. When you are using topic LINE the content is one of the commands.

When you want to use DDE communication to manage the labeling software, it is probably the best, when the user doesn't know for the background running of this application. For this purpose you can use this command parameter:

NLabel5.EXE <label_name> /s

The parameter s (silent) prevents that the software will show on the screen. It is run in the minimized form.

Integration to SAP R3

Integration to SAP/R3

The labeling software can be used to design labels that should be printed to thermal printers from SAP system. Two possible methods can be implemented.

| Printing labels using | NiceWatch data-detection module is used to integrate label |

214

NiceLabel Pro User Guide
### Integration and Connectivity

**the middleware integration module**

Printer to your existing SAP/R3 system.

Labels are normally designed on Windows PC, where the software is installed. NiceWatch runs on the same system.

User on SAP/R3 system would export the data that should be used on the label to some ASCII file or true database file format. NiceWatch will detect the appearance of the file and trigger label production.

The advantage of this approach is that labels will be processed on-the-fly. Labels will be imaged directly with data from exported database. There is full support for variable graphics elements, truetype fonts for variable fields and for advanced design options (usage of functions, VB Script etc.) All label printers with Windows driver can be used.

The only disadvantage is that a PC computer with installed Windows operating system is required for label printing.

For more information how NiceWatch can be used for your specific demand, refer to NiceWatch Operating Manuals.

### Printing directly from SAP/R3

Using this option the labels are designed with the labeling software on a PC computer and are then exported to SAP format. Export procedure will generate .ITF native file with description of the label. This .ITF file is then uploaded to SAP system and users can print labels directly from SAP/R3.

The advantage with this approach is that no PC is required for label printing. Once the label is created, you do not need the label designer any more.

However, there are several disadvantages. First of all, every label printer is not suitable for label printing directly from SAP/R3 system. SAP has certain limitations that the printer has comply to. There is also limited support for graphics elements. Variable graphics cannot be used at all. And only some printer models support printing of fixed images/truetype fonts. Variable text fields on the label has to be set in internal printer fonts that usually do not look as good as truetype fonts. Only prompted variables can be used. Because the label design application is not present at print-time, functions and advanced label elements cannot be used.

For more information about connecting labeling software to SAP R/3 system please refer to the appropriate White Paper on the web site of contact technical support.
Label Export

Label Export

Label Export functionality is used heavily from stand-alone and some print-only variants of this labeling software. Its functionality is tightly connected to the ability of printer that is used on the label. Export is only available when using thermal printer drivers shipping with the labeling software. The printer driver also must have built-in the support for the required export.

Windows version of labeling software on PC computer is used to design the label layout compliant to the labeling request. All label elements can be used on the label (text, paragraph, RTF, bar code, image, line, rectangle, ellipse, ...). When printing fixed labels, there is no issue you should pay attention to. The label elements are printed as graphics.

The exported printer file can have fixed or variable values. If you have label with fixed fields, you can send it directly to the label printer. If you have a label with variable fields, some external application has to assign values to the variable fields. Usually, the external application does the following:

- Takes the generated print file
- Searches for the locations of the variable fields
- Inserts the correct values for these fields

When you use variable fields on the label, you have to pay special attention to their format. All variable elements must follow some designing rules.

<table>
<thead>
<tr>
<th>All variables on the label have to be prompted</th>
<th>User must be able to set their values before printing. Date/Time variables have to acquire the data from the printer clock not from PC system clock.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support for functions is limited (Concatenate, Subset, etc.)</td>
<td>As PC labeling software is not available at print time, the functions cannot be processed, so you cannot use them on the label. There are some exceptions, for example Export to Pocket PC, where some functions can be used, because the application that will eventually print these files knows how to process them.</td>
</tr>
<tr>
<td>All counters have to be incremented by printer</td>
<td>As PC labeling software is not available at print time, the printer must be capable of using internal counters. Make sure you defined the counter variable on the label as the printer internal hardware counter, not software counter.</td>
</tr>
<tr>
<td>Variable graphics are not supported</td>
<td>Because PC labeling software is not available at print-time, it cannot handle the variable graphics. Any image on the label has to be static.</td>
</tr>
</tbody>
</table>
Label Export is one method of label printing from outside of labeling application. It requires some other application to be able to open exported label format, parse it and then print it. There are numerous other possibilities to integrate label printing to existing systems. More information is available on the product web site.

NiceCommands

The printing with the software can be automatic. There are two ways for automation. The first one is with the use of the command files (JOB file) which is used with Automatic print command from File menu. The second way is with the help of any other Windows application, which enables DDE communication between the programs.

In the both ways you can use the same commands. When you are using the automatic print, the commands must be written one per line in the command file (JOB file). With the DDE communication the commands are send through the DDE channel.

COMMENT

; When developing program code or scripts it is very wise to well document your commands. This will help you decode what the script really performs, when you will look at the code after some time.

Use semicolon (;) on the beginning of the line. Everything following it will be treated as script comment and will not be processed by application.

CREATEFILE

CREATEFILE <name_of_the_file>

This command will create a plain ASCII text file. The file will contain only one line of text.

The purpose of creating such file is to signal some external application that the label processing or printing has began or has ended.

The example of the CREATEFILE usage is printing labels with the data from some text file. First the external application prepares variable data for the labels and stores the data into the text file. Then labeling software is activated and printing starts. A CREATEFILE command is used to create a file on the disk. The appearance of the file represents a signal to the application that the current printing process is finished.

DELETEFILE

DELETEFILE <name_of_the_file>

This command deletes the specified file. You can use it in combination with CREATEFILE command.
**EXPORTLABEL**

EXPORTLABEL ExportFileName [, ExportVariant [, CreateLVXFile]]

The command is implemented to automate the "Export to printer" command. You can manually access the command using File -> Export -> Export to printer. The label is exported directly to the printer and stored in the memory for off-line printing. The user can recall the label with keyboard on the printer or sending a command file to the printer.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ExportFileName</td>
<td>The parameter is mandatory and defines the filename of a generated print stream for exporting label to the printer.</td>
</tr>
<tr>
<td>ExportVariant</td>
<td>Some printers support multiple export variants. When manually exporting, the user can select the export variant in the dialog. With the EXPORTLABEL command you must specify which export variant you want to use. The first variant has the value 0. The second variant has the value 1, etc. If you do not specify the variant type, value 0 is used as default.</td>
</tr>
<tr>
<td>CreateLVXFile</td>
<td>The parameter has two possible values, TRUE or FALSE. If you set the value to TRUE, besides the generated print stream also the LVX file will be created. The LVX file contains information about the variables used in the label. For more information about exporting labels and LVX files refer to the white paper section on the website.</td>
</tr>
</tbody>
</table>

**LABEL**

LABEL label_name [, printerName]

The command opens the working label. If the label is already opened, the program will use this one. It is recommended to write full path name along with the file name.

Note, if variable value contains space characters or commas, you will have to enclose the whole path in quotation marks (e.g. LABEL "C:\My Labels\sample3.lbl").

If you use LABEL command with NiceWatch running in service mode, use UNC quotation instead of the mapped drives (e.g. LABEL "\SERVER\SHARE\MY LABELS\LABEL.LBL" instead of "G:\MY LABELS\LABEL.LBL").

The PrinterName (when provided) sets the printer, for which the label will be initially opened. If non existing printer is provided, the command will raise an error.

**LABELCLOSE**

LABELCLOSE
The command closes the currently active label. The label application will stay opened. FILECLOSE command does the same thing, but is depreciated. To speed up label printing do not use this command frequently. You can have opened more label files simultaneously. If the label is already opened, it does not have to be loaded and thus the label processing can be performed quickly.

LOGIN

LOGIN <username>

Performs login procedure into the labeling software. This is necessary when login is required.

Note: This is a DDE command and should not be used in batch command .JOB files.

MESSAGEBOX

MESSAGEBOX message [, caption]

Displays the message in the message box. The second parameter is used to define the title of the message dialog box.

If the variable value contains space characters or commas, you have to enclose the text in quotation marks (e.g. MESSAGEBOX "Insert labels in printer", Warning).

OEMTOANSI

OEMTOANSI ON|OFF

This command works in conjunction with command SET. It puts the text that follows the command SET in proper codepage, so that variable is assigned the proper value.

Use it to put the values following SET command to the proper codepage, so correct characters will be transferred to labeling application at print time.

PORT

PORT <file_name> [, APPEND]

This command overrides the printer's port name. This command is used to redirect print output to a file.

<table>
<thead>
<tr>
<th>&lt;file_name&gt;</th>
<th>Specify the name of the filename to which you want to redirect the printer file. You can also include the path in front of the filename. If the file path or filename contain space characters, enclose the whole string in double quotes.</th>
</tr>
</thead>
<tbody>
<tr>
<td>APPEND</td>
<td>The parameter APPEND is optional. By default the print action overwrites the file on the disk, when it already exists. If you want to append the data to the existing file, make sure to use the parameter APPEND.</td>
</tr>
</tbody>
</table>

Once you use a command PORT in the JOB file it will be valid until the next PORT command, or until the end of file (whichever comes first). If you use PRINTER command after the PORT command has been executed, the PORT setting
will overwrite the port defined for the selected printer. If you want to use the actual port that is defined for the selected printer, you have to use another PORT command with empty value, like this PORT = "".

**PRINT**

PRINT quantity [, skip [, identical label copies [, number of label sets]]]

Command PRINT starts printing. The first parameter is the quantity of the labels that should be printed.

<table>
<thead>
<tr>
<th>&lt;number&gt;</th>
<th>This many labels will be printed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>VARIABLE</td>
<td>Some variable contains the information how many labels should be printed. It can be label-defined prompted variable or a field from the database.</td>
</tr>
<tr>
<td>UNLIMITED</td>
<td>If you use a database to acquire values for variable fields, unlimited printing will print as many labels as there are record in the database. If you do not use a database, there is not much sense to use this option. In this case the maximum number of labels that thermal printer internally supports will be printed.</td>
</tr>
</tbody>
</table>

The parameter skip in the command represents the number of the labels you want to omit before first printed label on the page. The parameter is used for label printing on sheets of paper. When the part of the page is already printed, you can re-use the same sheet by shifting the start location of the first label. The rest of the unused labels on the page can be printed with the help of this parameter.

The parameter identical label copies specifies how many copies of the same label should be printed.

The parameter number of label sets specifies how many times the whole printing process should be repeated.

If you do not need to set some of the supplementary parameters, use their default values.

<table>
<thead>
<tr>
<th>Skip</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identical label copies</td>
<td>1</td>
</tr>
<tr>
<td>Number of label sets</td>
<td>1</td>
</tr>
</tbody>
</table>

**Note:** Make sure the quantity values are provided as the numeric value, not string value. Do not enclose the value in the double quotes.

**PRINTER**

PRINTER <printer_name>

Normally, the PRINT command prints the label to the printer specified in the label file. Using this command you can override this defined printer and print the label to some other printer.
If the printer name contains space characters, you have to enclose it in quotation marks.

For printer_name always use the system printer name as is displayed in the status line in the label design application. System printer names are usually the same as the printer names in Printers folder from Control Panel, but not always, so pay attention. They differ only when you are using network-connected printers, when you should use "\SERVER\SHARE" syntax and not a printer friendly name.

**PRINTJOBNAME**

PRINTJOBNAME <job_name>

Specifies the print job name that will be used in print manager when using PRINT command. After printing the name is returned in normal state. Use this option to easier distinguish between different printing jobs in the Windows spooler.

If variable value contains space characters or commas, you have to enclose the text in quotation marks (e.g. PRINTJOBNAME "Label for printing").

**QUIT**

This command stops the labeling program after printing. The application is closed.

**RETURN**

This command returns focus to the main labeling program after the printing completes.

**SESSIONEND**

The function closes data stream.

**SESSIONPRINT**

SESSIONPRINT quantity [, skip]

You send the data stream to printer using this function. You can use multiple SessionPrint commands one after another and join them in single data stream. The stream is not closed until the command SessionEnd occurs. The meaning of quantity and skip parameters is the same as with NiceCommand PRINT.

**Note:** Make sure the quantity is provided as the numeric value, not string value. Do not enclose the value in the double quotes.

**SESSIONSTART**

All three commands(SessionStart, SessionPrint, SessionEnd) are used together. If ordinary command SessionPrint is used, every time a complete data stream for printer is sent. If you want to join multiple Print commands into one data stream, you can use the command SessionStart followed with any number of SessionPrint commands and in the end use the command SessionEnd. The stream is not closed until the command SessionEnd occurs.
These commands offer a way of optimal label printing. It is not necessary to generate a complete data stream for each print session, you can join more sessions in one stream.

**Important for the session printing:**

- You cannot change the label template within a session
- You cannot use commands SETDATABASE and SETTABLE within a session
- You cannot change the printer (PRINTER command) within a session
- You must set values for all variables from the label within a session, even if some of the variables will have empty values
- When you test the JOB files that use session printing, the command File -> Command Files -> Print Preview does not work

**SET**

SET name=variable_value, [,step[, quantity_of_repetition]]

Name is the name of the variable defined on the label. If the variable isn't on the label, an error will occur. Step and Quantity_of_repetition are option parameter. These parameters tell the increment of the variable and the number of the labels before change.

If Variable_value contains space characters or commas, you have to enclose the text in the text qualifier marks. By default the text qualifier is a double quote character, but you can use any other character (refer to the command TEXTQUALIFIER).

If you want to assign multi-line value to a variable, use the syntax "\r\n" to encode newline character. "\r" is replaced with CR (Carriage Return) and "\n" is replaced with LF (Line Feed). Both, CR and LF, represent newline character in Windows operating system.

**Note:** Be careful when setting values to variables that provide data for pictures on the label, as backslash characters might be replaced with some other characters.

For example, if you assign a value "c:\My Pictures\raw.jpg" to the variable, the "\r" will be replaced with CR character and the final result is this:

c:\My Pictures
aw.jpg

**Note:** You cannot use the command SET to set the value to the variable of the type Global. Values of global variables cannot be set from outside of the label designer.

**SETDATABASE**

SETDATABASE <database_name> = <value>

<table>
<thead>
<tr>
<th>database_name</th>
<th>The name of the currently used database as defined in the program.</th>
</tr>
</thead>
<tbody>
<tr>
<td>value</td>
<td>The name of the new table that should be used as data source.</td>
</tr>
</tbody>
</table>
This command allows you to use some other database with the label file and not the one, that was connected to the label file at design time.

This other database will only be used when printing labels, the label file will remain intact with connection to the original database.

**SETPRINTPARAM**

SETPRINTPARAM paramname=value

This command allows you to set advanced print parameters before printing. Currently supported PARAMNAMES are:

<table>
<thead>
<tr>
<th>PARAMNAME</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PAPERBIN</td>
<td>Use it to specify from which tray the paper should be used. If the printer is equipped with more than just one paper / label tray, you can control which is used for printing. The name of the tray should be acquired from the printer driver.</td>
</tr>
<tr>
<td>PRINTSPEED</td>
<td>Use this parameter so specify printing speed. The value for parameter varies from one printer to the other. Consult printer's manuals for numbers.</td>
</tr>
<tr>
<td>PRINTDARKNESS</td>
<td>Use this parameter so specify printing darkness / contrast. The value for parameter varies from one printer to the other. Consult printer's manuals for numbers.</td>
</tr>
</tbody>
</table>

**SETTABLE**

SETTABLE <table_name> = <value>

| table_name | The name of the currently used table as defined in the program. |
| value      | The name of the new table that should be used as data source. |

This command allows you to use some other table with the label file and not the one, that was connected to the label file at design time. This other database table will only be used when printing labels, the label template will remain unmodified with connection to the original table.

The new database table must be of the same type as original table. For example, you cannot change the table from dBase to Paradox. The structure of new table has to be identical to the original one.

You can use table from the database that is already connected to the label or from some entirely different database.

**TEXTQUALIFIER**

TEXTQUALIFIER %

Text-qualifier is the character that embeds a data value that is assigned to a variable. If the data value includes space characters, it must be included in the text-qualifier. Otherwise only the data until the first encountered space character is assigned to the variable.

The default delimiter for the command SET is double-quote character. Because the double-quote character is used as shortcut for inch unit of measure, sometimes it is difficult to pass the data with inch marks in the JOB files.

The work-around is to use the double double-quote character instead of just one, but in this case already the incoming data stream needed to be changed. You can leave the incoming data stream as-is and change the delimiter you want to use.

**For example:**

```
TEXTQUALIFIER %
```

```
SET Var1 = % EPAK WRP BD 12"X10 7/32" %
```

The command TEXTQUALIFIER set the delimiter to percent sign (%). The command SET can then use new delimiter character (%) for specifying the value to the variable Var1.

**Note:**
The command TEXTQUALIFIER is persistent (during single program session). If your JOB file sets the TEXTQUALIFIER to some value, it will be used until set to another value.

---

### Command Line Parameters

You can use the command line parameters to pass advanced commands to the label designer when the application starts.

The following command line options can be used when starting the main labeling application.

```
NLABEL5.EXE [file_name] [options]
```

- **[file_name]** Represents the full path name of the file. If the label file is given, then this label is opened. If JOB file is given, then this JOB file is executed. For more information about JOB files, refer to the topic NiceCommands.

- **[parameter]** can be one or more of the following:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/silent</td>
<td>Silent mode, no toolbar, menu or banner is displayed and window is minimized. This is useful when using the labeling software as label printing engine for label production from other application.</td>
</tr>
<tr>
<td>/r</td>
<td>Registers the software as an OLE server.</td>
</tr>
<tr>
<td>/u</td>
<td>Unregisters the software as an OLE server.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>/i</td>
<td>After JOB file is finished, the label designer exits.</td>
</tr>
<tr>
<td>/typelib</td>
<td>This option will generate NLABEL5.OLB file with type library description of the ActiveX interface. The file contains COM interface description, if you would like to integrate label-printing functionality to your application.</td>
</tr>
<tr>
<td>/lang=&lt;LANG&gt;</td>
<td>Run the software in the specified language. This will override the language selection in the program preferences, but only temporarily. If you start the software without the /lang switch, the default language is used.</td>
</tr>
</tbody>
</table>
Technical Support

Online Support

You can find the latest builds, updates, workarounds for problems and Frequently Asked Questions (FAQ) on the product web site at www.nicelabel.com. If you cannot solve the problem on your own, please contact your local vendor or representative offices listed in the topic Contact Information.

For more information please refer to:

- Support FAQ: www.nicelabel.com/Support/FAQ
- NiceLabel FAQ: www.nicelabel.com/Learning-center/Sales-FAQ
- NiceLabel Tutorials: www.nicelabel.com/Learning-center/Tutorials
- NiceLabel Forums: forums.nicelabel.com

Contact Information

Head Office

Euro Plus d.o.o
Poslovna cona A2
4208 Šenčur
Slovenia
Tel: +386 4 280 50 00
Fax: +386 4 233 11 48
support@nicelabel.com
www.nicelabel.com

North American Office

Niceware International, LLC
200 South Executive Drive, Suite 200
Brookfield, Wisconsin 53005
USA
Telephone: (888) 894-NICE (6423)
Fax: (262) 784-2495
E-mail: sales@nicewareintl.com, support@nicewareintl.com
Web: www.nicewareintl.com